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Getting Started

Welcome to Gentran:Director® for Windows® Application Integration
subsystem, Sterling Commerce’s Electronic Data Interchange (EDI)
mapping software for the Windows operating system. Gentran:Director
provides you with the tools you need to translate your application files to
EDI standard formats for documents you send to your partners (outbound
mapping), and to translate EDI standard formats to your application format
for documents that you receive from your partners (inbound mapping).

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 1
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Getting Started

What's in this Manual

This manual contains a tutorial for Gentran:Director Application Integration
subsystem using the EDIFACT standard. This tutorial includes an inbound
mapping example (purchase order) and an outbound mapping example
(invoice). Its purpose is to break the mapping process down into concise,
understandable steps, using examples that will enable you to master the tasks
required to create your own maps.

To access reference information, refer to the Gentran:Director Application
Integration online Help or Application Integration User’s Guide. For
additional information on the tasks described in this manual, refer to the
Gentran:Director User’s Guide.

This manual assumes that you are familiar with using a
PC and with Microsoft® Windows functions,
including:

B The terminology used to describe mouse and
cursor actions.

B The terminology used to describe Windows-
specific attributes, including dialog boxes, icons,
windows, and buttons.

This manual also assumes that you are familiar with

EDI concepts, EDI standards structure, your internal

application format, data mapping concepts, and

Gentran:Director.

The following is an overview of the chapters in this Tutorial Guide:

B Chapter 1, Getting Started explains the content, organization,
conventions, and system requirements in this guide. This chapter briefly
describes how to build maps using Gentran:Director Application
Integration and how to customize global display options. It also
introduces mapping and Gentran:Director for Windows.

B Chapter 2, Inbound Purchase Order (ORDERS) explains the tasks and

procedures necessary to create an export map for an EDIFACT inbound
(ORDERYS) purchase order.

B Chapter 3, Outbound Invoice (INVOIC) explains the tasks and
procedures necessary to create a system import map and an import map
for an EDIFACT outbound (INVOIC) invoice.

B The Glossary contains mapping definitions and Gentran:Director
Application Integration subsystem terms and concepts.

2 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Getting Started What’s in this Manual

Conventions in
this Manual The different typefaces used in this manual are:

Creatinganew map  This typeface is used for emphasis or to indicate a
chapter or section in this manual or other
Gentran:Director manuals.

NEW... This typeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, then press ENTER
to execute that command.

F1 This typeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a key combination that you press
simultaneously (e.g., ALT + TAB).

The different icons used in this manual are:

This icon indicates a note that gives you additional
information on the current subject.

This icon indicates a caution that alerts you to the
potential loss of information. Carefully read text
preceded by this icon.

This icon indicates helpful tips, suggestions, shortcuts,
and alternative actions.

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 3
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Getting Started

Introducing Mapping

Inbound

Outbound

Translation
Objects

A map is a set of instructions that you define in the Gentran:Director
Application Integration subsystem to indicate the relationship between your
application file and the EDI standards. A map also defines how the system
translates data.

For inbound mapping, the system translates your trading partner’s EDI
standard formatted business document to your application file format. To
translate inbound data, you must create an export map in the
Gentran:Director Application Integration subsystem because the system is
exporting to your application file.

For outbound mapping, the system translates your application file format to
EDI standard formats, so you can send documents to your partners. To
translate outbound data, must to create an import map and a system import
map. You must create an import map because the system is importing from
your application file. The import map defines how to move data from your
application file (flat file definition) to the EDI standard-formatted
documents that your partner expects to receive from you. When an
application file contains multiple documents, you must create a system
import map to specify which trading relationship (established in Partner
Editor) corresponds to which document in the application file so the system
knows the import map to use to process the document.

The map you create is the source from which you compile a translation
object. A translation object is a set of rules that instructs the translator how
to convert a file from one format to another. Each function performed during
translation requires a translation object. Translation objects control all
Gentran:Director EDI translation functions. Translation objects can be either
system translation objects or user translation objects. System translation
objects control the creation and separation of interchanges, functional
groups, and transaction sets. They are also used to generate and reconcile
functional acknowledgements. User translation objects control data entry,
importing, exporting, document turnaround, and creating printed reports. All
required system translation objects are automatically installed with
Gentran:Director.

Gentran:Director Application Integration allows you to generate import,
export, and document turnaround translation objects. The Gentran:Director
Forms Integration subsystem enables you to generate data entry and print
translation objects. Once you generate a translation object using the
Gentran:Director Application Integration subsystem (or the
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Introducing Mapping

Application File
Format

Gentran:Director Forms Integration subsystem), you must register the
translation object with Gentran:Director (see the Gentran:Director User’s
Guide for more information). In addition, you must establish correct trading
relationships for all trading partners. To establish a trading relationship, you
must specify the appropriate translation object name that the translator uses
to translate the data. (See the Gentran:Director User’s Guide for more
information.)

The diagram below illustrates the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound L» pp_»

Gentran:Director

Outbound -&——— .
EDI Application

i

Import Translation Object

When you create an import map, you must define to Gentran:Director your
application file format and the EDI standard format in which your partners
expect to receive the documents. When you create an export map, you must
define to Gentran:Director the EDI standard format in which your partners
will send documents and your application file format (how the data needs to
be formatted for your application to process it).

If you are creating an import or export map, you must define your
application to the Gentran:Director Application Integration subsystem. In
Gentran:Director terminology, your application file is also referred to as a
fixed-format file or a positional file. Your application file must contain all the
field information that you either extract from your partner’s document (if the
map is inbound) or that you need to send to your partner (if the map is
outbound).

The map components that you define your application file are:

Bl A group is a looping structure that contains related records and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 5
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Getting Started

EDI File Format

exhausted. If you create a group that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (a loop within
a loop). The application (positional) file is a group and is visually
represented the same way as other groups and sub-groups in the
Application Integration subsystem: (T

B A record contains a group of related fields. A record occurs once or
repeats multiple times. A record is visually represented in the
Application Integration subsystems as: 0

B A field is the smallest piece of information defined in the application
file. A field is the application map component that is mapped (linked) to
a corresponding EDI element. It is visually represented in the
Application Integration subsystems as: @

After a field has a mapping operation performed against it, a red
checkmark is displayed over the field icon.

Before you define your application file format, obtain a layout of the
necessary records, fields, and groups. Each map component is arranged
sequentially in the order that it is most logical for the system to process.
Each level of your application file must be created sequentially. For
example, your application file contains records and groups. The records
contain fields and the groups contain records and/or sub-groups. This means
that you must create records and groups before you create the subordinate
fields.

The EDI file must contain fields for all information that you expect to
receive from your partner (if the map is inbound) or send to your partner (if
the map is outbound).

The Gentran:Director Application Integration subsystem generates an EDI
file, based on the standard (agency), version, transaction set, and release (for
the TRADACOMS standard only) you selected. The system includes all the
groups, segments, composites, and elements defined by the standards agency
for the document version you selected. If you are creating an import or
export map, you typically customize the system-generated EDI file by
modifying the map component properties, and using specialized
Gentran:Director functions to manipulate the EDI file structure.

If you want to use a specialized version of an EDI standard that is not
available in the Gentran:Director standards database, it may be appropriate
for you to define the EDI file yourself.
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Map Components The specific EDI map components that you use depend on the type of map
you are creating. This includes the standard, version, and transaction set
(document) selected, and the groups, segments, composites, and elements
your company requires. We recommend that you determine which map
components you will use before generating or defining an EDI file.

The map components that Gentran:Director uses to define the EDI file
format are:

B A group is a looping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a sub-group (this corresponds to a nested
looping structure — a loop within a loop). The EDI file is a group and is
visually represented the same way as other groups and sub-groups in the
Application Integration subsystem: (J

Bl A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment occurs once or repeats
multiple times. A segment is visually represented in the Application
Integration subsystems as: 0

B A composite is a data element that contains two or more component
data elements or sub-elements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards). A composite is visually represented in the Application
Integration subsystems as: &

Bl Anelement is the smallest piece of information defined by the EDI
standards. An individual element has different meanings depending on
the context. Elements are typically not considered useful until combined
into segments. An element is the EDI map component that is mapped
(linked) to a corresponding application field to move data to and from
the EDI file. An element is visually represented in the Application
Integration subsystem as the following:

After an element has a mapping operation performed against it, a red
checkmark is displayed over the element icon.

Please see the Gentran:Director Application Integration User’s Guide for
more information on customizing map component properties and on using
specialized Gentran:Director functions to manipulate the EDI file structure.

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 7



Introducing the Application Integration Subsystem Getting Started

Introducing the Application Integration Subsystem

The Gentran:Director Application Integration subsystem enables you to
translate your application files to EDI standard formats for documents you
send to your partners (outbound mapping), and to translate EDI standard
formats to your application format for documents that you receive from your
partners (inbound mapping).

Navigation

You can access the Gentran:Director Application Integration Window in one
of four different ways:

8 April 2005

Click the menu option from the Main Menu Bar.
Click the appropriate button on the Main Toolbar.
Click the appropriate part of the map.

Click a map component with the right mouse button to access a shortcut
menu, which contains all the functions that are currently available for
that map component. The content of the shortcut menus varies,
depending on the type and level of the selected map component.

When you start Gentran:Director Application
Integration, the Main Menu Bar contains a subset of
menu items. A full set of menu items is displayed after
you create a new map or open (load) an existing map.

Gentran:Director Application Integration EDIFACT Tutorial Guide



Getting Started Introducing the Application Integration Subsystem

The Gentran:Director - Application Integration Window appears as follows::

Minimize/Maximize Buttons

Control Menu

THT Bar

& File Edit Function: “iew Optionz indow Help

e e s = ] e ) QR A S

£ ORDERS M- PURCHASE ORDER &

BGH M- 1 BEGINHING OF ME!

¥ 051004 -C- Sting 22 DOCU

¥ (51225 -C- Sting 3 MESSAI

DTH M- 35 DATE/TIME/PERI

507 M-

TEMPDATES -C- 1

¥ 01 PODATE -C- D Tm B Pu

¥ 02 DELDATE -C- Dt/ Tm 6D

¥ 03 CANCELDATE -C- Dt/ Tm
4 0200_MaD -C- 20

071 3035 -M- String 3 PAR
B2 Cog0 -
B Cosa-C-
133164 -C- Shing 35 CIT
20 3223 -C- Sting 2 COU
213251 -C- Sting 3 POS

NAD -C- 1 NAME AND ADDI

Y

T & Purchase Order D ate ¥® —
X.E Purchase Order Mumber #® —

DER -M-1 PO Header Hecurd@—
String 8 Customer Murmber ¥ —

furchase Order Type Code 9@ —
- String 35 Ship To Mame ¥® —
35 Ship To Addrezs Line 1 9@ —
35 Ship To Addreszs Line 2 ¥® —

-C- Strinig 35 Ship To City @ —
Btate, Province, ar Country o® —
rirng 9 Ship To Pozstal Code 9@ —
-C- String 35 Bill To Mame #® —
g 35 Bill To Addrezs Line 1 9@ —
0 35 Bill To Addreszs Line 2 ¥® —
T -C- String 35 Bill To ity w® —
Btate. Province, or Country o® —
Etring 9 Bill To Postal Code o® —
-td- DE/Tm B Delivery Date v® —

- Dt/ Tm B Cancel By Date v® —

FY

—%Shi ToDet -C- 1 Ship To Details
1| r r 1

pr]

L MM

For Help, press F1

— Main Menu Bar Main Toolbar ——

B The Control Menu contains the following commands: Restore, Move,
Size, Minimize, Maximize, and Close.

B The Title Bar contains the name of the application. You can use this to
move the position of the EDI Director window on your desktop.

B The Minimize button reduces the window to an icon.

The Maximize button enlarges the window to its maximum size.
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10

B The Main Menu Bar contains the following drop-down menus
(detailed descriptions of each of the commands on these menus are
found in the online Help). Unavailable items are dimmed.

Eil= Edit
Ctrl+M = . :
Lopy Tl
%Ipen... Chil+0 et Cirlsy w Status Bar
< :j: ChieS Create Sub N Activate Expand Branch
= Irsett » Deactivate Expand &l
Save fs... Delete Del — Unexpand Branch
) = Link, ;
Compile Erpmives Witk Shiw Active Only
Print... Chrl+P Session Bules Gererate TOF Equalize
Print Setup... Constants o
Print Ta File... Spntar Takens Generate LUEF]
Code Lists At T
1 Pet_8h0.map - =
Detailz
sl Find...

Tile Index

Arange lcons Using Help
v 1 Pet_850.map About GEMTRAM: Server - Application Integration. ..

B The Main Toolbar gives you access to some of the most common
operations in the Application Integration subsystem. Unavailable items
are dimmed. The Main Toolbar is a dockable toolbar, so you can affix it
to any edge of the client window. The Main Toolbar is illustrated below:

New Cut Constants Split Unlink

‘ Sa‘ve Pa|ste Code Lists ‘ Deactivate
NEFEBEEEEEEEEEE R E

|
Op‘en COLY Syntax Acti\late GenLrate
. . Tokens ) TDE
Compile Session Promote Link
Rules
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Customizing Global Display Options

The Gentran:Director Application Integration subsystem allows you to
customize the display of maps in several different ways. The global display
options that are established apply to all maps. This section explains how to

perform the following:

B Customizing global display options

B Displaying links (global option)

You can set or change global map display options at any time.

Customizing

Global Display Complete the following steps to customize global (for all maps) display

Options options:

1. Select Preferences... from the Options menu to display the Preferences
dialog (the Tree tab is displayed by default). The Preferences dialog is a

property sheet that enables you to set global defaults for
Gentran:Director.

Preferences

Tree |Links | Standard Formatsl PositionalDefauItsI Files | Confirmationsl

Theze settings customize the look of the file format tree.

Calours... |
v Show record descriptions Fant... |

W Shaow field descriptions

Ok I Cancel Help

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005
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Customizing Global Display Options Getting Started

2. Toturn on the default display of group, record (segment), and field
(element) descriptions, select the appropriate options.

You typically want all descriptions displayed for reference. But
depending on the size of your monitor, it may be easier to see the entire
map if the descriptions are not displayed.

You may want to experiment with shrinking the size of
the font for the map (see Customizing Global Fonts in
the Gentran:Director Application Integration User’s
Guide) before you turn off the display of descriptions.

3. Click OK to save changes and exit the Preferences dialog.

Customizing

Global Display Mapping Links are the visual lines that connect a field/element on the Input
of Links side of the map to a field/element on the Output side of the map.

Complete the following steps to customize the global display of mapping
links:

1. Select Preferences... from the Options menu to display the Preferences
dialog.

2. Click the Links tab to display the linking options. The Links tab enables
you to set the default display of mapping links.

Preferences

Tree  Links |Standard Formatsl F'DsitionalDefauItsI Files I Eonfilmationsl

These settings control how links are shown between the input and output file formats.

&% Show no links
" Show links ta or from the currently zelected element,

€ Show links to or from all wisible elements
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Getting Started Customizing Global Display Options

The options in the Links section of the Preferences dialog enable you to
select:

B Show no links
Do not visually display mapping links.

Bl Show links to or from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).

W Show links to or from all visible elements
Display all the mapping links.

The option you select is the default for all maps.

3. Click OK to save changes and exit the Preferences dialog.

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 13



Building a Map with Application Integration Getting Started

Building a Map with Application Integration

14

This section is an overview of the map-building process.

1.

April 2005

Prepare and Analyze

Obtain a layout of your application file and determine how it
corresponds with the EDI standard you will be using. Determine how
you will move data to or from each application field.

Set Global Defaults (first time only)

The first time you use the Gentran:Director Application Integration
subsystem, establish the default date format that you want the system to
use. Please see the Gentran:Director Application Integration User’s
Guide for more information on setting the global date default.

Create, Save, and Name a New Map
Please see Creating the Export Map on page 27 for more information on
creating, saving, and naming a map.

Activate the Appropriate EDI Groups, Segments, and Elements
Please see Activating EDI Map Components on page 32 for more
information on activation.

Define your Application File Format
Please see Defining Your Application File Format on page 37 for more
information on defining your application file format.

Map the Appropriate Data for Each Application Field
Please see Mapping Your Data on page 57 for more information on
mapping your data.

Compile the Translation Object

Please see Compiling the Map on page 115 for more information on
compiling the translation object and translation object naming
conventions.

Print the Mapping Report

Validate and review the map, and make modifications as needed. Please
see Printing the Report on page 117 for more information on printing
the mapping report.

Register the Translation Object with Gentran:Director
Please see the Gentran:Director User’s Guide for more information on
registering translation objects.

Gentran:Director Application Integration EDIFACT Tutorial Guide
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Building a Map with Application Integration

10.

11.

Create the Appropriate Trading Relationship

Establish the appropriate trading relationship in Gentran:Director for
your trading partners. Please see the Gentran:Director User’s Guide for
more information on creating trading relationships. The trading
relationship you use in this tutorial (PETZONEL) is provided in the
TUTORIAL folder. You must import the partner profile
(PETZONE1.PAR) into Gentran:Director, before you begin this tutorial.
Please see the Gentran:Director User’s Guide for more information on
importing trading relationships.

Testing the Translation Object

Obtain test data from your partner and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.

For these tutorials, we have provided test data for the translation objects
you create. The following table describes how to locate that test data:

Translation Object Test Data

Type Name
Inbound (export) PETTSTEL.INT
Outbound (system import and import) PET_EINV.TXT

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 15
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Inbound Purchase Order (ORDERS)

This tutorial defines the tasks necessary to create the map used to translate
EDIFACT purchase orders (ORDERS) that you receive from your trading
partner.

This chapter explains the tasks and processes associated with creating a map
for an inbound purchase order, which include:

Mapping analysis

Creating the new map

Activating groups, segments, and elements
Defining your application file format
Mapping your data

Finalizing the map

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 17
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Getting Started

Inbound
Mapping
Scenario

Mapping
Analysis

This tutorial is meant to be completed in its entirety. We recommend that
you complete each task sequentially, without referring to the completed map
that is provided with the installation program (although you may want to
verify your completed map with the model).

Completing each task in this tutorial in sequential order as if it were your
own scenario not only teaches individual mapping tasks, but also a logical
approach to methods that you utilize when you create your own map.

In this exercise, your company is MWT Manufacturing Co., which
manufactures a wide variety of pet supplies. Your company sells these
supplies directly to large pet supply retail chains. You must create a map that
enables your company to translate the purchase orders that you receive from
one of your trading partners, Pet Zone (a large pet supply retailer). Once the
purchase orders are translated into your application file format, they can be
processed through your Order Processing System, and your company can
ship the goods to Pet Zone.

You have an existing application file layout from your order entry
department that defines the information your system needs to process the
order. And from discussions with the Pet Zone, you know the data content of
the orders that your partner will be sending you.

The first step in creating a map is to analyze your mapping requirements.
This is the most important step in creating a successful map. If your analysis
is complete, you will have all the information you need to create the map in
an efficient and logical manner. If you omit this critical step, it is likely that
creating the map will be a much longer and more arduous task, and the map
may be invalid due to oversights or omissions.

Mapping analysis involves the following steps:

1. Analyzing your application file format

2. Analyzing your partner(s) EDI file format

3. Correlating your application and the EDI file formats

18 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Getting Started

Analyzing Your
Application File
Format

Field Name

The first step of mapping analysis to analyze your application file format,
because this is the component that is probably the most familiar to you. In
this tutorial, your application file format contains all the information that you
need to extract from the purchase order your partner sends, so that your
system can correctly process the purchase order and your company can fill
the order correctly.

You must define your application file format to Gentran:Director
Application Integration. If your company has an existing application file
format, as in this tutorial, obtain the record layout from the appropriate
person. If you do not have an existing application file format, you must
create one by determining fields you will need to process data correctly, and
then logically grouping those fields under records.

The application file layout for this tutorial is as follows:

Data Min Max
Type Length  Length

Description

Header Record (POHEADER) 1 per message

CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State, Province, or String 0 2
Country
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
BILLTONAME Bill To Name String 0 35
BILLTOADD1 Bill To Address Line 1 String 0 35
BILLTOADD2 Bill To Address Line 2 String 0 35
BILLTOCITY Bill To City String 0 35
BILLTOSTATE Bill To State, Province, or Country | String 0 2
BILLTOPOSTALCODE Bill To Postal Code String 0 9
DELDATE X Delivery Date Dt/Tm 6 6
(MMDDYY)

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 19



Getting Started

Inbound Purchase Order (ORDERS)

Field Name Description TD;:; Le'\f']igth ngxth

CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)

NUMLINEITEMS X Number of Line Items Number (NO) | 1 6

PO Detail Group (PODetailGroup) up to 200,000 per message
Detail Record (PODETAIL) 1 per message

CUSTNUMDET Customer Number String 1 8

PODATEDET Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

UOoM Unit of Measure String 0 7

UNITPR Unit Price Number (N2) | 0 14

QTYORD X Quantity Ordered Number (NO) | 1 9

Description Record (PODESC) up to 5 per message

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 80

Allowance/Charge Record (POALLCHG) up to 5 per message

CUSTNUMAC X Customer Number String 1 8

PODATEAC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMAC X Purchase Order Number String 1 22

ACIND Allowance or Charge Indicator String 0 1

ACMETHAND Allowance or Change Method of String 2

Handling Code
ACTOTAMT Allowance or Charge Total Number (N2) | O 9
Amount
Summary Record (POSUMMARY) 1 per message

CUSTNUMSUM Customer Number String 1 8

PODATESUM Purchase Order Date Dt/Tm 6 6
(MMDDYY)
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. S Min Max
Field Name Description Length Length
PONUMSUM X Purchase Order Number String 1 22
NUMLINEITEMSUM X Number of Line ltems Number (NO) | 1 6

The above table contains the minimum information necessary to define your
application file format to Gentran:Director (hame, mandatory status,
description, data type, and field length). Each record contains a group of
logically related application fields. These fields contain the information from
the EDI file that your system needs to process the purchase order. The group
contains logically related application records.

Each record contains a key (consisting of three fields) to ensure that the
same identifying information is located at the beginning of each record.
Your application contains a record key so that each record can be identified
individually. The record key for this purchase order consists of your
partner’s customer number, the purchase order date, and the purchase order
number. The records and the group are defined as:

B The POHEADER (header) record contains the purchase order type
code, shipping and billing information, delivery and cancel by date
information, and the number of line items in the purchase order. This
header record is mandatory and occurs once for each purchase order
translated.

B The PODetailGroup (detail information) contains all line item
information for the order, including the item, unit of measure, price,
quantity ordered, description, and the allowance and charge
information. Each PODetailGroup occurs up to 200,000 times per order
translated. This equals a maximum order of 200,000 items. The
information within the PODetailGroup is further segregated by record.

B The PODETAIL (detail) record contains line item code humber, unit of
measure, price, and quantity ordered. The PODETAIL record occurs
once per PODetailGroup.

B The PODESC (description) record contains descriptive information
about the line item ordered. The PODESC record occurs up to five times
per PODetailGroup, so multiple descriptive terms can be used for each
item. For example, if the line item is a “dog collar,” the description
fields may be “red,” “large,” and “leather.”

B The POALLCHG (allowance and charge) record contains the allowance
or charge indicator, method of handling code, and total allowance or
charge amount. The POALLCHG record occurs up to five times per
PODetailGroup, so multiple allowances and/or charges can be used for
each item.
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B The POSUMMARY (summary) record contains the total number of line
items in the purchase order. The POSUMMARY record occurs once for
each purchase order translated.

Now that you have thoroughly analyzed your application file format, the
next step is to determine the purchase order requirements that you will
receive from your partner(s).

Analyzing the EDI To analyze the EDI file, you must first determine what your trading partner
File will be sending you. You and your partner must agree on which standard,
version, and message you want to use. In this tutorial, we use the EDIFACT
standard, version 92.1, message ORDERS (purchase order message). It is
important to know what type of information your partner will be sending you
within the purchase order, and what type of data will be contained in each
element used.

It is very helpful to review the EDI standard(s) that you will be using before
analyzing the EDI file. Obtain an EDI standards manual for each standard
and version that you will be using. Standards manuals are available from
EDI standards agencies.

After discussing with your partner what they will send, determining which
segments and elements your company requires, and reviewing the EDI
standard, make a list of the map components that you must make available
for use (activate).

For this tutorial, the map components that are required but not currently
active are the following (the composite column is informational only, so you
will know where to locate the appropriate element):

Groups Segment Group Segment Comp. Element
BGM segment BGMO5 element
(already active) BGMO06 element
DTM segment C507 DTMO02 element

(already active)
NAD NAD segment C080 NAD10 element
group C059 NAD16 element
C059 NAD17 element

NAD19 element
NAD20 element
NAD21 element
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Groups Segment Group Segment Comp. Element
LIN LIN segment C212 LINO3 element
group
IMD:2 segment C273 IMD:206 element
QTY:3 segment C186 QTY:303 element
MOA:5 segment C516 MOA:502 element
ALC ALC:2 segment ALC:204 element
group
MOA MOA:8 C516 MOA:802 element
group segment
CNT segment C270

Reconciling Your
Application File
and the EDI File

Gentran:Director Application Integration EDIFACT Tutorial Guide

When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.

We recommend that you set up a Document Name for each map to make the
identification of a message created by this map easier in Gentran:Director.
This allows you to differentiate between messages in the document browsers
in Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the messages translated by this map. The
Name field of the document browsers that contain this message contains data
from the selected element or field. We strongly recommend that you select
an element or field that occurs only once in the message and has a data type
of “String.” In this tutorial, the map’s document name is the purchase order
number.

After you complete the analysis of the EDI file and your application, the
final step in mapping analysis is to correlate the two components.

To reconcile your application file format with the EDI file, you must identify
each application file with its corresponding element in the EDI file and
select a method for mapping it. To map information to a field, you use
linking, standard rules, extended rules, or a combination of all three.

Linking (simple mapping) enables you to map a field or element from the
input side of the map to a field or element on the output side of the map. The
link between two map components (fields) is visually represented with a line
connecting the two fields.

Standard rules give you access to mapping operation functions that are
more complex than simple linking, but less involved than extended rules.
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Field Name

Extended rules enable you to use a Gentran:Director proprietary
programming language to perform virtually any mapping operation you
require.

Additionally, you may determine that you need to establish temporary
storage (work) areas for the map to handle items such as Ship To and Bill To
name and address information, which is extracted using extended rules from
a group in the EDI data.

We recommend that you determine which mapping operations are required
on a field-by-field basis for your application file.

The following mapping operations (by application field) will be required for
this tutorial:

Mapping

Description Operations

Header Record (POHEADER) 1 per message

CUSTNUMHDR Customer Number Extract Application ID from Partner record
PODATEHDR Purchase Order Date Link to DTMO02 using “4” (PODATE) code
PONUMHDR Purchase Order Number Link to BGMO5

POTYPCODE Purchase Order Type Code Link to BGM06

SHIPTONAME Ship To Name Link to NAD10 using “ST” (ShipTo) code

SHIPTOADD1 Ship To Address Line 1 Link to NAD16 using “ST” (ShipTo) code

SHIPTOADD2 Ship To Address Line 2 Link to NAD17 using “ST” (ShipTo) code

SHIPTOCITY Ship To City Link to NAD19 using “ST” (ShipTo) code

SHIPTOSTATE

Ship To State, Province, or Country | Link to NAD20 using “ST” (ShipTo) code

SHIPTOPOSTALCODE

Ship To Postal Code Link to NAD21 using “ST” (ShipTo) code

BILLTONAME Bill To Name Link to NAD10 using “BT"(BillTo) code
BILLTOADD1 Bill To Address Line 1 Link to NAD16 using “BT"(BillTo) code
BILLTOADD2 Bill To Address Line 2 Link to NAD17 using “BT"(BillTo) code
BILLTOCITY Bill To City Link to NAD19 using “BT"(BillTo) code

BILLTOSTATE

Bill To State, Province, or Country Link to NAD20 using “BT"(BillTo) code

BILLTOPOSTALCODE

Bill To Postal Code Link to NAD21 using “BT"(BillTo) code

DELDATE

Delivery Date Link to DTMO02 using “117” (DELDATE)

code

CANCELDATE

Cancel By Date Link to DTMO02 using “153"

(CANCELDATE) code

NUMLINEITEMS

Number of Line Items Link to CNTO2 using “2” (NUMLINEITEMS)

code
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Field Name

Description

Mapping

Operations

PO Detail Group (PODetailGroup) up to 200,000 per message
Detail Record (PODETAIL) 1 per message
CUSTNUMDET Customer Number Extract Application ID from Partner record
PODATEDET Purchase Order Date Link to DTMO2 using “4” (PODATE) code
PONUMDET Purchase Order Number Link to BGMO05
CUSTPROCODE Customer Product Code Link to LINO3
UPCCODE UPC Code Extract Partner xref by partner item from
subtable “PRODCODE"
UOM Unit of Measure Extended rule to link to QTY:303
UNITPR Unit Price Link to MOA:502 using “146” (UNITPRICE)
code
QTYORD Quantity Ordered Link to QTY:302 using “21” (QTYORD)
code
Description Record (PODESC) up to 5 per message
CUSTNUMDESC Customer Number Extract Application ID from Partner record
PODATEDESC Purchase Order Date Link to DTMO02 using “4” (PODATE) code
PONUMDESC Purchase Order Number Link to BGM05
DESC Description Link to IMD:206
Allowance/Charge Record (POALLCHG) up to 5 per message
CUSTNUMAC Customer Number Extract Application ID from Partner record
PODATEAC Purchase Order Date Link to DTMO02 using “4” (PODATE) code
PONUMAC Purchase Order Number Link to BGMO05
ACIND Allowance or Charge Indicator Link to ALC:201
ACMETHAND Allowance or Change Method of Link to ALC:204
Handling Code
ACTOTAMT Allowance or Charge Total Amount | Link to MOA:802
Summary Record (POSUMMARY) 1 per message
CUSTNUMSUM Customer Number Extract Application ID from Partner record
PODATESUM Purchase Order Date Link to DTMO2 using “4” (PODATE) code
PONUMSUM Purchase Order Number Link to BGMO05
NUMLINEITEMSUM Number of Line Items Link to CNTO2 using “2” (NUMLINEITEMS)
code
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You must determine if you need code tables to convert map data. If you need
code tables, you must decide whether to create a code table in
Gentran:Director Application Integration that can only be used with this
map, or whether to add the table to the partner relationship or the internal
system partner in Partner Editor. In this tutorial, you need to map
information from a cross-reference table to translate your partner’s code for
a purchased item and your code for the same item. A cross-reference table is
used when you and your partner each reference an item by a different name
(or number).

You do not need to create this cross-reference table — it
is included with the PETZONE partner
(PETZONEL.PAR) that is provided with the tutorial
data when you install Gentran:Director.

My Value Partner Value Description Reference Data
12345678901234 555666411 Large Dog Collar Red
23456789012345 555666817 Spring Breeze Cat Litter 10# Bag
34567890123456 555666908 Small Beef Basted Rawhide Bones Bag of 12
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

After you finish correlating your application file format and EDI file on
paper, you can begin creating the map.
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Creating the Export Map

The first task in creating a new map is to define the format that will be used
for the input and output sides of the map. In this example, you are creating
an export map so Gentran:Director can translate a purchase order that your
partner sends to your application file. The input side of the map must reflect
the EDIFACT ORDERS purchase order that you receive. Instead of defining
the ORDERS message to the system yourself, you want Gentran:Director to
use the standards database on your system to build the purchase order
according to the standard. The output side of the map must reflect your
application file.

Complete the following steps to create the export map for the Inbound
Purchase Order:

1. Select New from the File menu to display the Create New Translation
Object dialog.

Function Ilmport
[ ata Souree I j Cancel |
— Input Format

Type Iﬁ [ ez Gtandards

Sgency I j

Ersio I j

Trarsaction I j

HelEase I "l

— Dutput Format

Tvpe I vl = e Standard:

Aaency I j
Versiom | =l
Trarsaction | =l
Helease I—Ll

2. From the Function list, select “Export.”

Complete the Input Format section of the dialog. This is the data format
that Gentran:Director translates.

3. From the (Input Format) Type list, select “EDI” as the type of format for
the input data.
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Click the Use Standards option, because you selected “EDI” in the Type
box and because you want the system to use the standards database on
your system to build the purchase order according to the standard.

To select a data source nhame from which Application Integration will
access EDI standards, select one from the Data Source list. This DSN
will be prompted the next time you create a map.

Select “[E] Edifact” as the EDI standard you will be using for the input
side of the map from the Agency list.

Select “[092001] EDIFACT 1992 RELEASE 1” (92.1) as the standard
version from the Version list. Available versions depend on which
standard you selected.

Select “[ORDERS] PURCHASE ORDER MESSAGE” as the
transaction set (message) from the Transaction list. The transactions that
are available depend on which standard and version you selected.

Next you must complete the Output Format section of the dialog.

From the Type list, select “Positional” as the format type for output
data. Gentran:Director uses the term “positional” to describe any flat
file that you create.

The Create New Translation Object dialog should now look like this:

Function IExport
Data Source IGENTHI—\N Standards j Card] |
— Input Faormat

Tupe IEDI *I ¥ Use Standard:

Agency I[E] Edifact j

Yersion I[DEI2DEI1] EDIFACT 1992 RELEASE 1 j

Transaction |[ORDERS] PURCHASE ORDER MESE )7 |

Release I 'I

r— Output Farmat

Type IPc-&itionaI vl = [Use Standard

LAEGY I j
= el I j
IR E=ir =il I j

Eelease I 'I
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10. Click OK to generate the new map (this may take a few seconds). The
new map is displayed in the following window.

$* GENTRAN:Director - Application Integration - [GENTRAN1]

£r Fle Edt Functions Wiew Options ‘window Help =&
) 1 e 1 = e e e
§DHDEHS-M- PURCHASE ORDER MESSAG & OUTPUT M- 3 =

BGM -1 BEGINMIMG OF MESSAGE
DTM -M- 35 DATE/TIME/PERIOD

3
3
3
3
3
3
3
3
3
3
3
3
7
UNS -1 SECTION CONTROL

‘|§ | _.|:" o]

For Help, press F1 S

11. After you create a new map, it is important to define and save its details.
The Save function writes (saves) the map with current focus to disk.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of information.
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Select Save from the File menu to display the Translation Object Details
dialog.

Tranzlation Dhjact Details

~Summoy

by khor Diezclipion Traredation Object Functon Spatem
Export 2| C
I I s |—I | Cancel I
ermon Control

Major walgicn IEI Minar version IEI D:rnpils-dml

Agency

‘erzmn

Flaleaen

F Group

EDl Assodialione

Tramsaction  [OADERS [PLACHASE ORDE

Irput Output

IE_ [Edtact

|uaem1 |EDIF.£I.I2T 1992 FEL

[
| |

BRRE

12.

13.

14.

15.

16.
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In the Author box, type your name. This box typically contains the name
of the person who created the map.

In the Description box, type “PET E 92.1 ORDERS Export”. This
description must be unique because the system uses it to identify the
map. We recommend that you use the following identifying
characteristics: the partner that this map is used for, the standard, the
version, the transaction type this map uses, and the map direction (e.g.,
Import). For example, “PET E 92.1 ORDERS Export” is the description
of a map used with partner Pet Zone, for an EDIFACT version 92.1
Purchase Order (ORDERS), that is received Inbound (Export).

Verify that the type of map shown in the Translation Object Function
list is “Export.”

Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version number in the Major box
and accept the “0” as the release number in the Minor box.

Q Whenever any major changes are made to your map,

increase the version to the next real number (e.g., 2.0).
For minor map changes map, increase the version by a
percentage point (e.g., 2.1).

The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides
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of the map are in EDI format. For the tutorial, DO NOT change the
information in these boxes.

The system allows you to change the information in the
Input and Output boxes, but modifying this
information will not alter the content of the map. An
example of when you may wish to alter these boxes is if
you want the map to reflect a standard version that is
not loaded on your system. You can change the version
on this dialog, and then physically alter the map to be
compliant with that version.

The Translation Object Details dialog should now look like this:

Trarrslatinr Mgenct Tietails

rSummeny
Aukhor Diescipion Trarcdation Object Function Epetemm
Stari TE 521 0RDERS Expot | |Export |
I o I " I s |—I Cancel I
Merson Confrol

Maijor wanaion I'I Minar version IEI Compiled on

Aoancy

Yerzmn

Releasmz

F Group

ED Assor alioes

Trameaction |OADERS | [PLACHASE ORDE

Irput Output

IE_ [Edtac

|uaa:u1 |EDIF.¢'I.CT 1552 REL

O
| |

BRRE

17.

18.

19.

Click OK to save the translation object details and access the Save As
dialog.

The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN Director\Maps.
If the current subfolder is not the correct one, select the appropriate
subfolder.

Type “PET_EORD.MAP” as the map name in the File Name list. The
file name should be unique. In our example, the name indicates an
EDIFACT Purchase Order (ORDERS) for partner Pet Zone.

The default file extension for maps is .MAP. Using this extension
distinguishes map files from other file types, such as translation objects.
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The naming conventions in Gentran:Director are:

B The source map (map created in Gentran:Director) uses the file
extension .MAP (e.g., PET_EORD.MAP).

B The compiled translation object (translation object that is the result
of compiling the source map) uses the same file name that was
allocated to the source map BUT with the file extension . TPL (e.g.,
PET_EORD.TPL).

The Save As dialog should now look like this:

T T
Save r: IEMBPS R ﬁl Bi

File name: IF'ET_EEIHD.M.&F'
Save az lype: IMaps [*.map] j Cancel |

20. Click SAVE to save the map.

Now that you have finished creating and saving the new Export map, you
must define the Input and Output sides of the map.

Activating EDI
Map The map components for an EDI File are:
Components @& EDI File
] Segment
] Loop (Group)
£ Composite Element
- Element
The map components for a Positional File are:
] Positional File
] Record
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& Loop (Group)
Field

The specific EDI map components that you use depend on the type of map
you are creating, the standard, version, and transaction set (message)
selected, and the segments and elements your company requires. We
recommend that you determine which segments and elements you will use
before starting this step.

When Gentran:Director generates the EDI side(s) of the map, the system
includes all groups, segments, composites, and elements that are defined by
the standards agency for the version of the message you selected. The system
activates all the groups, segments, composites, and elements that are defined
as “mandatory” (must be present) by the standard. The system does not
enable you to deactivate the mandatory groups, segments, composites, and
elements. By default, Gentran:Director displays active map components
with a black font, and inactive map components with a gray font (dimmed).
In the example below, the DTM segment and the DTMO1 element are
mandatory, so they have already been activated by the system. You must
also use the DTMO02 element (a conditional element), so you will need to
activate it.

OTH - 35 DATETIME /PERIOD
52 CHO7 M-

LT ]

E # 01 2005 -M- String 3 DATE/TIME/PERIOD QUALIFIER

2
2

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elements that are not defined as mandatory, but that you have determined
that you need to use in mapping.

Complete the following steps to activate the required conditional groups,
segments, and elements:
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1. Double-click the segments and groups that are listed in the table below
to open them. These are the groups, subgroups, segments, and elements
that you must activate. Opening all the necessary groups, segments, and
composites before you start to activate allows you to scroll down the
map and activate the segments and elements sequentially.

Segment

Group Segment Comp. Element

BGM segment BGMO5 element
(already active) BGMO06 element
DTM segment C507 DTMO02 element
(already active)
NAD NAD segment C080 NAD10 element
group C059 NAD16 element
C059 NAD17 element
NAD19 element
NAD20 element
NAD21 element
LIN LIN segment C212 LINO3 element
group
IMD:2 segment C273 IMD:206 element
QTY:3 segment C186 QTY:303 element
MOA:5 segment C516 MOA:502 element
ALC ALC:2 segment ALC:204 element
group
MOA MOA:8 C516 MOA:802 element
group segment
CNT segment C270
When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.
2. Click the Activate button on the Main Toolbar.
3. Click each inactive group listed in the table. This will activate the
groups.
If you click a group, segment, or element that you did
not mean to activate, click it with the right mouse
button to access the shortcut menu. Select Deactivate
from the shortcut menu.
34 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Creating the Export Map

4. Click each inactive segment listed in the table. This will activate the
segments.

5. Click each inactive element listed in the table. This will activate the
elements.

6. Once you have activated all necessary groups, segments, and elements,
click the Activate button on the Main Toolbar to turn activation mode
off.

Verifying EDI

Delimiters If you are using an EDI standard that contains composite elements or sub-
elements, you must verify that Gentran:Director is specifying the correct
delimiters. Delimiters are flags that you define to the system as separating
specific EDI components. Delimiters are necessary for all variable field-
length standards, because data is compressed (and the leading zeroes and
trailing blanks are removed). Since fields vary in length, the system needs a
flag to determine where one element ends and another begins. For example,
an element delimiter marks the beginning of a new element.

Although verifying EDI delimiters in Gentran:Director
is mandatory only if you are using a standard with
composite elements or sub-elements, we recommend
that you perform this task regardless of which
standard you use.

Complete the following steps to verify EDI delimiters:

1. Click the ORDERS ORDER DETAILS EDI file icon with the right
mouse button to access the shortcut menu. Select Properties... from the
shortcut menu.
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The EDI File Format Properties dialog is displayed.

LU [z | ormat Praperbics
Home IEIFIDEHE D IF'UF! CHASE ORDER MESSARE | i I
[ Gtizam zegments
EDI Synlax
) . Rules. .. I
¥ Specihy defaulla [T Uae smtes iecard  [© Conlare dein
Tz O efmitar I Fiecord Tag Tag Oelmiter Pos
Elemant Deimiter |-r Elerre=nt Delmiber Proe

Tag Position
Segment Dalimitsr I Segment Dalimier Poc
Sub Elernenk Delimien I: ecard Lenghh Subekement Delimbe Pos
Ralessa Chalactal I’.' Riale==a Chalaclar Paz

Dezcrnal Geparalar | [rzcrnal Sepaiabar Pos

JTTT

2. Inthe EDI Syntax section, verify that the Specify defaults option is
selected.

3. Verify the required delimiters for the EDIFACT standard. If the
delimiters differ from the defaults in the table below, type either the
character or the hexadecimal value in the correct box. The default
delimiters for EDIFACT are the following (the tag delimiter is not used
for EDIFACT):

EDIFACT Default EDIFACT Default

Box Character Hex Value
Tag Delimiter
Element Delimiter + (plus) 0x2B
Segment Delimiter ' (single quote) 0x27
Sub Element Delimiter : (colon) O0x3A
Release Character ? (question mark) Ox3F
Decimal Separator . (period) O0x2E

4. Click OK to exit the EDI File Format Properties dialog.
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Defining Your Application File Format

Creating the
POHEADER
Record

If either side of your map is positional (fixed-format), you must define your
application file format to Gentran:Director. In this tutorial, the output side of
the map is positional. Your application file must contain all the information
that you need to extract from your partner’s message, so that your system
can accurately process the data.

Before you define your application file format, obtain a layout of the
necessary records, fields, and groups. The records contain related fields and
the groups contain related records. You must arrange each map component
sequentially in the order that it is most logical for the system to process.
Each level of your application file format must be created sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. This means that you
must create records and groups before you create the subordinate fields and
records.

The first record in your application file is generally the header record. The
first record is subordinate to the icon in the application side (output) of the
map.

The POHEADER (header) record contains the purchase order type code,
shipping and billing information, delivery and cancel by date information,
and the number of line items in the purchase order. This header record is
mandatory and occurs once for each purchase order translated.

each application file. The header record is typically
mandatory and repeats only once (it is not a looping
structure).

Q We recommend that you include a header record in

Complete the following steps to create the first application record
(POHEADERY):

1. Click the Positional File icon (Output for an inbound map).
2. Select Create Sub from the Edit menu. Select Record from the submenu.
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The Positional Record Properties dialog is displayed.
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3. In the Name box, type “POHEADER?” as the record identification code.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

4. In the Desc box, type “PO Header Record”. This description provides a
brief explanation of the record that allows you to differentiate it from
similar records.

5. Inthe Tag box, type “HDR” as the record identification code <TAG>.
The system recognizes a record by the following syntax:
<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

We recommend that you define the record tag on the
Positional Record Properties dialog, instead of defining
fields with the purpose of explicitly containing the
record tag.

6. Inthe Position box, accept the default of “1” as the starting column
position of the tag in the data record.
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7. Inthe Min Usage box, type “1” to make the header record mandatory.
This is the minimum amount of times the record must repeat.

If the Min Usage box contains a “0” (zero), the record
is “conditional.” If the Min Usage box contains a “1” or
greater, the record is “mandatory.”

If you want the record to repeat (loop), type the maximum number of
times it can repeat in the Max Usage box. For the header record, we
recommend that you always accept the default of “1” so it remains a
record that only occurs once.

The Positional Record Properties dialog should now look like this:
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8. Click OK to create the POHEADER record.

Creating the
PODetailGroup The PODetailGroup (detail information) contains all line item information

for the order, including the item, unit of measure, price, quantity ordered,
description, and the allowance and charge information. Each PODetailGroup
occurs up to 200,000 times per order translated, allowing for a maximum
order of 200,000 items. The information within the PODetailGroup is further
segregated by related records that repeat in sequence until either the data
ends or it reaches the maximum number of times that the loop is allowed to
repeat.
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Complete the following steps to create the PODetailGroup:

1. To create a group that is at the same level as the POHEADER record,
highlight the POHEADER record and select Insert from the Edit menu.
Select Group from the submenu.

The Group Properties dialog is displayed.
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2. Inthe Name box, type “PODetailGroup” to indicate that this group
contains all detail records. This is the segment loop identification code.

3. Inthe Description box, type “PO Detail Group” as the loop description.
This box provides a brief explanation of the loop.

Accept the default of “0” in the Minimum Usage box. This is the
minimum number of times the loop must be repeated. For a conditional
loop, the minimum usage should always be “0” (zero). For a mandatory
loop, the minimum usage should be “1” or greater.

4. In the Maximum Usage box, type “200000".

The Group Properties dialog should now look like this:
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5. Click OK to create the PODetailGroup.
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Creating the
PODETAIL,
PODESC, and
POALLCHG
Records

In this tutorial, the PODetailGroup contains three subordinate records:
PODETAIL, PODESC, and POALLCHG. After you create the first
subordinate record (PODETAIL), you will define subsequent records at the
same level (PODESC and POALLCHG).

Complete the following steps to create the PODETAIL record:

1. Highlight the PODetailGroup and select Create Sub from the Edit menu.
Select Record from the submenu.

The Positional Record Properties dialog is displayed.
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2. In the Name box, type “PODETAIL” as the record identification code.

3. Inthe Desc box, type “PO Detail Record”. This box is used to provide a
brief explanation of the record that allows you to differentiate it from
similar records.

4. Inthe Tag box, type “DET” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the data record’s starting
column tag position.
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6.

The Positional Record Properties dialog should now look like this:
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Click OK to create the PODETAIL record.

Complete the following steps to create the PODESC record:

1.

April 2005

Highlight the PODETAIL record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “PODESC?” as the record identification code.

In the Desc box, type “Description Record” as a description of the
record.

In the Tag box, type “DES” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

The Looping section of the Positional Record Properties dialog enables
you to specify the minimum and maximum number of times this record
can repeat. You can also specify whether a record is mandatory or
conditional. Alter this section only if the record is a looping structure.
Otherwise, accept the defaults.

Accept the default of “0” in the Min Usage box. This is the minimum
amount of times the record repeats.
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6.

7.

In the Max Usage box, type “5” as the maximum amount of times the
record can repeat.

The Positional Record Properties dialog should now look like this:
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Click OK to create the PODESC record.

Complete the following steps to create the POALLCHG record:

1.

Highlight the PODESC record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “POALLCHG” as the record identification code.

In the Desc box, type “Allowance/Charge Record” as a record
description.

In the Tag box, type “ACG” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the data record’s starting
column tag position.

Accept the default of “0” in the Min Usage box.

In the Max Usage box, type “5” as the maximum amount of times the
record repeats.
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The Positional Record Properties dialog should now look like this:
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7. Click OK to create the POALLCHG record.

Creating the
POSUMMARY The final record you must create (POSUMMARY) is at the same level as the
Record POHEADER record and the PODetailGroup.

The POSUMMARY (summary) record contains the total number of line
items in the purchase order. The POSUMMARY record occurs once for each
purchase order translated.

Complete the following steps to create the POSUMMARY record:

1. Highlight the PODetailGroup and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

Use “Insert” from the Edit menu when you want to
create equal records/groups and “Create Sub” to
create subordinate groups/records/fields.

2. In the Name box, type “POSUMMARY” as the record identification
code.

3. Inthe Desc box, type “PO Summary Record” as the record description.
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4. In the Tag box, type “SUM?” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the data record’s starting

column tag position.

Accept the default of “0” in the Min Usage box.

Also, accept the default of “1” in the Max Usage box so the summary

record only occurs once (not a looping structure).

The Positional Record Properties dialog should now look like this:
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6. Click OK to create the POSUMMARY record.
The application side of the map (output) should now look like this:

QUTPUT -M- £

POHEADER -M- 1 PO Header Record
PODetalGroup -C- 200000 PO Detaill Groupﬁ
PODETAIL -C- 1 PO Detal Record
PODESC -C- & Description Hecurdy
POALLCHG -C- & Allowance/Charge Record
POSUMMARY -C- 1 Summany Record
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Creating the
Application
Fields

Field Name

Each record you create contains a group of logically related application
fields. These fields define the structure and content of data that your system
needs to process the purchase order.

The easiest way to add application fields to a record is to use the Positional
Field Editor. You generally create the fields for the first record in the
application file (POHEADER), and then proceed with each sequential
record.

The application fields that you must create are listed under their respective
records in the following table. The name, mandatory status, description, data
type, and length for each field is listed in the table.

Data Min Max
Type Length  Length

Description

Header Record (POHEADER) 1 per message

CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State, Province, or String 0 2
Country
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
BILLTONAME Bill To Name String 0 35
BILLTOADD1 Bill To Address Line 1 String 0 35
BILLTOADD2 Bill To Address Line 2 String 0 35
BILLTOCITY Bill To City String 0 35
BILLTOSTATE Bill To State, Province, or String 0 2
Country
BILLTOPOSTALCODE Bill To Postal Code String 0 9
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Field Name Description TD;;Z Length ngxth

DELDATE X Delivery Date Dt/Tm 6 6
(MMDDYY)

CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)

NUMLINEITEMS X Number of Line ltems Number (NO) |1 6

PO Detail Group (PODetailGroup) up to 200,000 per message
Detail Record (PODETAIL) 1 per message

CUSTNUMDET Customer Number String 1 8

PODATEDET Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

uoM Unit of Measure String 0 7

UNITPR Unit Price Number (N2) |0 14

QTYORD X Quantity Ordered Number (NO) |1 9

Description Record (PODESC) up to 5 per message

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 80

Allowance/Charge Record (POALLCHG) up to 5 per message

CUSTNUMAC X Customer Number String 1 8

PODATEAC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMAC X Purchase Order Number String 1 22

ACIND Allowance or Charge Indicator | String 0 1

ACMETHAND Allowance or Change Method of | String 2

Handling Code
ACTOTAMT Allowance or Charge Total Number (N2) |0 9
Amount
Summary Record (POSUMMARY) 1 per message
CUSTNUMSUM ‘ X | Customer Number String ‘ 1 | 8
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Field Name Description TD;;Z Le'\f']igth ngxth
PODATESUM X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMSUM X Purchase Order Number String 1 22
NUMLINEITEMSUM X Number of Line Items Number (NO) |1 6

Complete the following steps to create the application fields for the
POHEADER record:

1. Click the POHEADER application record with the right mouse button
and select Edit Fields... to access the Positional Field Editor dialog.
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2. Ifthe field you are creating is the first field in the record, click NEW. A
highlight bar is displayed in the Fields section where the new field is
positioned. You must fill in the values in the Field Details section.

3. Inthe Name box, type “CUSTNUMHDR?”, which is the name of the
first field in the POHEADER record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “HDR” for the Header record.
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10.

11.

12.
13.

Click the Mandatory option to identify it as a required field. For this
example, the customer number must be present so your system can
identify who sent the Purchase Order.

In the Description box, type “Customer Number” as the field
description.

From the Data Type list, select the “String” as the field type, to specify
that this field must contain alphanumeric data.

If you wanted to indicate the field’s exact position in
the record, type the starting field position in the Start
Pos box. Specify field start positions if, for example,
you only be use a few fields and you want them
positioned exactly in the record.

In this tutorial, you use the alternative to specifying the
start position of each field, which is to add the fields
sequentially in the record and then use the Auto
Position function. Please see step 13 below for more
information on the Auto Position function.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length.
In the Max Length box, type “8” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 46.

Click Delete to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This calculates the start position in the
record of each field based on the criteria that each field is positioned
directly after the previous field and is of the length specified in the Max
Length box. Click YES to acknowledge the warning message that fields
will be sequenced in order.

It is only valid to use the Auto Position function if you
define a record tag on the Positional Record Properties

dialog and if you define every field in the record in the
sequence that each field occurs, as you are doing in this
tutorial.
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The Positional Field Editor dialog should now look like the following
(only the last 11 record fields are currently visible in the Fields list):
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14. When you are completely finished adding fields to the POHEADER

record, click CLOSE.

Complete the following steps to create the application fields for the
PODETAIL record:

1.

o~ DN

@
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Click the PODETAIL application record with the right mouse button
and select Edit Fields... to access the Positional Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.
In the Name box, type “CUSTNUMDET”.
Click the Mandatory option to identify it as a required field.

In the Description box, type “Customer Number” as the description of
the field.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.
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8. If the minimum length of the field is “0,” accept that default in the Min
Length box. Otherwise, type “1”.

9. Inthe Max Length box, type “8” as the maximum field length.

10. To add the field and to create the next field positioned after it, press
ENTER.

11. Create the rest of the fields according to the record layout table starting
on page 46.

12. Click Delete to stop adding fields.

13. After adding the last field, click AUTO POSITION to automatically
position the fields in the record. Click YES to acknowledge the warning
message that fields will be sequenced in order.

The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the PODETAIL
record, click CLOSE.
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Complete the following steps to create the application fields for the
PODESC record:

1.

g A~ N

IS

10.

11.

12.
13.
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Click the PODESC application record with the right mouse button and
select Edit Fields... to access the Positional Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.
In the Name box, type “CUSTNUMDESC”.
Click the Mandatory option to identify it as a required field.

In the Description box, type “Customer Number” as the field
description.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

If the minimum length of the field is “0,” accept that default in the Min
Length box. Otherwise, type “1”.

In the Max Length box, type “8” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER.

Create the rest of the fields according to the record layout table starting
on page 46.

Click Delete to stop adding fields.

After adding the last field, click AUTO POSITION. Click YES to
acknowledge the warning message.
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The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the PODESC record,

click CLOSE.

Complete the following steps to create the application fields for the
POALLCHG record:

1.

o > 0N

Sk
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Click the POALLCHG application record with the right mouse button
and select Edit Fields... from the shortcut menu to access the Positional

Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “CUSTNUMAC”.

Click the Mandatory option to identify it as a required field.

In the Description box, type “Customer Number” as the field

description.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format

from the Format list.
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8. If the minimum length of the field is “0,” accept that default in the Min
Length box. Otherwise, type “1”.

9. Inthe Max Length box, type “8” as the maximum length of the field.

10. To add the field and to create the next field positioned after it, press
ENTER.

11. Create the rest of the fields according to the record layout table starting
on page 46.

12. Click DELETE to stop adding fields.

13. After adding the last field, click AUTO POSITION to automatically
position the fields in the record. Click YES to acknowledge the warning
message that fields will be sequenced in order.

The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the POALLCHG
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record, click CLOSE.
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Complete the following steps to create the application fields for the
POSUMMARY record:

1.

10.

11.

12.
13.

Click the POSUMMARY application record with the right mouse
button and select Edit Fields... to access the Positional Field Editor
dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “CUSTNUMSUM?”, which is the name of the
first field in the POSUMMARY record.

Click the Mandatory option to identify it as a required field.

In the Description box, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that will allow you to differentiate it from similar fields.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

If the minimum length of the field is “0,” accept that default in the Min
Length field. Otherwise, type “1”.

In the Max Length box, type “8” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER.

Create the rest of the fields according to the record layout table starting
on page 46.

Click Delete to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. Click YES to acknowledge the warning
message that fields will be sequenced in order.

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 55



Defining Your Application File Format Inbound Purchase Order (ORDERS)

The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the POSUMMARY
record, click CLOSE.

After defining your application file format to Gentran:Director, you must
map the necessary data from the EDI file to your application fields.
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Mapping Your Data

POHEADER
Record

CUSTNUMHDR

This section examines each application field sequentially and describes the
mapping operations that you need to perform to map the appropriate data
into each field.

This section describes how to map each field in the POHEADER (header)
record. The POHEADER (header) record contains the purchase order type
code, shipping and billing information, delivery and cancel by date
information, and the number of line items in the purchase order. This header
record is mandatory and occurs once for each purchase order translated.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner database in your maps by
means of a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The map information that you use includes any field in a table
(location, lookup, or cross-reference) or data from the partner record.

For this map, you must pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is part of the record key, it appears five times in
the application file format, once in each record (CUSTNUMHDR,
CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner so you can map it from the partner definition to
each customer number field.
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Complete the following steps to map the customer number from the
document record:

1.

Double-click the CUSTNUMHDR field (in the POHEADER record).
The Field Properties dialog is displayed.
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If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

The Advanced section is only displayed if you
previously clicked ADVANCED>> on a Field Properties
dialog (during this session of Gentran:Director), and
did not click <<ADVANCED to hide this section before
closing the Field Properties dialog.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.
Verify that the Select option is selected.

From the Table list, select “Document record.” This indicates that the
system will update this field with selected information from the
document record.

Select the Exclusive check box to generate a compliance error if the
system does not find a valid entry.

From the Map From list, select “Partner Key.” This field contains the
customer number for this partner.

From the Map To list, select “CUSTNUMHDR.” Partner Editor
information is mapped to this field.

Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Mapping Your Data

The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK to add the standard rule to the CUSTNUMHDR field.

PODATEHDR Onthe EDI side of the map, date information for the map header is contained
in the DTM segment. This segment repeats multiple times. You must change
the properties of the DTMO02 element (Date/Time/Period) to reflect the

minimum and maximum length, type, and format that your partner will send
you.

If the DTMO1 (Date/Time/Period Qualifier) is “4,” that iteration of the DTM
segment contains the order date/time. You must map the order date/time to
the PODATE field in each application record (PODATEHDR,
PODATEDET, PODATEDESC, PODATEAC, and PODATESUM).

To map the correct information from the DTM segment to the
PODATEHDR field in the application header record, you must determine
the data type, then extract the order date/time information.

To map the order date/time information to your application file format, you
must create a temporary storage segment and element on the EDI side of the
map that does not repeat. Use an extended rule to extract the order date/time
information from the DTM segment and move it to the appropriate
temporary storage elements. Then map the order date/time directly from the
temporary storage element to the PODATEHDR application field.
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Changing the properties
of the DTMO02 element

You have determined that your partner will send you six digits for the
DTMO02 element (Date/Time/Period). These six digits will be a Dt/Tm data
type in the YYMMDD format (two-digit year, two-digit month, and two-
digit day). You must change the minimum and maximum length, the type,
and the format of the DTMO02 element.

Complete the following steps to change the length of the DTMO02 element:
1. Double-click the DTMO02 element to display the Field Properties dialog:
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2. Inthe Min box, type “6” as the minimum length.
In the Max box, type “6” as the maximum length.

4. From the Type list, select “Dt/Tm.” This indicates that this is a date/time
element. The system prompts you with a message that changing the
field’s data type will invalidate its format. Click YES to acknowledge
this message and proceed.

5. From the Format list, select “YYMMDD” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits will contain the day.

The Field Properties dialog should now look like this:
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6. Click OK to exit the Field Properties dialog.

60 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Mapping Your Data

Creating the The following table lists the temporary storage segment details that you will
TEMPDATES temporary create.
storage segment
Min Max
Usage Usage

Tag

TEMPDATES $$$ 0 1

Complete the following steps to create the TEMPDATES temporary storage
segment:

1. Highlight the DTM segment. The temporary storage segment is located
after the DTM segment, at the same level.

2. Select Insert from the Edit menu. Select Record from the submenu. The
EDI Segment Properties dialog is displayed.
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3. Inthe Name box, type “TEMPDATES”.

4. Inthe Tag box, type “$$$”. Because the system does not read a segment
with a value of “$$$” in the Tag box, it will not flag this temporary
storage segment as an error during compliance checking.
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The EDI Segment Properties dialog should now look like this:
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5. Click OK to create the TEMPDATES temporary storage segment.

Creating the PODATE Add an element to the temporary storage segment that you just created. The

temporary storage following table lists the temporary storage element details
element

Description i Format

PODATE Purchase Order Date 6 6 Dt/Tm YYMMDD

Complete the following steps to create the PODATE element:

1. Highlight the TEMPDATES segment. Select Create Sub from the Edit
menu to create a subordinate element.

2. Select Field from the submenu.

62 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Mapping Your Data

The Field Properties dialog is displayed.
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3. Inthe Name box, type “PODATE”.
4. Inthe Description box, type “Purchase Order Date”.
5. In the Min box, type “6” as the minimum length.
6. Inthe Max box, type “6” as the maximum length.
7. From the Type list, select “Dt/Tm.” Click YES to acknowledge the

message prompt and proceed.

8. From the Format list, select “YYMMDD?, to indicate how the element
is formatted.

The Field Properties dialog should now look like this:
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9. Click OK to create the PODATE element.
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Using an extended rule Use an extended rule to extract the order date/time from the DTM segment
and move it to the PODATE temporary storage element. The system
executes the extended rule after reading the DTMO01 (Date/Time Qualifier).

Complete the following steps to create the extended rule:
1. Double-click the DTMO01 element to access the Field Properties dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:

IF #2005 = "4" THEN
BEGIN

$ORDERS.#PODATE = #2380;
END
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The rule is executed if the DTMO01 element contains “4” (order date/
time).

4. Click COMPILE to validate the extended rule’s syntax. Each rule in the
map is compiled when you compile the translation object. The system
allows you to compile each rule individually so that you can verify its
accuracy after you create it.

This compiles the rule interactively and allows you to

correct any generated errors. Errors or warnings that
occur during the compilation process are displayed in
the Compile Errors box.

5. Click OK to add the extended rule to the DTMO1 element.
6. Click CLOSE to exit the Field Properties dialog.

Mapping the order date/ Use the Link function to map the PODATEHDR field directly from the
time PODATE temporary storage element. The Link function allows you to map
a field or element from the Input side of the map to a field or element on the
Output side of the map. The link between the two fields is visually
represented with a line connecting the two fields.

Complete the following steps to map the order date/time:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the PODATE temporary storage element in the TEMPDATES
segment. When you click the element, the cursor changes to a “Link
Arrow”™: | e

3. Click the application field PODATEHDR in the POHEADER record.

A line is displayed, visually illustrating the link between the PODATE
element and the PODATEHDR field.

PONUMHDR  Use the Link function to map the PONUMHDR field directly from the
BGMO5 (Document/Message Number). Your partner will only send you up
to 22 characters for the BGMO05 element (Document/Message Number), so
you must change the maximum length allowed for that element.

We recommend that you set up a Document Name for each map to make
identifying map messages easier. This allows you to differentiate between
messages in the document browsers in Gentran:Director.
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Mapping the document/
message number

Changing the maximum
length of the BGMO05
element

To set up a Document Name, select an element or field in the map that
contains data that distinguishes the messages translated by this map.The
Name field of the document browsers that contain this message contain the
data from the selected element or field.

We strongly recommend that you select an element or
field that occurs only once in the message and has a
data type of “String.” For a Purchase Order, the
document name is typically the Purchase Order
Number.

To map the document/message number, link the BGMO5 element in the
BGM record to the application field PONUMHDR in the POHEADER
record.

Because your partner will only send 22 alphanumeric characters for the
BGMO5 element (Document/Message Number), you must change the
maximum length of the BGMO05 element.

Complete the following steps to change the length of the BGMO05 element:
1. Double-click the BGMOS5 element to display the Field Properties dialog:
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Setting up the document
name

2. In the Max box, type “22” as the maximum length.

With the Field Properties dialog for the BGMOS5 element still displayed,
complete the following steps to set up the Document Name for this Purchase
Order:

1. If the Advanced section of the Field Properties dialog is not currently
displayed, click ADVANCED>> to access this section, which enables
you to define rules.

2. Click the Use Standard Rule check box to display the rule options.
3. Click the Update option.
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4. From the Table/Key list, select “Document record.” This indicates that
you are updating the document record in Gentran:Director.

5. From the Field list, select “Document Name.” This indicates that you
are updating the Name field in the document browsers with the contents
of this element.

The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to set up the document name.

POTYPCODE Use the Link function to map the POTYPCODE field directly from the
BGMO06 (Message Function, Coded) element.

To map the coded message function, link the BGMO06 element in the
BGM record to the application field POTYPCODE in the POHEADER
record.

SHIPTONAME On the EDI side of the map, the name and address information is contained
in the NAD segment in the NAD group. The NAD group contains shipping
and billing name and address information. It repeats multiple times. If the
Party Qualifier (in the NAD segment) is “ST,” that iteration of the NAD
group contains shipping information. You must map the shipping
information to the Ship To fields in the application header record. If the
Party Qualifier is “BT,” that iteration of the NAD group contains billing
information. You must map the billing information to the Bill To fields in
the application header record.

To map the correct information (either bill to or ship to) from the NAD
group to the Bill To and Ship To fields in the application header record, you
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must extract the billing and the shipping information after determining the
type. Because your partner will only send you up to two characters for the
NAD20 element (Country Sub-Entity Identification), you must change the
maximum length allowed for that element.

To map the shipping and billing information to your application file format,
you must create temporary storage segments and elements on the EDI side of
the map that do not repeat. Use an extended rule to extract the shipping and
billing information from the NAD group and move it to the appropriate
temporary storage elements. Map the shipping and billing information
directly from the temporary storage elements to your application fields.

Creating temporary  The following table lists the temporary storage segments that you will create.

storage segments

Ta Min Max
9 Usage Usage
ShipToDet Ship To Details $$$ 0 1
BillToDet Bill To Details $$$ 0 1

Creating the shipping Complete the following steps to create the ShipToDet temporary storage
temporary storage segment:

segment

April 2005

Highlight the NAD group. The two temporary storage segments are
located after the NAD group at the same level.

Select Insert from the Edit menu. Select Record from the submenu.
The EDI Segment Properties dialog is displayed.

In the Name box, type “ShipToDet”.

In the Description box, type “Ship To Details”.

In the Tag box, type “$$$”.
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The EDI Segment Properties dialog should now look like this:
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6. Click OK to create the ShipToDet temporary storage segment.

Creating the billing Complete the following steps to create the BillToDet temporary storage
temporary storage segment:

segment Highlight the ShipToDet segment.
2. Select Insert from the Edit menu. Select Record from the submenu.
The EDI Segment Properties dialog is displayed.
In the Name box, type “BillToDet”.
4. In the Description box, type “Bill To Details”.

5. Inthe Tag box, type “$$$”.
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The EDI Segment Properties dialog should now look like this:
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6. Click OK to create the BillToDet temporary storage segment.

Creating the temporary  Add the elements on the following table to the temporary storage segments

70

storage elements you just created.

Max
EDI Segment EDI Element Length
ShipToDet SHIPTONAME 35
SHIPTOADDR1 35
SHIPTOADDR2 35
SHIPTOCITY 35
SHIPTOSTATE 2
SHIPTOPCODE 9
BillToDet BILLTONAME 35
BILLTOADDR1 35
BILLTOADDR2 35
BILLTOCITY 35
BILLTOSTATE 2
BILLTOPCODE 9
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Creating the shipping Complete the following steps to create the ShipToDet elements:

t t A . .
emporar)élsercr)]:}s\r?é 1. Highlight the ShipToDet segment. Select Create Sub from the Edit
menu to create a subordinate element.

2. Select Field from the submenu.

The Field Properties dialog is displayed
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3. In the Name box, type “SHIPTONAME”.
4. Inthe Max box, type “35” as the maximum length.

The Field Properties dialog should now look like this:
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5. Click OK to create the SHIPTONAME element.
Create the remaining Ship To elements.

6. With the SHIPTONAME element highlighted, select Insert from the
Edit menu. Select Field from the submenu to display the Field
Properties dialog.
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7. Repeat steps 3 through 6 for the remaining elements on the following

table.
Max
EDI Segment EDI Element Length
ShipToDet SHIPTONAME 35
SHIPTOADDR1 35
SHIPTOADDR2 35
SHIPTOCITY 35
SHIPTOSTATE 2
SHIPTOPCODE 9

Creating the billing Complete following steps to create BillToDet elements:
temporary storage

clements 1 Highlight the BillToDet segment. Select Create Sub from the Edit menu

to create a subordinate element.
2. Select Field from the submenu.
The Field Properties dialog is displayed.
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3. Inthe Name box, type “BILLTONAME”.
4. Inthe Max box, type “35” as the maximum length.

The Field Properties dialog should now look like this:
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5. Click OK to create the BILLTONAME element.
Create the remaining Bill To elements.

6. With the BILLTONAME element highlighted, select Insert from the
Edit menu. Select Field from the submenu to display the Field
Properties dialog.

7. Repeat steps 3 through 6 for the remaining elements on the following

table.
Max
EDI Segment EDI Element Length
BillToDet BILLTONAME 35
BILLTOADDR1 35
BILLTOADDR2 35
BILLTOCITY 35
BILLTOSTATE 2
BILLTOPCODE 9

Changing the maximum Because your partner will only send you two alphanumeric characters for the
length of the NAD20 NAD20 element (Country Sub-Entity Identification), which represent the
element  state, province, or country of the party identified in the NADO1 element
(Party Qualifier), you must change the maximum length of the NAD20
element.

Complete the following steps to change the length of the NAD20 element:
1. Double-click the NAD20 element to display the Field Properties dialog:
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2. Inthe Max box, type “2” as the maximum length.
3. Click OK to exit the Field Properties dialog.
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Using an extended rule Use an extended rule to extract the shipping and billing information from the

74

NAD group and move it to the appropriate temporary storage element. After
the system reads an occurrence of the NAD group and executes the extended
rule.

Complete the following steps to create the extended rule:

1. Click the NAD group with the right mouse button and select Rules... to
display the Loop Level Extended Rules dialog.

i Loop Level Extended Rules M=l E5
' On Begin " OnEnd
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Cancel

=

Compile

1y of

Compile Errors

2. Click the On End option to specify that the rule will be executed when
the loop terminates. The system loads an occurrence of the NAD group
(containing the billing or shipping information) and then executes this
rule.

3. In the Editor box, type the following:

IF #3035 ="BT" THEN

BEGIN
$ORDERS.#BILLTONAME = #3036;
$ORDERS.#BILLTOADDRL1 = #3042;
$ORDERS #BILLTOADDR?2 = #3042:2;
$ORDERS#BILLTOCITY = #3164;
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$ORDERS #BILLTOSTATE = #3229;
$ORDERS #BILLTOPCODE = #3251;
END
IF #3035 ="ST" THEN
BEGIN
$ORDERS #SHIPTONAME = #3036;
$ORDERS #SHIPTOADDR1 = #3042;
$ORDERS.#SHIPTOADDR? = #3042:2;
$ORDERS#SHIPTOCITY =#3164;
$ORDERS #SHIPTOSTATE = #3229;
$ORDERS.#SHIPTOPCODE = #3251;
END

If a segment/record or element/field occurs more than
once in a map it is identified by its name <ID>.
Subsequent occurrences are identified by <ID>:n,
where “n” is the number of the occurrence in the map.

4. Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the NAD group.

Mapping the ship to  After you create the temporary storage segments and elements and add the
name information  extended rule, map the shipping and billing information directly from the
temporary storage elements to your application fields.

Link the SHIPTONAME element in the ShipToDet temporary storage
segment to the application field SHIPTONAME in the POHEADER.

SHIPTOADD1 To map the SHIPTOADDJ, link the SHIPTOADDRL1 element in the
ShipToDet temporary storage segment to the application field
SHIPTOADDL1 in the POHEADER record.

SHIPTOADD2 To map the SHIPTOADD?2, link the SHIPTOADDR?2 element in the
ShipToDet temporary storage segment to the application field
SHIPTOADD?2 in the POHEADER record.

SHIPTOCITY To map the SHIPTOCITY, link the SHIPTOCITY element in the
ShipToDet temporary storage segment to the application field
SHIPTOCITY in the POHEADER record.

SHIPTOSTATE To map the SHIPTOSTATE, link the SHIPTOSTATE element in the
ShipToDet temporary storage segment to the application field
SHIPTOSTATE in the POHEADER record.
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SHIPTOPCODE

BILLTONAME

BILLTOADD1

BILLTOADD?2

BILLTOCITY

BILLTOSTATE

BILLTOPCODE

DELDATE

To map the SHIPTOPCODE (postal code), link the SHIPTOCODE
element in the ShipToDet temporary storage segment to the application
field SHIPTOPOSTALCODE in the POHEADER record.

To map the BILLTONAME, link the BILLTONAME element in the
BillToDet temporary storage segment to the application field
BILLTONAME in the POHEADER record.

To map the BILLTOADDI, link the BILLTOADDR1element in the
BillToDet temporary storage segment to the application field to the
BILLTOADD1 in the POHEADER record.

To map the BILLTOADD?2, link the BILLTOADDR? element in the
BillToDet temporary storage segment to the application field
BILLTOADD?2 in the POHEADER record.

To map the BILLTOCITY, link the BILLTOCITY element in the
BillToDet temporary storage segment to the application field
BILLTOCITY in the POHEADER record.

To map the BILLTOSTATE, link the BILLTOSTATE element in the
BillToDet temporary storage segment to the application field
BILLTOSTATE in the POHEADER record.

To map the BILLTOPCODE (postal code), link the BILLTOPCODE
element in the BillToDet temporary storage segment to the application
field BILLTOPOSTALCODE in the POHEADER record.

The DTM segment contains all the purchase order date information. It
repeats multiple times. If the DTMO1 (Date/Time/Period/Qualifier) is “117”,
that iteration of the DTM segment contains the First Delivery Date/Time.
You must map the delivery information to the DELDATE field in the
application header record. If the DTMO1 (Date/Time/Period/Qualifier) is
“153”, that iteration of the DTM segment contains the Latest Cancellation
Date/Time. You must map the cancel by date information to the
CANCELDATE field in the application header record.

To map the delivery and cancel by date information to your application file,
you must create temporary storage elements in the TEMPDATES temporary
storage segment that you have already created on the EDI side of the map.
Use an extended rule to extract the delivery and cancel by date information
from the DTM segment and move it to the appropriate temporary storage
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elements. Map the delivery and cancel by date information directly from the
temporary storage elements to your application fields.

You have already changed the properties of the DTMO02 element (Date/
Time/Period) to reflect the minimum and maximum length, the type, and the
format that your partner will send you.

Creating temporary Complete the following steps to create the DELDATE and CANCELDATE
storage date elements  temporary storage elements:

1. Highlight the PODATE element (in the TEMPDATES segment) and
select Insert from the Edit menu. Select Field from the submenu to
display the Field Properties dialog.

hicld Properics

Nare |
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Min  Ma: Type Format
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2. Inthe Name box, type “DELDATE”.
3. In the Description box, type “Delivery Date”.
4. Inthe Min box, type “6” as the minimum length.
5. In the Max box, type “6” as the maximum length.
6. From the Type list, select “Dt/Tm” to indicate that this is a date/time

element. The system prompts you with a message that changing the
field’s data type will invalidate its format. Click YES to acknowledge
this message and proceed.

To turn off the message prompt, select Preferences
from the Options menu. Select the Confirmations tab
and clear the “Confirm everything” check box. From

the “Confirm when 1...” list, clear the “Change a
format or datatype of a field” check box. Select OK to
save.

7. From the Format list, select “YYMMDD?”, to indicate that the first two
digits will contain the year, the second two digits will contain the
month, and the last two digits will contain the day.
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The Field Properties dialog should now look like this:
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8. Click OK to create the DELDATE element.
Create the CANCELDATE element.

9. With the DELDATE element highlighted, select Insert from the Edit
menu. Select Field from the submenu to display the Field Properties
dialog.

10. In the Name box, type “CANCELDATE".

11. In the Description box, type “Cancel By Date”.
12. In the Min box, type “6” as the minimum length.
13. In the Max box, type “6” as the maximum length.

14. From the Type list, select Dt/Tm. This indicates that this is a date/time
element.

15. From the Format list, select “YYMMDD,” to indicate that the first two
digits will contain the year, the second two digits will contain the
month, and the last two digits will contain the day.

The Field Properties dialog should now look like this:
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16. Click OK to create the CANCELDATE element.
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Using an extended rule Use an extended rule to extract the delivery and cancel by date information
from the DTM segment and move it to the appropriate temporary storage

elements. After the system reads the DTMO1 (Date/Time/Period/Qualifier),

it executes the extended rule.
Complete the following steps to create the extended rule:
1. Double-click the DTMO1 element to access the Field Properties dialog

|zl 'opoitics
Nee 2005
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2. Click RULE... to display the Field Level Extended Rule dialog.

IF Fz20Q3 = "d' THEN
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3. The Rule list already contains the extended rule that extracts the order
date/time from the DTM segment (if the Date/Time/Period/Qualifier is
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“4) and moves it to the PODATE temporary storage element. In the
Rule list below this extended rule, type the following:

IF #2005 = "117" THEN
BEGIN

$ORDERS.#DELDATE = #2380;
END
IF #2005 = "153" THEN
BEGIN

$ORDERS.#CANCELDATE = #2380;
END

The Field Level Extended Rule dialog should now look like this:
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The system loads the DTMO02 element (containing the delivery and
cancel by date information) and executes this rule.

4. Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the DTMO1 element.
6. Click CLOSE to exit the Field Properties dialog.
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Mapping the date  After you create the temporary storage segment and elements and add the
information  extended rule, map the delivery and cancel by date information directly from
the temporary storage elements to your application fields.

To map the delivery date, link the DELDATE element in the TEMPDATES
temporary storage segment to the application field DELDATE in the
—| POHEADER record.

CANCELDATE To map the cancel by date, link the CANCELDATE element in the
TEMPDATES temporary storage segment to the application field
CANCELDATE in the POHEADER record.

NUMLINEITEMS  On the EDI side of the map, the CNT segment contains control total
information. The segment contains all the control values and repeats
multiple times. If the CNTO1 (Control Qualifier) is “2,” that iteration of the
CNT segment contains the number of line items in the message. You must
map the total number of line items to the NUMLINEITEMS field in the
POHEADER application record and the NUMLINEITEMSUM field in the
POSUMMARY application record.

In order to map the correct information from the CNT segment to the
NUMLINEITEMS field in the application header record, you must
determine the control value type and extract the number of line items.

To map the number of line items to your application file format, you need to
create a temporary storage segment and element on the EDI side of the map
that do not repeat. You can use an extended rule to extract the number of line
items from the CNT segment and move it to the appropriate temporary
storage element. Map the number of line items directly from the temporary
storage element to the NUMLINEITEMS application field.

Creating the The following table lists the temporary storage segment details that you will
TEMPCONTROL create.
temporary storage
segment Min Max
Usage Usage

Tag

TEMPCONTROL $$$ 0 1

Complete the following steps to create the TEMPCONTROL temporary
storage segment:

1. Highlight the CNT segment. The temporary storage segment is located
after the CNT segment at the same level.

2. Select Insert from the Edit menu. Select Record from the submenu.

The EDI Segment Properties dialog is displayed.
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5.

In the Name box, type “TEMPCONTROL”.
In the Tag box, type “$$$”.
The EDI Segment Properties dialog should now look like this:
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Click OK to create the TEMPCONTROL temporary storage segment.

Creating the  Add an elements to the temporary storage segment you just created. The
NUMLINEITEMS  following table lists the details of the temporary storage element:

temporary storage
element

Description Max Type Format

NUMLINEITEMS Number of Line Items 6 Number R9

Complete the following steps to create the NUMLINEITEMS element:

1.

I e

82 April 2005

Highlight the TEMPCONTROL segment. Select Create Sub from the
Edit menu to create a subordinate element.

Select Field from the submenu.

The Field Properties dialog is displayed

In the Name box, type “NUMLINEITEMS”.

In the Description box, type “Number of Line Items”.
In the Max box, type “6” as the maximum length.

From the Type list, select “Number.”
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7.

From the Format list, select “R9.” This indicates that the element will be
formatted with an explicit decimal point and up to nine places.

The Field Properties dialog should now look like this:
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8.

Click OK to create the NUMLINEITEMS element.

Using an extended rule Use an extended rule to extract the number of line items from the CNT
segment and move it to the NUMLINEITEMS temporary storage element.
After the system reads an occurrence of the CNT segment, it executes the
extended rule.

Mapping the total

Complete the following steps to create the extended rule:

1.

5.

Click the CNT segment with the right mouse button and select Extended
Rules... to display the Loop Level Extended Rules dialog.
Select the On End option. This specifies that the rule will be executed
when the loop terminates. The system loads an occurrence of the CNT
segment (containing the control value information), and executes this
rule.
In the Editor box, type the following:
IF #6069 = "2" THEN
BEGIN

$ORDERS.#NUMLINEITEMS = #6066;
END
Click COMP I LE to validate the extended rule’s syntax.

Click OK to add the extended rule to the CNT segment.

Use the Link function to map the NUMLINEITEMS field directly from the
number of line items  NUMLINEITEMS temporary storage element.

To map the number of line items to the application header record, link the
NUMLINEITEMS temporary storage element in the TEMPCONTROL
temporary storage segment to the application field NUMLINEITEMS in the
POHEADER record.
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PODetailGroup

PODETAIL
Record

CUSTNUMDET

The PODetailGroup (detail information) contains all line item information
for the order, including the item, unit of measure, price, quantity ordered,
description, and the allowance and charge information. Each PODetailGroup
occurs up to 200,000 times per order translated. This equals a maximum
order of 200,000 items. The information within the PODetailGroup is further
segregated by record (PODETAIL, PODESC, POALLCHG).

This section describes how to map each field in the PODETAIL (detail)
record. The PODETAIL (detail) record contains line item code humber, unit
of measure, price, and quantity ordered. The PODETAIL record occurs once
per PODetailGroup.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps by
means of a standard rule. Map information from your trading partner's
profile in the Partner Editor to a selected element or field in the map. The
information that you use in the map includes any field in a table (location,
lookup, or cross-reference) or data from the partner key.

For this map, you must pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is part of the record key for each record, it
appears five times in the application, once in each record (CUSTNUMHDR,
CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application. It identifies which trading partner sent the purchase order.
This customer number is already part of the partner definition for this partner
S0 you can map it from the partner definition to each customer number field.
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Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMDET field (in the PODETAIL record) to
display the Field Properties dialog.

mon
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Verify that the Select option is selected.

4. From the Table list, select “Document record” to indicate that the
system will update this field with selected information from the
document record.

5. Select the Exclusive check box to indicate that the system generate a
compliance error if it does not find a valid entry.

6. From the Map From list, select “Partner Key.” This field contains the
customer number for this partner.

7. From the Map To list, select “CUSTNUMDET.” Partner Editor
information will be mapped to this field.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMDET field.

PODATEDET On the EDI side of the map, the date information is contained in the DTM
segment. The DTM segment contains date information for the header part of
the map and repeats multiple times. If the DTMO1 (Date/Time/Period
Qualifier) is “4,” that iteration of the DTM segment contains the order date/
time. You must map the order date/time to the PODATE field in each
application record (PODATEHDR, PODATEDET, PODATEDESC,
PODATEAC, and PODATESUM).

You created a temporary storage segment and element on the EDI side of the
map that does not repeat. You used an extended rule to extract the order date/
time information from the DTM segment and move it to the PODATE
temporary storage element.

The TEMPDATES temporary storage segment does not repeat. You must
map the information from the PODATE temporary storage element to the
PODATEDET field. The PODATEDET field is included in the PODETAIL
segment in the PODetailGroup, which repeats 200,000 times.

You must map fields and elements that are at the same level. This means that
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order date in the TEMPDATES
temporary storage segment directly to your application PODATEDET field.

To map the purchase order date to this application field, you must use an
extended rule to extract the purchase order date from the PODATE
temporary storage element and move it to the PODATEDET field.
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Using an extended rule

Complete the following steps to create the extended rule:

1. Double-click the PODATEDET field to access the Field Properties
dialog.

Neme [PoDATEDET
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule list, type the following:
#PODATEDET = $ORDERS.#PODATE;

The “$ORDERS.#PODATE” is the addressing for the PODATE
temporary storage element. After system processes the PODATEDET
field, it executes this rule.

4. Click COMPILE to validate the extended rule’s syntax.
Click OK to add the extended rule to the PODATEDET field.
6. Click CLOSE to exit the Field Properties dialog.

The BGMO5 (Document/Message Number) element contains the purchase
order number. The BGM segment does not repeat. You must map the
information from the BGMO5 element to the PONUMDET field. The
PONUMDET field is included in the PODetailGroup, which repeats 200,000
times.

You can only map fields and elements that are at the same level. To map the
document/message number to this application field, you must use an
extended rule to extract the purchase order number from the BGMO05
element and move it to the PONUMDET field.
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Using an extended rule

Complete the following steps to create the extended rule:

1. Double-click the PONUMDET field to access the Field Properties
dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule list, type the following:
#PONUMDET = $ORDERS.#1004;

The “SORDERS.#1004” is the addressing for the BGMO05 element.
After the system processes the PONUMDET field, it executes this rule.

4. Click COMPILE to validate the syntax of the extended rule.
Click OK to add the extended rule to the PONUMDET field.
6. Click CLOSE to exit the Field Properties dialog.

The Application Integration subsystem enables you to use selected
information from the Gentran:Director partner database in your maps by
means of a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner record.

You must map information from a cross-reference table for the PETZONE1
partner profile to translate your partner’s code for a purchased item and your
code for the same item. Your partner uses a customer product code
(CUSTPROCODE) for each item. Your company uses a UPC code
(UPCCODE) for each item. After you and your partner determine what the
equivalent customer product code is for each UPC code, you can create a
cross-reference table in the Partner Editor and use that information in your
map.

A cross-reference table is used when you and your partner each reference an
item by a different name (or number). For example, if your unique name for
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Mapping the customer
product code

Creating a cross-
reference table

a “widget”

is “wid” and your partner’s unigue name for the same “widget” is

“1234”, the system uses the cross-reference table to translate the two names
for the “widget” item.

In this map, you have one code (UPC code) for each item ordered. Your
partner refers to the same item by a different code (customer product code).
You must map the customer product code from the LINO3 element (Item
Number) to the customer product code field (CUSTPROCODE) on the
application side of the map. In order to achieve this, you must create a cross-
reference table to translate the customer product code to your UPC code.

%

Before you create the cross-reference table, you and
your partner must determine what the equivalent
customer product code is for each UPC code. Then you
can create the cross-reference table in Partner Editor
and use that information in your map.

Finally, you must use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.

To map the customer product code, link the LINO3 element in the LIN
segment (in the LIN group) to the application field CUSTPROCODE in the
PODETAIL record.

In the Partner Editor, create a cross-reference table named “PRODCODE".
See the Gentran:Director User’s Guide or online Help for more information
on creating a cross-reference table.

The cross-reference table you create will only contain
six entries. This is an example — an actual table would
contain all of the items your company manufactures
that your partner purchases.

Use the information in the following table when you create the cross-
reference table. The “My Value” field contains your UPC code for the item.
The “Partner Value” field contains your partner’s customer product code for
the item. The “Description” field contains a description (and size, if
applicable) of the item, and the Reference Data field contains additional
quantity or color information.

My Value Partner Value Description Reference Data
12345678901234 555666411 Large Dog Collar Red
23456789012345 555666817 Spring Breeze Cat Litter 5 Kg. Bag
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My Value Partner Value Description Reference Data
34567890123456 555666908 Small Beef Basted Rawhide Bones Bag of 12
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

Translating Complete the following steps to translate your partner’s customer product

CUSTPROCODE to  code to your UPC Code for each item your partner ordered:
UPCCODE

90

1.

Double-click the CUSTPROCODE field (in the PODETALIL record).
The Field Properties dialog is displayed.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

4. From the Table box, select “Partner xref by partner item.” This indicates
that you are using a cross-reference table and translating by your
partner’s item.

5. In the Sub Table box, type “PRODCODE”. This is the name of the
cross-reference table you created.

6. Select the Exclusive check box to signal the generate a compliance error
if the translation fails.

7. From the Map From list, select “My Item” to map the contents from this

April 2005

field.

From the Map To list, select “UPCCODE” to map Partner Editor
information to this field.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to map from the cross-reference table.

UOM Onthe EDI side of the map, the line item information is contained in the LIN
group (in the LIN, IMD:2, QTY:3, and MOA:5 segments). The QTY:3
segment repeats multiple times. You need to map the unit of measurement
from the QTY:3 segment to the PODETAIL application record, which does
not repeat. To map the unit of measurement from the QTY:303 element to
the PODETAIL record, you must create a temporary storage segment and
element on the EDI side of the map that do not repeat.

Use an extended rule to extract the unit of measurement from the QTY:3
segment and move it to the appropriate temporary storage element. Map the
unit of measurement directly from the temporary storage element to the
UOM application field.

Creating the Complete the following steps to create the TEMPLINEITEM temporary
TEMPLINEITEM  storage segment:

temporary storage o .
segment 1. Highlight the LIN segment (in the LIN group). Select Insert from the

Edit menu. Select Record from the submenu.
The EDI Segment Properties dialog is displayed.
2. In the Name box, type “TEMPLINEITEM”.
3. Inthe Tag box, type “$$$”.
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The EDI Segment Properties dialog should now look like this:
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4. Click OK to create the TEMPLINEITEM temporary storage segment.

Creating the UNITMEAS  Complete the following steps to create the UNITMEAS temporary storage

92

temporary storage element:
element

Highlight the TEMPLINEITEM segment. Select Create Sub from the
Edit menu to create a subordinate element. Select Field from the

submenu.

The Field Properties dialog is displayed.
2. Inthe Name box, type “UNITMEAS”.
3. Inthe Description box, type “Unit of Measurement”.
4. In the Max box, type “3” as the maximum length.
The Field Properties dialog should now look like this:
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5. Click OK to create the UNITMEAS element.
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Using an extended rule Use an extended rule to extract the unit of measurement from the QTY:3
segment and move it to the UNITMEAS temporary storage element. After
the system reads the QTY:303 element (Measure Unit Qualifier), it executes
the extended rule.

Complete the following steps to create the extended rule:

1. Double-click the QTY:303 element to access the Field Properties dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule box, type the following:

IF #6063 = "21" THEN
BEGIN

$2500_LIN#UNITMEAS = #6411:2;
END

The system verifies that the QTY:303 element does contain “21”
(quantity ordered) and executes this rule.

4. Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the QTY:303 element.
6. Click CLOSE to exit the Field Properties dialog.

Mapping the unit of Use the Link function to map the UOM (Unit of Measurement) field directly
measurement  from the UNITMEAS temporary storage element.

Link the UNITMEAS temporary storage element in the
TEMPLINEITEM temporary storage segment (in the LIN group) to the
application field UOM in the PODETAIL record.

UNITPR The MOA:5 segment repeats multiple times. You must map the unit price
from the MOA:5 segment to the PODETAIL application record, which does
not repeat. The MOA.:5 segment contains monetary amount information, and
repeats multiple times. If the MOA:501 element (Monetary Amount Type) is
“146,” that iteration of the MOA:5 segment contains the unit price for that
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line item. You must map the unit price to the UNITPR field in the
PODETAIL application record.

To map the correct information from the MOA:5 segment to the UNITPR
field, you must extract the unit price after determining the type of monetary
amount. You must create a temporary storage element in the
TEMPLINEITEM temporary storage segment that you have already created.

Use an extended rule to extract the unit price from the MOA:5 segment and
move it to the appropriate temporary storage element. You can then map the
unit price directly from the temporary storage element to the UNITPR
application field.

Creating the Complete the following steps to create the UNITPRICE temporary storage
UNITPRICE temporary element:

storage element o X
Highlight the UNITMEAS temporary storage element (in the

TEMPLINEITEM segment). Select Insert from the Edit menu to create
a subordinate element, and select Field from the submenu.

The Field Properties dialog is displayed.
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In the Name field, type “UNITPRICE”.

In the Description field, type “Unit Price”.

In the Max field, type “14” as the maximum length.
From the Type list, select “Number.”

o o~ w D

From the Format list, select “R9” to indicate that the element will be
formatted with an explicit decimal point and up to nine places.
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The Field Properties dialog should now look like this:
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7. Click OK to create the UNITPRICE element.

Using an extended rule Use an extended rule to extract the unit price from the MOA:5 segment and
move it to the UNITPRICE temporary storage element. After the system
reads the MOA:501 element (Monetary Amount Type), it executes the
extended rule.

Complete the following steps to create the extended rule:
1. Double-click the MOA:501 element to access the Field Properties

dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule box, type the following:

IF #5025 = "146" THEN
BEGIN

$2500_LIN.#UNITPRICE = #5004;
END

The system verifies that the MOA:501 element does contain “146” (unit
price) and executes this rule.
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Mapping the unit price

QTYORD

Creating the QTYORD
temporary storage
element

4. Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the MOA:501 element.
6. Click CLOSE to exit the Field Properties dialog.

Map the UNITPR (Unit Price) field directly from the UNITPRICE
temporary storage element, by using the Link function.

Link the UNITPRICE temporary storage element in the
TEMPLINEITEM temporary storage segment (in the LIN group) to the
application field UNITPR in the PODETAIL record.

You must map the quantity ordered from the QTY:3 segment to the
PODETAIL application record, which does not repeat. The QTY:3 segment
contains quantity information and repeats multiple times. If the QTY:301
element (Quantity Qualifier) is “21,” that iteration of the QTY:3 segment
contains the quantity ordered for that line item. You must map the quantity
ordered to the QTYORD field in the PODETAIL application record.

In order to map the correct information from the QTY:3 segment to the
QTYORD field, you must determine the quality type and extract the quantity
ordered. You must create a temporary storage element in the
TEMPLINEITEM temporary storage segment that you have already created.

Use an extended rule to extract the quantity ordered from the QTY:3
segment and move it to the appropriate temporary storage element. Then
map the quantity ordered directly from the temporary storage element to the
QTYORD application field.

Complete the following steps to create the QTYORD temporary storage
element:

Highlight the UNITPRICE temporary storage element (in the
TEMPLINEITEM segment). Select Insert from the Edit menu to create
a subordinate element. Select Field from the submenu.

The Field Properties dialog is displayed.

In the Name field, type “QTYORD”.

In the Description field, type “Quantity Ordered”.
In the Max field, type “9” as the maximum length.

From the Type drop-down list, select “Number.”

o ok~ DN

From the Format drop-down list, select “R9” to indicate that the element
will be formatted with an explicit decimal point and up to nine places.
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The Field Properties dialog should now look like this:
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7.

Click OK to create the QTYORD element.

Using an extended rule Use an extended rule to extract the unit price from the QTY:3 segment and
move it to the QTYORD temporary storage element. After the system reads

the QTY:301 element (Quantity Qualifier), it executes the extended rule.

Complete the following steps to create the extended rule:

1. Double-click the QTY:301 element to access the Field Properties dialog.
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Click RULE... to display the Field Level Extended Rule dialog.
In the Rule box, type the following:

IF #6063 = "21" THEN
BEGIN
$2500_LIN.#QTYORD = #6060;
END
The system verifies that the QTY:301 element does contain “21”
(quantity ordered) and executes this rule.

Click COMP I LE to validate the syntax of the extended rule.
Click OK to add the extended rule to the QTY:301 element.
Click CLOSE to exit the Field Properties dialog.
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Mapping the quantity Use the Link function to map the QTYORD (quantity ordered) directly from
ordered the QTYORD temporary storage element.

Link the QTYORD temporary storage element in the TEMPLINEITEM
temporary storage segment (in the LIN group) to the application field
QTYORD in the PODETALIL record.

PODESC Record _ . _ _ o -
This section describes how to map each field in the PODESC (description)

record. The PODESC (description) record contains descriptive information
about the line item ordered. The PODESC record occurs up to five times per
PODetailGroup, so multiple descriptive terms can be used for each item. For
example, if the line item is a “dog collar,” the description fields may be
“red,” “large,” and “leather.”

CUSTNUMDESC The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps by
means of a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you must use information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

98 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Mapping Your Data

Complete the following steps to map the customer number from the partner

definition:

1. Double-click the CUSTNUMDESC field (in the PODESC record) to
display the Field Properties dialog.

| 1zld 'opoibics

P— {CUSTHUMDEST

D eceription IEu:th:ln'Et Number

ala ' aldation
M Max  Tpps Format —

W Wandatoy |1 fa fseng  [#]

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

4. From the Table list, select “Document record” to update this field with
information from the document record.

5. Select the Exclusive check box to generate a compliance error if the
system does not find a valid entry.

6. From the Map From list, select “Partner Key.” This contains the
customer number for this partner.

7. From the Map To list, select “CUSTNUMDESC.” Partner Editor
information is mapped to this field.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMDESC field.

PODATEDESC On the EDI side of the map, the date information is contained in the DTM
segment. The DTM segment contains date information for the header part of
the map, and repeats multiple times. If the DTMO0L1 (Date/Time/Period
Qualifier) is “4,” that iteration of the DTM segment contains the order date/
time. You must map the order date/time to the PODATE field in each the of
the application records (PODATEHDR, PODATEDET, PODATEDESC,
PODATEAC, and PODATESUM).

You have already created a temporary storage segment and element on the
EDI side of the map that do not repeat. You used an extended rule to extract
the order date/time information from the DTM segment and move it to the
PODATE temporary storage element.

The TEMPDATES temporary storage segment does not repeat. You must
map the information from the PODATE temporary storage element to the
PODATEDESC field. The PODATEDESC field is included in the PODESC
segment in the PODetailGroup, which repeats 200,000 times.

You only map fields and elements that are at the same level. This means that
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order date in the TEMPDATES

temporary storage segment directly to your application PODATEDESC
field.

To map the purchase order date to this application field, you must use an
extended rule to extract the purchase order date from the PODATE
temporary storage element and move it to the PODATEDESC field.
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Using an extended rule

Complete the following steps to create the extended rule:

1. Double-click the PODATEDESC field to access the Field Properties
dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule box, type the following:
#PODATEDESC = $ORDERS.#PODATE;
After the system processes the PODATEDESC field, it executes this
rule.
4. Click COMPILE to validate the extended rule’s syntax.
Click OK to add the extended rule to the PODATEDESC field.
6. Click CLOSE to exit the Field Properties dialog.
PONUMDESC The BGMO5 (Document/Message Number) element contains the purchase

order number. The BGM segment does not repeat. You must map the
information from the BGMO05 element to the PONUMDESC field. The
PONUMDESC field is included in the PODetailGroup, which repeats
200,000 times.

You only map fields and elements that are at the same level. This means that
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the document/message number in the BGM
segment directly to your application PONUMDESC field.

To map the document/message number to this application field, you must
use an extended rule to extract the purchase order number from the BGMO05
element and move it to the PONUMDESC field.
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Using an extended rule  Complete the following steps to create the extended rule:

1. Double-click the PONUMDESC field to access the Field Properties
dialog.
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Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule list, type the following:
#PONUMDESC = $ORDERS.#1004;
After the system processes the PONUMDESC field, it executes this
rule.
4, Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the PONUMDESC field.
6. Click CLOSE to exit the Field Properties dialog.

DESC The DESC field is available so your partner can describe the item in a
free-form format. Use the Link function to map the DESC (description) field
directly from the IMD:206 element.

Link the IMD:206 element in the IMD:2 segment (in the LIN group) to the
application field DESC in the PODESC record.

POALLCHG

Record This section describes how to map each field in the POALLCHG
(allowance/charge) record. The POALLCHG (allowance and charge) record
contains the allowance or charge indicator, method of handling code, and
total allowance or charge amount. The POALLCHG record occurs up to five
times per PODetailGroup, so multiple allowances and/or charges can be
used for each item.
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CUSTNUMAC

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps by
means of a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you must use information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMAC field (in the POALLCHG record) to
display the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.
From the Table list, select “Document record.”

Select the Exclusive check box.

o gk~ w

From the Map From list, select “Partner Key.” This contains the
customer number for this partner.

7. From the Map To list, select “CUSTNUMAC.”
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMAC field.

PODATEAC 0On the EDI side of the map, the date information is contained in the DTM
segment. The DTM segment contains date information for the header part of
the map, and repeats multiple times. If the DTMO1 (Date/Time/Period
Qualifier) is “4,” that iteration of the DTM segment contains the order date/
time. You need to map the order date/time to the PODATE field in each the
of the application records (PODATEHDR, PODATEDET, PODATEDESC,
PODATEAC, and PODATESUM).

You have already created a temporary storage segment and element on the
EDI side of the map that do not repeat. And you used an extended rule to
extract the order date/time information from the DTM segment and move it
to the PODATE temporary storage element.

The TEMPDATES temporary storage segment does not repeat. You must
map the information from the PODATE temporary storage element to the
PODATEAC field. The PODATEAC field is included in the POALLCHG
segment in the PODetailGroup, which repeats 200,000 times.

To map the purchase order date to this application field, you must use an
extended rule to extract the purchase order date from the PODATE
temporary storage element and move it to the PODATEAC field.
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Using an extended rule  Complete the following steps to create the extended rule:
1. Double-click the PODATEAC field to access the Field Properties

dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule list, type the following:
#PODATEAC = $ORDERS.#PODATE;

After the system processes the PODATEAC field, it executes this rule.
4. Click COMPILE to validate the extended rule’s syntax.
5. Click OK to add the extended rule to the PODATEAC field.
6. Click CLOSE to exit the Field Properties dialog.

PONUMAC The BGMO5 (Document/Message Number) element contains the purchase
order number. The BGM segment does not repeat. You need to map the
information from the BGMO05 element to the PONUMAC field. However,
the PONUMAC field is included in the PODetailGroup, which repeats
200,000 times.

To map the document/message number to this application field, you must
use an extended rule to extract the purchase order number from the BGMO05
element and move it to the PONUMAC field.
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Using an extended rule

Complete the following steps to create the extended rule:
1. Double-click the PONUMAC field to access the Field Properties dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
3. Inthe Rule list, type the following:
#PONUMAC = $ORDERS.#1004;
After the system processes the PONUMAC field, it executes this rule.
4. Click COMPILE to validate the extended rule’s syntax.
Click OK to add the extended rule to the PONUMAC field.
6. Click CLOSE to exit the Field Properties dialog.
ACIND On the EDI side of the map, the line item information is contained in the

ALC group (in the ALC:2 and MOA:8 segments). The ALC:2 segment is
contained in the ALC group, which is subordinate to the LIN group. You can
use a code list table to define which codes will be accepted for the allowance
or charge indicator in the ALC:201 element. The allowable codes are “A”
(Allowance) and “C” (Charge). Then map the allowance or charge indicator
from the ALC:2 segment directly to the POALLCHG application record,
which is subordinate to the PODetailGroup.
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Loading a code table Complete the following steps to load a code list table from the standard:
1.

Double-click the ALC:201 element to display the Field Properties
dialog.
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In the Advanced section, click the Use Standard Rules check box.
Click the Use Code option.
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4. Click EDIT TABLE... to access the Edit Code List dialog.

Edit Code Lict

~Tabke Oelails
Tahle |0 |5=153 Diase |.ﬁ.I_LIZr'-.h-'.d-.HI2E OR CHAAEE QUALIFER

Cance

#illawed Codex
Code Vake ['==cnphon

M

Dieeta

Load...

The Table ID contains the element name for which this code list table is
used. The Description box contains the element description for which
this code list table is used.

5. Click LOAD... to access the Load Code List dialog. You are prompted to
select a Data Source Name that the system uses to access the EDI
message standards. Select the appropriate DSN and click OK.
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Mapping the allowance
or charge indicator

ACMETHAND

Mapping the allowance
or charge method of
handling code

ACTOTAMT

6. Inthe Codes in Standard list, click the “A Allowance” code. Press the
SHIFT key and click the “C Charge” code, to highlight both codes.
Click ADD--> to move both codes to the Codes Selected list.

7. Click OK to load the selected codes and exit the Load Code List dialog.
8. Click CLOSE to exit the Edit Code List dialog.

In the Advanced section of the Field Properties dialog, verify that the
Table list contains “5463 ALLOWANCE OR CHARGE QUALIFIER.”

9. Click the Exclusive check box to specify that, for compliance reasons,
the element must contain one of two codes that you loaded from the
code list table.

10. Click CLOSE to exit the Field Properties dialog.

You can map the ACIND (allowance or charge indicator) field directly from
the ALC:201 element, which indicates that the total amount is an allowance
or charge.

Link the ALC:201 element in the ALC:2 segment (in the ALC group in the
LIN group) to the application field ACIND in the POALLCHG record.

On the EDI side of the map, the line item information is contained in the
ALC group (in the ALC:2 and MOA:8 segments). The ALC:2 segment is
contained in the ALC group, which is subordinate to the LIN group. You can
map the allowance or charge method of handling code directly from the
ALC:204 element in the ALC:2 segment to the POALLCHG application
record, which is subordinate to the PODetailGroup.

To map the ACMETHAND field, link the ALC:204 element in the ALC:2
segment (ALC group, LIN group) to the application field ACMETHAND in
the POALLCHG record.

On the EDI side of the map, the line item information is contained in the
ALC group (in the ALC:2 and MOA:8 segments). The MOA:8 segment is
contained in the MOA group, which is subordinate to the ALC group, which
is subordinate to the LIN group. You must map the allowance or charge total
amount from the MOA:8 segment to the POALLCHG application record,
which is subordinate to the PODetailGroup. The MOA group repeats up to
two times. Because your partner will only send you one iteration of the
MOA group, you must change the maximum usage for the group and
promote the records in the group to the parent level.
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You also know that the only Monetary Amount Type Qualifier (MOA:801
element) that your partner will send you is “128,” which specifies that
iteration of the MOA group contains the total amount of the allowance or
charge. Since “128” is the only qualifier that your partner will send, you do
not have to perform any mapping operations with this element.

You can map the allowance or charge total amount directly from the
MOA:802 element to the ACTOTAMT application field.

Changing the properties Complete the following steps to change the properties of the MOA group:

f the MOA . . .
of the MOA group Click the MOA group (ALC group, LIN group) with the right mouse
button and select Properties... from the shortcut menu to access the
Group Properties dialog.

2. Inthe Max Usage box, type “1” to make the MOA group a non-
repeating group.

3. Select the Promote records to parent option to specify that when this
group is compiled, the subordinate segments will be extracted and
placed in the parent group. This locates the MOA:8 segment at the same
level as the POALLCHG record on the application side of the map.

The Group Properties dialog should now look like this:
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4, Click OK to exit the Group Properties dialog.

Mapping the allowance Map the ACTOTAMT (allowance or charge total amount) field directly
or charge total amount  from the MOA:802 element, which indicates the handling method for the
allowance or charge.

Link the MOA:802 element in the MOA.:8 segment (ALC group, LIN group)
to the application field ACTOTAMT in the POALLCHG record.
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POSUMMARY
Record

CUSTNUMSUM

This section describes the actions necessary for you to map to each field in
the POSUMMARY (summary) record. The POSUMMARY record contains
the total number of line items in the purchase order. The POSUMMARY
record occurs once for each purchase order translated.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps by
means of a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you use in the map includes any field in a table
(location, lookup, or cross-reference) or data from the partner key.

For this map, you must use information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMSUM field (in the POSUMMARY record)
to display the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Verify that the Select option is selected.
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4. From the Table list, select “Document record.”
Click the Exclusive check box.

6. From the Map From list, select “Partner Key.” This is the field that
contains the customer number for this partner.

7. From the Map To list, select “CUSTNUMSUM.”

The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMSUM field.

PODATESUM On the EDI side of the map, the date information is contained in the DTM
segment. The DTM segment contains date information for the header part of
the map, and repeats multiple times. If the DTMO1 (Date/Time/Period
Qualifier) is “4,” that iteration of the DTM segment contains the order date/
time. You need to map the order date/time to the PODATE field in each the
of the application records (PODATEHDR, PODATEDET, PODATEDESC,
PODATEAC, and PODATESUM).

To map the correct information from the DTM segment to the
PODATESUM field in the application header record, you must determine
the data type and extract the order date/time.

You have already created a temporary storage segment and element on the
EDI side of the map that does not repeat. To map the order date/time
information to your application file format, you used an extended rule to
extract the order date/time information from the DTM segment and move it
to the appropriate temporary storage element. You can map the order date/
time directly from the temporary storage element to the PODATESUM
application field.
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Mapping the order date/
time

PONUMSUM

NUMLINEITEM
SUM

Use the Link function to map the PODATESUM field directly from the
PODATE temporary storage element.

Link the PODATE temporary storage element in the TEMPDATES segment
to the application field PODATESUM in the POSUMMARY record.

PODATE is already linked to the PODATEHDR in the
PODATE record. It is acceptable to have multiple links
to an element.

You previously determined that your partner will only send you up to 22
characters for the BGMO5 element (Document/Message Number), so you
have already changed the maximum length allowed for that element. Use the
Link function to map the PONUMSUM field directly from the BGMO05
(Document/Message Number) field. The BGMO5 element is already mapped
(linked) to the PONUMHDR field in the POHEADER application record, so
you will be adding an additional link from this element to the PONUMSUM
field in the POSUMMARY record.

To map the document/message number, link the BGMO5 element in the
BGM record to the application field PONUMSUM in the POSUMMARY
record.

On the EDI side of the map, the control total information is contained in the
CNT segment. The CNT segment contains all the control values, and repeats
multiple times. If the CNTO1 (Control Qualifier) is “2,” that iteration of the
CNT segment contains the number of line items in the message. You must
map the total number of line items to the NUMLINEITEMS field in the
POHEADER application record and the NUMLINEITEMSUM field in the
POSUMMARY application record.

To map the correct information from the CNT segment to the
NUMLINEITEMSUM field in the application summary record, you must
extract the number of line items after determining the type of control value.
You have already created a temporary storage segment (TEMPCONTROL)
and element (NUMLINEITEMS) on the EDI side of the map that do not
repeat. You used an extended rule to extract the number of line items from
the CNT segment and move it to the appropriate temporary storage element.

You can map the number of line items directly from the temporary storage
element to the NUMLINEITEMS application field. The NUMLINEITEMS
temporary storage element is already mapped (linked) to the
NUMLINEITEMS field in the POHEADER application record so you will
be adding an additional link from this element to the NUMLINEITEMSUM
field in the POSUMMARY record.
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Mapping the total Link the NUMLINEITEMS temporary storage element in the
number of line items  TEMPCONTROL temporary storage segment to the application field
NUMLINEITEMSUM in the POSUMMARY record.

After you complete the mapping operation for this final application field, the
icons representing each of the application fields should be bisected by a red
checkmark (except the UPCCODE field in the PODETAIL application
record). The red checkmark indicates that a mapping operation has been
performed against the field.

114 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Inbound Purchase Order (ORDERS) Finalizing the Map

Finalizing the Map

To complete the mapping process, you must save the map, compile the
translation object, print and review the Gentran:Director report, and test the
map.

Compiling the
Map The Compile function generates a translation object. The map that you

created (PET_EORD.MAP) is a source map. When that source map is
compiled, the result is a compiled translation object.

After you save the translation object, you must register it with the

Gentran:Director system before you can use it.

Complete the following steps to compile a map and generate a translation

object:

1. Select Save from the File menu to save the source map.

2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Hame EE

Save Ia Tramz0bj j gl :

File narme: IF'et_eold.TF'L
Save as type: ITransIation Objectz (= TPL) j Cancel |

3. The File Name box contains “pet_eord.tpl.” This is the name of the
translation object using the default . TPL file extension. We recommend
that you name the translation object (.TPL file) the same file name as
the map (.MAP file). Preserving the same file name (with different file
extensions) means that the relationship between the source map and the
compiled translation object will remain evident.

Do NOT overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.
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4. Change the drive and folder where the compiled translation object will
be stored, if necessary.

Do NOT store the compiled translation object in the
GENTRAN Director\RegTransObj subfolder. This
subfolder is reserved for storing a copy of each
translation object you register with Gentran:Director.

5. Click SAVE.The system compiles the map and generates a translation
object. The Compile Errors dialog is displayed. Verify that no errors
occurred (scroll down to the bottom of the list). Click OK to exit the
dialog.

6. Select Details from the Edit menu.
The Translation Object Details dialog is displayed.
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The date on which the translation object was compiled is automatically
loaded into the Compiled on box on the Translation Object Details.
Click CANCEL to exit the dialog.

7. Select Save from the File menu to save the source map.
You must register this translation object with the
Gentran:Director system before you can use it. See the

Gentran:Director User’s Guide for information on
registering a translation object.
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Printing the

Report The Gentran:Director report enables you to validate and review and modify
the map. If you review the report and determine that the map is incorrect,
make the modifications, save the map, recompile the translation object, and
print the report again.

Complete the following steps to print the Gentran:Director report:
1. Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.
Print Options
— Report zections
¥ Print branching diagram
I¥ Print record details

W Print mapping details
¥ PFrint extended rules

W Prirt code lists

W Inchude only active objects

2. Accept the defaults on this dialog (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog is displayed.

3. Select the appropriate options. Click OK.

Click SETUP... to select a specific printer, paper orientation, or size and
source of paper. The Print Setup dialog is displayed.

Testing the

Translation After you compile the map, print and verify the report, and register the
Object translation object with Gentran:Director, test the translation object to verify
that the data is translated correctly. To test the compiled translation object,
obtain test data from your partner(s) and process the data. Verify
acknowledgement processing (if applicable) and communications with your
network.

Following is an overview of the steps required for testing the inbound
(Export) translation object you just created:

1. Register the PET_EORD.TPL translation object with Gentran:Director.
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Please see the Gentran:Director User’s Guide for more information on
registering a translation object.

Import the PETZONEL.PAR partner relationship into Gentran:Director.
Please see the Gentran:Director User’s Guide for more information on
importing a partner.

Verify (in Partner Editor) that the PET E 92.1 ORDERS Export
translation object is selected for the Inbound Relationship. Please see
the Gentran:Director User’s Guide for more information on selecting
inbound translation objects.

Use the Process File option in Gentran:Director to process the data file
(PETTSTEL.INT) through the translation object. The data file is located
in the TUTORIAL subfolder under the folder where Gentran:Director is
installed. The default path for the data file is: C:\Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PETTSTELINT

After the message is translated, it is located in the In Documents in
Gentran:Director. Export the message to ensure that it was translated
correctly. Please see the Gentran:Director User’s Guide for more
information on exporting files.
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This tutorial defines the tasks necessary to create the map used to translate
your application file to EDIFACT invoices (INVOIC). After you translate
your application file to EDIFACT, it is ready to send to your trading partner.

This chapter explains the processes associated with creating a map for an
outbound invoice. Those include:

Mapping analysis

Creating the new map

Defining constants

Activating groups, segments, and elements

Defining the application side of the map

Mapping your data

Finalizing the map
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Getting Started

Outbound
Mapping
Scenario

Mapping
Analysis

This tutorial is meant to be completed in its entirety. We recommend that
you perform each task sequentially without referring to the completed map
that is provided with the installation program. You can then verify your
completed map with the model we have provided.

By completing each task in sequential order, you will learn individual
mapping techniques and a logical approach to methods you will utilize when
you create your own map.

For outbound translation, you must set up a system import map and an
import map. Generally, you create one system import map for each message
type and create one import map for each partner to whom you send
messages.

In this exercise, your company is MWT Manufacturing Co., which
manufactures a wide variety of pet supplies. Your company sells these
supplies directly to large pet supply retail chains. You must create a map that
enables your company to translate your application file to the invoices that
you will send to one of your trading partners, Pet Zone, a large pet supply
retailer. After you ship an order to Pet Zone, generate the corresponding
invoice, and translate your application file into an EDI invoice, your
company can send the invoice to Pet Zone.

You have an existing application file layout from your accounts payable
department that defines the information your system generates for the
invoice. From discussions with the Pet Zone, you know the requirements for
the EDI invoices that you will be sending them.

The first and most important step in creating a successful map is to analyze
your mapping requirements. If your mapping analysis is complete, you will
have all the information you need to create the map in an efficient, logical
manner. If you omit this critical step, it is likely that creating the map will be
a much longer and more arduous task, and the map may be invalid due to
oversights and omissions.

Mapping analysis involves the following steps:

1. Analyzing your application file format

2. Analyzing your partner(s) EDI file

3. Correlating your application file format and the EDI file
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Analyzing Your The first step of mapping analysis is to analyze your application file format,
Application File because this is the component that is probably most familiar to you. For an
Format outbound map, your application file contains the data that you must convert
to an EDI file so your system can generate the message correctly. In this
tutorial, your application file contains all the information that you need to
generate the invoice that you will send your partner.

You must define your application file to Gentran:Director. If your company
has an existing application file, as in this tutorial, obtain the record layout
from the appropriate person. If you do not have an existing application file
layout, you must create one by determining the fields necessary to process
the data correctly then logically grouping those fields under records.

The application file layout for the system import map in this tutorial is as

follows:
Field Name Description Max
Length
Header Record (HEADER) 1 per message
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1

The application file layout for the import map in this tutorial is as follows:

Field Name Description TD;:)Z L;\f]igth Lg/'nzxth
Header Record (HEADER) 1 per message
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1
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Field Name

Description

Beginning Record (INVBEGIN) 1 per message

Max
Length

BILLTOACCTBEG X Bill to Acct Number String 9
DOCTYPBEG X Document Type String 6
INVNUMBEG X Invoice Number String 10
INVDATE X Invoice Date Dt/Tm 6
(YYMMDD)
PONUM Purchase Order Number String 20
PODATE Purchase Order Date Dt/Tm 6
(YYMMDD)
VENDNAME Vendor Name String 35
VENDADD1 Vendor Address Line 1 String 35
VENDADD2 Vendor Address Line2 String 35
VENDCITY Vendor City String 35
VENDSTATE Vendor State String 2
VENDPOSTALCODE Vendor Postal Code String 9
SHIPTONAME Ship To Name String 35
SHIPTOADD1 Ship To Address Line 1 String 35
SHIPTOADD2 Ship To Address Line2 String 35
SHIPTOCITY Ship To City String 35
SHIPTOSTATE Ship To State String 2
SHIPTOPOSTALCODE Ship To Postal Code String 9
SHIPTOLOC Ship To Store Location String 9
SHIPTODEPTNUM Ship To Dept Number String 4
REMITTONAME Remit To Name String 35
REMITTOADD1 Remit To Address Line 1 String 35
REMITTOADD2 Remit To Address Line 2 String 35
REMITTOCITY Remit To City String 35

122 April 2005

Gentran:Director Application Integration EDIFACT Tutorial Guide




Outbound Invoice (INVOIC)

Getting Started

Field Name

Description

Max
Length

REMITTOSTATE Remit To State String 0 2
REMITTOPOSTALCODE Remit To Postal Code String 0 9
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
Comment Group (INVCommentGroup) 10 per message
Comment Record 1 (INVCOMMENT1) 1 per message
BILLTOACCTCM1 X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
REFNUM X Reference Number String 1 30
Comment Record 2 (INVCOMMENT2) 1 per message
BILLTOACCTCM2 X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232
Detail Record (INVDETAIL) up to 200,000 per message

BILLTOACCTDET X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) String 1 6
QTYSHIP X Quantity Shipped Number (NO) | 1 5
QTYORD X Quantity Ordered Number (NO) | 1 5
UNITPRICE X Unit Price Number (N2) | 1 7
UoM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
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. . Max
Field Name Description Length
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30

Summary Record (INVSUMMARY) 1 per message

BILLTOACCTSUM X Bill To Acct Number String 1 9

DOCTYPSUM X Document Type String 1 6

INVNUMSUM X Invoice Number String 1 10

TOTALAMOUNT X Total Monetary Value Number (N2) | 1 10
Summary

TRANSTOTAL X Transaction Totals Number (NO) | 1 6

The above table contains the minimum information necessary to define your
application file to Gentran:Director (hame, mandatory status, description,
data type, and field length). Each record contains a group of logically related
application fields. These fields contain information that your system needs to
generate the invoice.

Each record (except the HEADER record, which is used for selecting the
appropriate trading relationship) contains a three-field record key to ensure
that the same identifying information is located at the beginning of each
record. Your application file format contains a record key so that each record
can be individually identified. The record key for this invoice consists of
your partner’s bill to account number, the document type, and invoice
number. The records are defined as:

B The HEADER (header) record contains the five-field key (partner
identifier, standard, version, transaction set (message), and test/
production flag), which is used for selecting the appropriate trading
relationship. This header record is mandatory and occurs once for each
invoice translated.

B The INVBEGIN (beginning) record contains the purchase order number
and date; the vendor, ship to, and remit to address information; and the
bill of lading number and ship date. The beginning record is mandatory
and occurs once for each invoice.

B The INVCommentGroup (comment information) groups all the
comment information for the invoice, including the reference number
and message text. The INVCommentGroup occurs up to ten times per
invoice translated. The information within the INVCommentGroup is
further segregated by record.
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Analyzing the EDI
File

B The INVCOMMENT1 (first comment) record contains the reference
number. The first comment record is mandatory and occurs once per
invoice translated (once for each comment line).

B The INVCOMMENT2 (second comment) record contains message text.
The second comment record is mandatory and occurs once per invoice
translated (once for each comment line).

B The INVDETAIL (detail) record contains line item number and
description, quantity shipped, quantity ordered, unit of measure, price,
and product code. The detail record is mandatory and occurs up to
200,000 times per invoice translated (once for each line item invoiced).

B The INVSUMMARY (summary) record contains the total invoice
amount and the total transaction amount. The summary record is
mandatory and occurs once per invoice translated.

Now that you have analyzed your application file, the next step is to
determine the invoice requirements that you will send to your partner.

To analyze the EDI file, determine what you want to send your trading
partner and what your partner expects to receive. You and your partner must
agree on which standard, version, and message to use. In this tutorial, we use
an EDIFACT version 92.1 INVOIC. It is important to know what type of
information your partner expects you to send within the invoice and what
data will be contained in each element used.

Before you analyze the EDI file, it is helpful to review the EDI standard(s)
that you will use. Obtain an EDI standards manual for each standard and
version that you will use. Standards manuals are available from EDI
standards agencies.

After discussing with your partner what you will send, determining which
segments and elements your partner requires, and reviewing the EDI
standard, make a list of the map components that you must make available
for use (activate).

For this tutorial, the map components that are required but not currently
active are:

Groups Segment Comp. Element

BGM segment BGMO5 element
(already active)

DTM segment C507 DTMO2 element
(already active)
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Groups Segment Comp. Element
FTX segment Cc108 FTX06 element
FTX07 element
RFF group RFF segment C506 RFF02 element
DTM:2 segment C507 DTM:202 element
NAD group NAD segment C080 NAD10 element
C059 NAD16 element
C059 NAD17 element
NAD19 element
NAD20 element
NAD21 element
LOC segment C517 LOCO5 element
CTA group CTA segment CO056 CTAO3 element
LIN group LIN segment LINO1 element
C212 LINO3 element
C212 LINO4 element
PIA segment C212 PIAO2 element
C212 PIAO3 element
IMD:2 segment C273 IMD:206 element
QTY:2 segment C186 QTY:303 element
MOA group MOA:5 segment C516 MOA:502 element
CNT segment C270
MOA group MOA:10 segment C516 MOA:1002 element

(already active)

When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.

We recommend that you set up a Document Name for each map. This allows
you to differentiate between messages in the document browsers.

To set up a Document Name, select a map element or field that contains
distinguishing data for messages translated by this map. We strongly
recommend that you select an element or field that occurs only once in the
message and has a data type of “String.” In this tutorial, the system import
document name is the document/message number.
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You can also establish a Document Reference for each map to distinguish
messages. When you set up the Reference in the Application Integration
subsystem, the RefData field of the document browser that contains this
message contains data from that mapped field. In this tutorial, the system
import document reference is the reference (purchase order) number.

Since you are creating an import map to create outbound data, you must
define constants in the qualifier elements on the EDI (output) side of the
map. Part of your analysis is determining in which elements you must define
and use qualifiers and then determining which elements they qualify. You
must use constant values that are compliant with the EDI standard.

For this tutorial, you must define the following constants to create the
required qualifier elements:

Element Element
. Constant .
Using Constant ID value it
Constant Qualifies
DTM:2201 Invoice date/time 3 DTM:2202
RFF:1101 Order number (purchase) ON RFF:1102
(PONUM_RFF) (PONUM_RFF)
DTM:2501 Order date/time 4 DTM:2502
(PONUM_RFF) (PONUM_RFF)
NAD:301 Vendor VN NAD:310
(Vend_NAD) (Vend_NAD)
NAD:501 RemitTo RE NAD:510
(RemitTo_NAD) (RemitTo_NAD)
NAD:401 ShipTo ST NAD:410
(ShipTo_NAD) (ShipTo_NAD)
LOC:1301 Goods receipt place 4 LOC:1305
(ShipTo_NAD) (ShipTo_NAD)
RFF:1201 Bill of lading number BM RFF:1202
(BOL_RFF) (BOL_RFF)
DTM:2601 Despatch date/time 11 DTM:2602
(BOL_RFF) (BOL_RFF)
FTX01 Invoice instruction INV FTX06/FTX07
QTY:501 Despatch quantity 12 QTY:502
QTY:601 Ordered quantity 21 QTY:602
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Element Element
. Constant .
Using Constant ID value it
Constant Qualifies
MOA:1301 Unit price 146 MOA:1302
LINO4 Buyer’s part number BP LINO3
PIA:203 UPC Code UP Pl1A:202
PIA:201 Additional Identification 1 Pl1A:202
UNSO01 Summary S
CNT:201 Number of line items in 2 CNT:202
message
CNT:301 Total quantity 1 CNT:302
MOA:1401 Total amount 128 MOA:1402

Correlating Your
Application File
and the EDI File

April 2005

After you complete the analysis of the EDI file and your application file
format, the final step in mapping analysis is to correlate the two components.

To translate outbound data, you must build an import map and a system
import map. The Application Integration subsystem uses the system import
map to determine which import map to use. The system import map builds
the key that the translator uses to find the partner relationship. The system
import map’s sole function is to identify the appropriate partner relationship;
it does not map data.

To build the key in system import map header record, you can use one of
two methods: the five-field key (six-field for TRADACOMS standard) or
the three-field key.

The method that we recommend, and demonstrate in this tutorial, requires
six EDI-specific fields in the header record: partner key, standard, version,
message, release (for TRADACOMS only), and test/production status. The
combination of these six fields defines a unique key that identifies the
appropriate partner relationship. We recommend that you use this method
because it is flexible. You typically use this method when you are defining
your application from scratch and can easily add the EDI-specific fields that
are not already present in the header record.

The three-field key method is easier to build because the header record only
requires the partner key, application 1D, and application alias value. Please
note that an empty string is a valid value in the application ID and
application alias value fields. The combination of these three fields defines a
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unique key that identifies the appropriate partner relationship. Because only
three fields combine to build the key, this method is not as flexible as the
five-field key method. You typically use the three-field key method when
you use a legacy (existing) application definition and when you do not want
to add EDI-specific information.

To reconcile your application file with the EDI file, you must identify each
application field with its corresponding element in the EDI file and select a
method for mapping it. To map information to an element, you can use
linking, standard rules, extended rules, or a combination of all three.

Linking (simple mapping) enables you to map a field or element from the
input side of the map to a field or element on the output side of the map. The
link between two map components (fields) is visually represented with a line
connecting the two fields. Standard rules give you access to functions that
are necessary for mapping operations that are more complex than simple
linking, but less involved than extended rules. Extended rules enable you to
use a Gentran:Director proprietary programming language to perform
virtually any mapping operation you require.

You must promote several groups and segments that repeat multiple times to
extract one iteration (instance) of the group or repeating segment. This is
necessary to map multiple application fields to the same segment or group.

We recommend that you determine which mapping operations are required
on a field-by-field basis for your application file.

The following mapping operations (by application field) are required for the
system import map in this tutorial:

Mapping
Operations

Field Name Description

Header Record (HEADER) 1 per message

PARTNER_ID Partner Identifier Select standard rule to match
the EDI Code in the Partner
record (Partner by EDI Code)

STANDARD Standard Update standard rule to update
the Agency field on the
Document record

VERSION Version Update standard rule to update
the Version field on the
Document record

TRANSACTION_SET Transaction Set Update standard rule to update
the Transaction Set ID field on
the Document record

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 129



Getting Started

Outbound Invoice (INVOIC)

Field Name

Description

Mapping
Operations

TEST_PROD

Test/Production Flag

Update standard rule to update

the Test Mode field on the
Document record

Field Name

Description

The following mapping operations (by application field) are required for the
import map in this tutorial:

Mapping

Operations

Header Record (HEADER) 1 per message

PARTNER_ID Partner Identifier No mapping required
STANDARD Standard No mapping required
VERSION Version No mapping required
TRANSACTION_SET Transaction Set No mapping required
TEST_PROD Test/Production Flag No mapping required

Beginning Record (INVBEGIN) 1 p

er message

BILLTOACCTBEG

Bill to Acct Number

No mapping required

DOCTYPBEG Document Type No mapping required

INVNUMBEG Invoice Number Link to BGMO5 and UNSO1

INVDATE Invoice Date Link to DTM:2202 using “3” (invoice date/
time) code

PONUM Purchase Order Number Link to RFF:1102 using “ON” (order
number) code

PODATE Purchase Order Date Link to DTM:2502 using “4” (order date/
time) code

VENDNAME Vendor Name Link to (Vend_NAD) NAD:310

VENDADD1 Vendor Address Line 1 Link to (Vend_NAD) NAD:316

VENDADD2 Vendor Address Line2 Link to (Vend_NAD) NAD:317

VENDCITY Vendor City Link to (Vend_NAD) NAD:319

VENDSTATE Vendor State, Province, or Country | Link to (Vend_NAD) NAD:320

VENDPOSTALCODE Vendor Postal Code Link to (Vend_NAD) NAD:321

SHIPTONAME Ship To Name Link to (ShipTo_NAD) NAD:410

SHIPTOADD1 Ship To Address Line 1 Link to (ShipTo_NAD) NAD:416

SHIPTOADD2 Ship To Address Line2 Link to (ShipTo_NAD) NAD:417
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Field Name

Description

Mapping

Operations

SHIPTOCITY

Ship To City

Link to (ShipTo_NAD) NAD:419

SHIPTOSTATE

Ship To State, Province, or Country

Link to (ShipTo_NAD) NAD:420

SHIPTOPOSTALCODE

Ship To Postal Code

Link to (ShipTo_NAD) NAD:421

SHIPTOLOC

Ship To Store Location

Link to (ShipTo_NAD) LOC:1305 using
“4” (goods receipt place) code

SHIPTODEPTNUM

Ship To Dept Number

Link to (ShipTo_NAD) CTA:603

REMITTONAME

Remit To Name

Link to (RemitTo_NAD) NAD:510

REMITTOADD1

Remit To Address Line 1

Link to (RemitTo_NAD) NAD:516

REMITTOADD2

Remit To Address Line2

Link to (RemitTo_NAD) NAD:517

REMITTOCITY

Remit To City

Link to (RemitTo_NAD) NAD:519

REMITTOSTATE

Remit To State, Province, or
Country

Link to (RemitTo_NAD) NAD:520

REMITTOPOSTALCODE

Remit To Postal Code

Link to (RemitTo_NAD) NAD:521

BOLNUM

Bill of Lading Number

Link to RFF:1202 using “BM” (bill of
lading number) code

SHIPDATE Ship Date Link to DTM:2602 using “11” (despatch
date/time) code
Comment Group (INVCommentGroup) 10 per message

omment Record 1 (INVCOMMENT1)

1 per message

BILLTOACCTCM1

Bill To Acct Number

No mapping required

DOCTYPCM1 Document Type No mapping required
INVNUMCM1 Invoice Number No mapping required
REFNUM Reference Number Link to FTX06 using “INV” (invoice

instruction) code

omment Record 2 (INVCOMMENT?2)

1 per message

BILLTOACCTCM2

Bill To Acct Number

No mapping required

DOCTYPCM2 Document Type No mapping required
INVNUMCM2 Invoice Number No mapping required
MESSAGETEST Message Text Link to FTX07

Detail Record (INVDETAIL) up to 200,000 per message
BILLTOACCT Bill To Acct Number No mapping required
DOCTYPDET Document Type No mapping required
INVNUMDET Invoice Number No mapping required
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. - Y/ in
Field Name Description apping
Operations

ITEMNUM Item Number (Our Item) Link to LINO1

QTYSHIP Quantity Shipped Link to QTY:502 using “12” (despatch
quantity) code

QTYORD Quantity Ordered Link to QTY:602 using “21” (ordered
quantity) code

UNITPRICE Unit Price Link to MOA:1302 using “146" (unit price)
code

UOM Unit of Measure Link to QTY:503 and QTY:603

CUSTPROCODE Customer Product Code Link to LINO3 using “BP” (buyer’s part
number) code

UPCCODE UPC Code Link to PIA:202 using “UP” (UPC code)
and “1” (additional information) codes

ITEMDESC Item Description Link to IMD:306

Summary Record (INVSUMMARY) 1 per message

BILLTOACCTSUM Bill To Acct Number No mapping required

DOCTYPSUM Document Type No mapping required

INVNUMSUM Invoice Number No mapping required

TOTALAMOUNT Total Monetary Value Summary Link to MOA:1402 using “128" (total
amount) code

TRANSTOTAL Transaction Totals Link to CNT:202 using “2” (number of line
items in message) code

After you correlate your application file and EDI file on paper, you can
begin to create the system import and import maps.
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Creating the System Import Map

For outbound translation, you must set up a system import map and an

import map. Generally, as explained on page 188, you create one system
import map for each partner to whom you send messages and one import
map for each message type.

The system uses a system import map to find the partner relationship for a
message (flat file definition) and to determine which import map is used to
translate the data. The system import map builds the key that the translator
uses to find the partner relationship.

Complete the following steps to create the system import map:
1.

Select New from the File menu to create a new map. The Create New
Translation Object dialog is displayed.

Function ||mp.3,t
[Vata Sauree I j el |
— Input Format

Tupe Iﬁ = Use Standard:

Sgency I j

ersit I j

Iratisattion I j
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r— Output Format

Type Iﬁ 1= [Use Gtandand

Laeney I j

Ersio I j

Trarsaction I j

HelEase Iﬁ

From the Translation Object Function list, select “System Import.”

From the Input Format Type list, select “Positional.”

From the Output Format Type list, select “Positional.” The system

ignores the Output side of the map and only processes the Input side.

Click OK to create the new system import map (this may take a few

seconds).
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6. After you create the new map, it is important to define its details and
save it. The Save function writes (saves) the map with current focus to
disk.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of information.

Select Save from the File menu to display the Translation Object Details
dialog.
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sy || [
Yersmn I I I I
Tram=achion I I I I
Al I_ I_
raoe [ | -

7. Inthe Author box, type your name. This box typically contains the name
of the person who created the map.

8. In the Description box, type “System Import HDR”. For system import
maps, we recommend that you type “System Import *”, where “*” is the
identifier for this system import map. The Imports tab of the System
Configuration program describes which system import translation
object is used to begin translation during the import process. Please see
the Gentran:Director Administration Guide for more information on
modifications your system administrator must make to the system
configuration program.

9. Verify that the Translation Object Function list contains “System
Import.”

10. Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version humber in the Major box
and accept the “0” as the release number in the Minor box.
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increase the version to the next real number (e.g., 2.0).
If you make a minor change to the map, increase the
version by a percentage point (e.g., 2.1).

Q Whenever any major changes are made to your map,

11. The Input and Output boxes (Agency, Version, Transaction, Release,

and F Group) contains information only if the Input and/or Output sides
of the map are of EDI format. For the tutorial, DO NOT change the box
information.

The system allows you to change the information in the
Input and Output boxes but modifying this
information will not alter the content of the map. An
example of when you may wish to alter these boxes is if
you want the map to reflect a standard version that is
not loaded on your system. You can change the version
on this dialog, and then physically alter the map to be
compliant with that version.

The Translation Object Details dialog should now look like this:
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12. Click OK to save the translation object details and access the Save As

dialog.

Save jn |El Maps j gl IE?
Pet_eord.map

File name:  [GENTRANT.map

Save az bype: IMaps [*.map] j Cancel |

13. The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN Director\Maps.
If the current subfolder is not the correct one, select the appropriate
subfolder.

14. In the File Name box, type “HEADER.MAP” as the map name. You
allocate a file name to a map when you save the map for the first time or
use the Save As function to save a copy of the map under a different
name. The default file extension is “.MAP”. The naming conventions in
Gentran:Director are:

B The source map (map created in Gentran:Director) should be
named using the file extension .MAP (e.g., HEADER.MAP).

B The compiled translation object (translation object that is the result
of compiling the source map) should be named using the same file
name that was allocated to the source map BUT with the file
extension .TPL (e.g., HEADER.TPL).

Do not overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.

15. Click SAVE to save the map.

After you create the system import map, you must define the header
record for the system import map. Use the six-field key in this tutorial.
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Creating the

HEADER The only record that you define for the system import map is the header
record. The header record is subordinate to the icon on the input side of the
Record 0

The HEADER (header) record contains the five fields that comprise the
system import map key. The HEADER record is mandatory and occurs only
once.

Complete the following steps to create the HEADER record:
1. Highlight the Positional File icon on the input side of the map.
2. Select Create Sub from the Edit menu. Select Record from the submenu.

The Positional Record Properties dialog is displayed.
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3. In the Name box, type “HEADER?” as the record identification code.
Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

4. In the Desc box, type “Header Record”. This provides a brief
explanation that allows you to differentiate it from similar records.
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5. Inthe Tag box, type “HDR” as the record identification code <TAG>. A
record is recognized by the system by the following syntax:

<TAG>[Field_1][Field 2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

You must define the record tag on the Positional
Record Properties dialog for outbound maps instead of
defining fields with the purpose of explicitly containing
the record tag.

6. Inthe Position box, accept the default of “1” for the starting column
position of the tag in the data record.

7. Inthe Min Usage box, type “1” to make the header record mandatory.
This is the minimum amount of times the record must repeat.

If the Min Usage box contains a “0” (zero), the record
is “conditional.” If the Min Usage box contains a “1” or
greater, the record is “mandatory.”

The Positional Record Properties dialog should now look like this:
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8. Click OK to create the HEADER record.
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Creating the

HEADER To use the preferred method of building the system import key, you must
Fields define at least five fields for the header record (partner key, standard,
version, transaction, and test/production status). These fields do not have to
be in any order or sequence but they must be part of the header record.

After you define the header record and fields, you must set up the mapping
operations to define the key that the translator uses to find the partner
relationship.

The easiest way to add a record field is to use the Positional Field Editor.
The fields that you must create are listed in the following table. The name,
mandatory status, description, data type, and length of each field are given in

the table.

Field Name

Header Record (HEADER) 1 per message

Description

Max
Length

PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET | X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1
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140

Complete the following steps to create the fields for the HEADER record:

1.

April 2005

Right-click the HEADER record and select Edit Fields... from the
shortcut menu to access the Positional Field Editor dialog.
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The field you are creating is the first field in the record. Click NEW. A
highlight bar is displayed in the Fields section where the new field is
positioned. You must fill in the field values in the Field Details section.

In the Name box, type “PARTNER_ID”, which is the name of the first
field in the HEADER record.

Click the Mandatory check box to identify it as a required field. For the
system import map, each field in the key is mandatory.

In the Description box, type “Partner Identifier”.

From the Data Type list, select “String.”

In the Start Pos box, type “4”.

In the Min Length box, type “1” as the minimum field length.
In the Max Length box, type “9” as the maximum field length.

. To add the field and to create the next field positioned after it, press

ENTER. A new field with blank values ready for you to identify is
positioned below the field.
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11. Create the rest of the fields according to the record layout table on

12.
13.

page 1309.
Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This calculates the start position in the
record of each field based on the criteria that each field is positioned
directly after the previous field and is of the length specified in the Max
Length box. Click YES to acknowledge the warning message that fields

will be sequenced in order.

Please note that it is only valid to use the Auto Position
function if you define a record tag on the Positional

Record Properties dialog, and if you define every field
in the record in the sequence that each field occurs, as

you are doing in this tutorial.

The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the HEADER

Gentran:Director Application Integration EDIFACT Tutorial Guide
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Defining the

Key After you define the header record and fields, you can set up the mapping
operations that define the key that the translator uses to find the partner
relationship.

Defining the Complete the following steps to define the partner key:

Partner Key : . . .
1. Double-click the HEADER record to display the fields you just created.
2. Double-click the PARTNER_ID field to display the Field Properties

dialog.
1zid | 'vepoibics
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3. If the Advanced section of the dialog is not currently displayed, click
ADVANCED >> to define rules.

4. Click the Use Standard Rule check box to display the rule options.
5. Verify that the Select option is selected.

6. From the Table list, select “Partner by EDI Code” (you could also select
“Partner by Alternate code,” or “Partner by Partner Key”) to look up the
indicated partner key in the partner database and update this field.
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The Advanced section of the Field Properties dialog should now look
like this:
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7. Click OK to add the standard rule to the partner key field.

Defining the Complete the following steps to define the EDI standard field:
Standard Field 1. Double-click the standard field to display the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update option.

4. From the Table/Key list, select “Document record” to indicate that you
wish to store an item of data in the Gentran:Director tracking database
for the document.

5. From the Field list, select “Agency” to indicate that you are updating the
agency (standard) field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
like this:

Advancad
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6. Click OK to add the standard rule to the standard field.

Defining the Complete the following steps to define the version:
Version Field 1. Double-click the Version field to display the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.
4. From the Table/Key list, select “Document record.”

5. From the Field list, select “Version” to indicate that you are updating
the standard version field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
like this:

Bdvancad
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6. Click OK to add the standard rule to the version field.

Defining the Complete the following steps to define the transaction set (message):
Transaction Field 1. Double-click the transaction set field to display the Field Properties
dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.
4. From the Table/Key list, select “Document record.”

From the Field list, select “Transaction Set ID” to indicate that you are
updating the transaction set field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to add the standard rule to the transaction set field.

Defining the Test/  Complete the following steps to define the test or production status field:

Production Field 1. Double-click the test/production field to display the Field Properties

dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Update option.
4. From the Table/Key list, select “Document record.”

From the Field list, select “Test Mode” to indicate that you are updating
the release field in the system buffer.
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The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to add the standard rule to the test or production status field.

Compiling the
Map The Compile function generates a translation object. The map that you
created (HEADER.MAP) is a source map. When that source map is
compiled, the result is a compiled translation object.

After you save the translation object, you must register it with
Gentran:Director before you can use it.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map.
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2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Hame EHE

Save in: |E TranzObj j gl E ]

File name:  |HEADER.TPL

Save a3 bype: | Translation Objects [ TFL) =l Eariad |

3. The File Name box automatically contains “header.tpl.” This is the
name of the translation object, using the default .TPL file extension and
our recommendation that you name the translation object (. TPL file) the
same file name as you named the map (.MAP file). Preserving the same
file name (with different file extensions) means that the relationship
between the source map and the compiled translation object will remain
evident.

Do not overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.

4. Change the drive and folder where the compiled translation object is
stored, if necessary.

5. Click SAVE. The system compiles the map and generates a translation
object. The Compile Error dialog is displayed. Verify that no errors
occurred, and click OK to exit the dialog.

6. Select Details from the Edit menu.
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The Translation Object Details dialog is displayed.
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The date on which the translation object was compiled is
automatically loaded into the Compiled on box on the Translation
Object Details dialog. Click CANCEL to exit the dialog.
7.

Gentran:Director Application Integration EDIFACT Tutorial Guide

Select Save from the File menu to save the source map.
You must register this translation object with the
Gentran:Director system before you can use it. See the

Gentran:Director User’s Guide for information on
registering a translation object.
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Printing the
Report

Testing the
Translation
Object

The Gentran:Director report enables you to validate and review the map, and
make modifications as needed. If you review the report and determine that
the map is incorrect, make the modifications, save the map, recompile the
translation object, and print the report again.

Complete the following steps to print the Gentran:Director report:
1.  Select Print from the File menu to access the Print Options dialog.

Print Options |

— Report zections

¥ Print branching diagram
v Prirtk record details ﬂl
W Print mapping details
¥ Print extended rules

W Prirk code lists

W Include only active objects

2. Accept the defaults on this dialog (all options checked) so the report will
include all sections and only the activated map components. Click OK
and the Print dialog is displayed.

3. Select the appropriate options. Click OK.

Click SETUP... to select a specific printer, paper orientation, or size and
source of paper. The Print Setup dialog is displayed.

After you compile the map, print and verify the report, and register the
translation object with Gentran:Director, test the translation object to verify
that the data was translated correctly. Test the system import translation
object (HEADER.TPL) when you test the import map (please see page 246).
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Creating the Import Map

The first task in creating a new map is to define the format that will be used
for the input and output sides of the map. In this example, you are creating
an import map so Gentran:Director can translate your application file to an
invoice that you are sending to your partner. The input side of the map must
reflect your application file. The output side of the map must reflect the
EDIFACT 92.1 invoice (INVOIC) that you will send to your partner. Instead
of defining the INVOIC message to the system yourself, you want
Gentran:Director to use the standards database on your system to build the
invoice according to the standard.

Complete the following steps to create the import map for the outbound

invoice:
1. Select New from the File menu to display the Create New Translation
Object dialog.
Create Hew Translation Object E3
Function ||m|:,.:,,t
[afa Source I
— Input Format
Type I vl [0} sz Standard:
BAEnE I j
TSI I j
Tarisastion I j

Eelease I x |

— Output Format

Type I vl 2| Uze Standard:

AgEREN I j
S Ersiar I j
TiratEactinn I j

Eelease I * |

2. Accept the default of “Import” in the Translation Object Function list.

Complete the Input Format section of the dialog. This is the data format
that Gentran:Director translates.
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From the (Input Format) Type list, select “Positional” as the output data
format type. The term “positional” describes flat files that you create.
Now you must complete the Output Format section of the dialog.

From the (Output Format) Type list, select “EDI” as the format type for
the output data.

Click the Use Standards check box because you selected “EDI” in the
Type box and because you want the system to use the standards
database on your system to build the invoice according to the standard.

To select a data source name from which Application Integration will
access EDI standards, select one from the Data Source list. This DSN
will be prompted the next time you create a map.

Select “[E] Edifact” as the EDI standard you will be using for the input
side of the map from the Agency list.

Select “[092001] EDIFACT 1992 RELEASE 1” (92.1) as the standard
version from the Version list. Available versions depend on which
standard you selected.

Select “[INVOIC] INVOICE MESSAGE” as the transaction set
(message) from the Transaction list. Available transactions depend on
which standard and version you selected.

The Create New Translation Object dialog should now look like this:

Function Ilmport
Data Source IGENTHAN Stardards j Cancel |
r Input Format

Type IPositionaI VI ™ [Use Standardt

Sgency I j

Y Ersion I j

Irarsachion I j

Fielease Iﬂ
r— Output Farmat

Type IEDI vI v Use Standard:

Agency  |[E]Edifact i

Wersion I[DSEDDH ECIFACT 1332 RELEASE 1 j

Transaction | [INVOIC] INVOICE MESSAGE =l

Release Iﬂ
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10. Click OK to generate the new map (this may take a few seconds).

The new map is displayed in the following window.

& GEMTRAN:Director - Application Integration - [INVOIC]

&7 Fle Edt Functions Wiew Options ‘window Help =1=1x]
) = e N e = o e e s
) INPUT -M- = INWOIC -M- INVOICE MESS."—\GE@

BGHM -M- 1 BEGINNING OF MESSAGE
DT -M- 35 DATE/TIME/PERIOD

&
-
&
-
G-
&
-
&
-
G-
&
LINS -M-1 SECTION EDNTHDLz:

4500_M04 -M- 100 (51

G-
. @_ .

<] | AN|E [ I_I

For Help, press F1 I_ o

11. After you create a new map, it is important to define and save its details.
The Save function writes (saves) the map with current focus to disk.

We recommend that you save your maps often to

mitigate the possible loss of additions or modifications
in the event of a hardware or system error.
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Select Save from the File menu to display the Translation Object Details
dialog.

Tramzlation Object Details

rSumman
Auithar

Daccriptian Tranzlatian O bjecl Function Syetam

I Ilrnpal H = Caraal

~aizion Canirol

Mapr rerzen (10 Mo vemon IEI Compled on I

Agency

Yarsion

Ralaaas

F Group

-ED Azzocialicna

Trermachon I | IIH'H‘EIIE IIN‘r‘EIIEE MESZAGE

Ihpuk Oukpk

[ ] [ [Edilaci

| | |u52u:r| IEDIFAL‘I’ 1992 REL

i

12.

13.

14.

15.
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In the Author box, type your name. This box typically contains the name
of the person who created the map.

In the Description box, type “PET E 92.1 INVOIC Import”. This
description must be unique because the system uses it to identify the
map. We recommend that you use the following identifying
characteristics: the partner that this map is used for, the standard, the
version, the transaction type this map uses, and the direction of the map
(e.g., Import). For example, “PET E 92.1 INVOIC Import” is the map
description used with partner Pet Zone, for an EDIFACT version 92.1
Invoice (INVOIC) that is sent outbound (Import).

Verify that the type of map shown in the Translation Object Function
list is “Import.”

Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version humber in the Major box
and accept the “0” as the release number in the Minor box.

Whenever any major changes are made to your map,
increase the version to the next real number (e.g., 2.0).
For minor map changes, increase the version by a
percentage point (e.g., 2.1).
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16. The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides
of the map are in EDI format. For the tutorial, DO NOT change the
information in these boxes.

Input and Output boxes, but modifying this
information will not alter the content of the map. An
example of when you may wish to alter these boxes is if
you want the map to reflect a standard version that is
not loaded on your system. You can change the version
on this dialog, and then physically alter the map to be
compliant with that version.

Q The system allows you to change the information in the

The Translation Object Details dialog should now look like this:

Trarvelativern Mlwject Tt ails

rSummoy
A kher Diezcriplioh Tranzilation Object Function Syzkem
Steri FET E 321 INWVOIC Imporl || Impart 2
o I P | e u Cancel I
Mermon Control

Major waigion |1 Mincr waigion IIJ Campilad an I

EDN Associatiore

Irpt Oulpul
Aoency [ €] [Earact
Yersin | | {2001 [EDIFACT 1552 AEL
Tramction | [ [0IC [IMVOICE MESSAGE
Helesss I_ ID_
F Group | | IIWEIII: |

17. Click OK to save the translation object details and access the Save As
dialog.

18. The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN Director\Maps.

If the current subfolder is not the correct one, select the appropriate
subfolder.

19. Type “PET_EINV.MAP” as the name of the map in the File name list.
The file name should be unique. In our example, the name indicates an
EDIFACT invoice (INVOIC) for partner Pet Zone.
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Activating EDI

The Save As dialog should now look like this:

Save As

o &f ol

I 4 Maps
Pet_eard. map

Save in:

File name: IPET_EINV.MAF‘

Save as lppe: |Ma|:us [*.rnap)

j " Cancel |

20. Click SAVE to save the map.

Now that you have finished creating and saving the new Import map, you
must define the Input and Output sides of the map.

I\/Iap The map components for an EDI File are the following:
Components & EDI File
O Segment
] Loop (Group)
A Composite Element
. Element
The map components for a Positional File are the following:
=l Positional File
L ] Record
a Loop (Group)
’ Field
The specific EDI map components that you use depend on the type of map
you are creating, the standard, version, and transaction set (message)
selected, and which segments and elements your company requires. We
recommend that you determine which segments and elements you will use
before starting this step.
When Gentran:Director generates the EDI side(s) of the map, the system
includes all the groups, segments, composites, and elements that are defined
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by the standards agency for the message version you selected. The system
activates all the groups, segments, composites, and elements that are defined
as “mandatory” (must be present) by the standard. The system does not
enable you to deactivate the mandatory groups, segments, composites, and
elements. By default, Gentran:Director displays active map components
with a black font and inactive map components with a gray font (dimmed).
In the example below, the DTM segment and the DTMO1 element are
mandatory, so they have already been activated by the system. You must
also activate the DTMO02 element (a conditional element).

DT 4- 35 DATE/TIME /PERIOD
Se CHO7 M-

EET ]

E @ 01 2005 -M- String 3 DATE/TIME/PERIOD QUALIFIER
-

=

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elements that are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Complete the following steps to activate the required conditional groups,
segments, and elements:

1. Double-click the segments and groups that are listed in the table below
to open them. These are the groups, subgroups, segments, and elements
that you must activate. Opening all necessary groups, segments, and
composites before you start to activate allows you to scroll down the
map and activate the segments and elements sequentially.

Groups Segment Comp. Element
BGM segment BGMO5 element
(already active)
DTM segment C507 DTMO02 element
(already active)
FTX segment C108 FTX06 element
FTX07 element
RFF group RFF segment C506 RFF02 element
DTM:2 segment C507 DTM:202 element
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Groups Segment Comp. Element
NAD group NAD segment C080 NAD10 element
C059 NAD16 element
C059 NAD17 element
NAD19 element
NAD20 element
NAD21 element
LOC segment C517 LOCO05 element
CTA group CTA segment C056 CTAO03 element
LIN group LIN segment LINO1 element
C212 LINO3 element
C212 LINO4 element
PIA segment C212 PIAO2 element
C212 PIAO3 element
IMD:2 segment C273 IMD:206 element
QTY:2 segment C186 QTY:303 element
MOA group MOA:5 segment C516 MOA:502 element
CNT segment C270
MOA group MOA:10 segment C516 MOA:1002 element
(already active)

w

April 2005

N

When you activate a group or segment, the mandatory
subordinate segments and elements are automatically
activated.

Click the Activate button on the Main Toolbar.

Click each inactive group that you need to use. This will activate the
groups.

If you click a group, segment, or element that you did
not mean to activate, click it with the right mouse
button to access the shortcut menu. Select Deactivate
from the shortcut menu.

Click each inactive segment that you need to use. This will activate the
segments.

Click each inactive element that you need to use. This will activate the
elements.

After you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn
activation mode off.
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Defining Literal

Constants The system uses literal constants to store information that is used later in the
map. For an outbound map, constants are typically used to define qualifying
relationships. A qualifying relationship establishes a relationship between an
element and its qualifier. A qualifier contains a code that further defines the
element or the element(s) with which it is associated. Qualifying
relationships are typically defined in outbound maps. You define a
qualifying relationship using a standard rule. This process is explained later
in this tutorial.

Since you are creating an import map to translate outbound data, you must
use constants to define the qualifying relationships on the EDI (output) side
of the map. First, determine which constants you want to use in a map, then
define each to save time. For this tutorial, you must define the following

constants:

Constant ID Constant Type Constant

Value

Invoice date/time String 3
Order number (purchase) String ON
Order date/time String 4
Vendor String VN
RemitTo String RE
ShipTo String ST
Goods receipt place String 4
Bill of lading number String BM
Despatch date/time String 11
Invoice instruction String INV
Despatch quantity String 12
Ordered quantity String 21
Unit price String 146
Buyer’s part number String BP
UPC Code String UP
Additional Identification String 1
Summary String S
Number of line items in message String
Total quantity String 1
Total amount String 128
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To create the literal constants that you will use in the import map, complete
the following steps:

1. Select Constants from the Edit menu to display the Translation Object
Constants dialog.

Tran:latinn NFjrct ~anstants

|1] Topm  Yakm

=
[kl

Hrli

2. Click NEW... to access the Edit Constant dialog.

il T amctart

3. Inthe ID box, type “Invoice Date/Time”, which is the first literal
constant identifier in the table. This is typically a description of the field
or element in which the constant will be used.

4. From the Type list, select “String” as the category of this literal
constant.

5. Inthe Value box, type “3” as the actual constant expression. This is the
value of the literal constant.

6. Click OK to add the constant to the system.

7. Repeat steps 2 — 6 to create the rest of the constants, according to the
table starting on page 159.

8. Click CLOSE to exit the Translation Object Constants dialog.
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Mapping the The UNS segment contains the section control information. Both the UNS
UNSO1 element segment and the UNSO1 element are mandatory. Since you are creating an
outbound (import) map, you must map data to the UNSO1 element. Because
this data is not part of your application file, you must use a constant to map
the appropriate data to this element. You have already defined all the
constants that you will use for this map.

Complete the following steps to map the mandatory data to the UNSO1
element:

1. Double-click the UNSO1 element (Section Identification) in the UNS
segment, to access the Field Properties dialog.

Nams fo=1

De=criplion ISEETIDNIDENTIFIEATIDN

ala'Vaidtion
hin Max  Tpp= Formnat

Coedilioes. .

¥ Mandalon |1 |1 IStr'rg |£||><

2. Inthe Standard Rules section, click the Use Standard Rule check box.
3. Click the Constant option.
4. Click the second Constant option.

v ancad

¥ Uz Sterdand Auk:
(1 Select 1 Updats O Conelanl ) U fzcur ) Loop Count ) Usa Code

1 Syster W aizble (W Cohztant
Comtontz | 2] Ed..
Qualfies | 1£]

5. From the Constants list, select the “S” constant (summary), to identify
the UNSO1 element as the summary section control.

6. Click OK. The “S” code is loaded in the Section Identification element.
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Promoting
Groups and
Repeating
Segments

Promoting the
DTM segment

Promoting the RFF
group and adding
specialized
definitions

The Promote function extracts one iteration (instance) of a group or
repeating segment. This enables you to map unique data from your
application file and enter a specialized definition. Only one-to-one (no
loops) or many-to-many (loops) mapping relationships are valid.

Promote is a specialized function that guarantees the integrity of your EDI
structure. You must promote several groups and repeating segments. You
must also enter a specialized definition for each group you promote so that
you can easily differentiate between the multiple instances of a group. You
decide that the naming convention that Gentran:Director uses for multiple
instances of the same segment is sufficient and you do not need to enter
specialized definitions for the segments you promote.

If a segment/record or element/field occurs more than
once in a map it is identified by its name <ID>.
Subsequent occurrences are identified by <ID>:n,
where “n” is the number of the occurrence in the map.

The DTM segment contains the date and time information for the map
header and repeats up to 35 times. You must extract one iteration of the
DTM segment so you can map the INVDATE field, which is in the
INVBEGIN record that repeats once, to the DTM segment.

Complete the following steps to promote one iteration of the DTM segment:

1. Click the DTM segment with the right mouse button and select Promote
from the shortcut menu to extract one iteration of the DTM segment.
The new iteration is named DTM:22 and is located directly above the
DTM segment.

2. Click the original DTM segment with the right mouse button and select
Deactivate from the shortcut menu to deactivate the DTM segment
(which now repeats 34 times) so the system will not process it.

The RFF group contains reference information and repeats up to 10 times.
You must extract two, singly occurring instances of the RFF group so you
can map the purchase order number and date and the bill of lading number
and ship date from the INVBEGIN record (which repeats once). You must
add a specialized definition to each group you promote so you can easily
differentiate between the two instances of the RFF group.
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Complete the following steps to promote two iterations of the RFF group
and add specialized definitions:

1.

Click the 0100_RFF group with the right mouse button and select
Promote from the shortcut menu to extract one iteration of the RFF
group. The new iteration is named 0100_RFF:2 and is located directly
above the 0100_RFF group.

Click the 0100_RFF group (which now repeats nine times) with the
right mouse button and select Promote from the shortcut menu to extract
one iteration of the RFF group. The new iteration is named 0100_RFF:3
and is located directly above the 0100_RFF group.

Click the original 0100_RFF group with the right mouse button and
select Deactivate from the shortcut menu to deactivate the 0100_RFF
group, which now repeats eight times.

Click the 0100_RFF:2 group with the right mouse button and select
Properties from the shortcut menu to access the Group Properties
dialog.

Name | (M00_AFF:2
Drescription |

Minimum Uzage |0 ¥ Promote mzonds to paenl

Canc=l

Fiamats

Madrmum Uzages |1

5.

In the Name box, type “PONUM_RFF”, which is a specialized
definition that identifies this group as containing purchase order number
information.

Click OK to save the change and exit the Group Properties dialog.

Click the 0100_RFF:3 group with the right mouse button and select
Properties from the shortcut menu.
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Promoting the
DTM:23 segment

Promoting the
DTM:24 segment

The Group Properties dialog is displayed.

Marne | C00_AFF:3
Canc=l
D' e=criplion |

Mikimum Uzage |0 ¥ Promote recomds to paienl

Famats

zdmum Usage |1

8. Inthe Name box, type “BOL_RFF”, which is a specialized definition
that identifies this group as containing bill of lading information.

9. Click OK to save the change and exit the Group Properties dialog.

The DTM:23 segment (in the PONUM_RFF group) contains the date and
time information for the purchase order number reference and repeats up to
five times. You must extract one iteration of the DTM:23 segment so you
can map the PODATE field (which is in the INVBEGIN record that repeats
once) to the DTM:23 segment.

Complete the following steps to promote one iteration of the DTM:23
segment:

1. Click the DTM:23 segment in the PONUM_RFF group and select
Promote from the shortcut menu to extract one iteration of the DTM:23
segment. The new iteration is named DTM:25 and is located directly
above the DTM:23 segment.

2. Click the original DTM:23 segment with the right mouse button and
select Deactivate from the shortcut menu to deactivate the DTM:23
segment, which now repeats four times.

The DTM:24 segment in the BOL_RFF group contains the date and time
information for the bill of lading reference and repeats up to five times. You
must extract one iteration of the DTM:24 segment so you can map the
SHIPDATE field (which is in the INVBEGIN record that repeats once) to
the DTM:24 segment.

Complete the following steps to promote one iteration of the DTM:24
segment:

1. Click the DTM:24 segment (in the BOL_RFF group) and select
Promote from the shortcut menu to extract one iteration of the DTM:24
segment. The new iteration is named DTM:26 and is located directly
above the DTM:24 segment.
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2. Click the original DTM:24 segment and select Deactivate from the
shortcut menu to deactivate the DTM:24 segment, which now repeats
four times.

Promoting the The NAD group contains name and address information and repeats up to 20
NAD group and times. You cannot map from a non-repeating record (INVBEGIN) to a
adding specialized repeating group (NAD). To map vendor, shipping, and remittance
definitions information from your application file format, you must extract three single
iterations of the NAD group so the links between the application fields in the
INVBEGIN record and the NAD groups are valid. You must also add a
specialized definition to each group you promote so you can easily
differentiate between the three instances of the NAD group.

Complete the following steps to promote three iterations of the NAD group
and add specialized definitions:

1. Click the 0200_NAD group with the right mouse button and select
Promote from the shortcut menu to extract one iteration of the NAD
group. The new iteration is named 0200_NAD:2 and is located directly
above the 0200_NAD group.

2. Click the 0200_NAD group, which now repeats 19 times, and select
Promote from the shortcut menu to extract one iteration of the NAD
group. The new iteration is named 0200_NAD:3 and is located directly
above the 0200_NAD group.

3. Click the 0200_NAD group, which now repeats 18 times, and select
Promote from the shortcut menu to extract one iteration of the NAD
group. The new iteration is named 0200_NAD:4 and is located directly
above the 0200_NAD group.

4. Click the 0200_NAD:2 group with the right mouse button and select
Properties from the shortcut menu to access the Group Properties
dialog.

Lroup |'repcrlics

Marne [T
Canc=l

D esscriplion |

Mikimum Uzage |0 ¥ Promote mcoms to paenl
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M zedmum Lleage |1

5. Inthe Name box, type “Vend_NAD”, which is a specialized definition
that identifies this group as containing vendor information.
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Click OK to save the change and exit the Group Properties dialog.

Click the 0200_NAD:3 group with the right mouse button and select
Properties from the shortcut menu to access the Group Properties
dialog.

Group Propertias Ed

Marne | [G200_Ma[x:3
D eszcriplion |

bditimum Uzage |0 ¥ Promote mzoms to paienl

Cancsl
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MW=drum Uzage |1

8.

9.
10.

In the Name box, type “ShipTo_NAD?”, which is a specialized definition
that identifies this group as containing shipping information.

Click OK to save the change and exit the Group Properties dialog.

Click the 0200_NAD:4 group with the right mouse button and select
Properties from the shortcut menu to access the Group Properties
dialog.

Marne | [EA00_Nal: 4
D eszcriplion |
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11.

12.
13.

14.

15.

April 2005

In the Name box, type “RemitTo_NAD”, which is a specialized
definition that identifies this group as containing shipping information.

Click OK to save the change and exit the Group Properties dialog.

Double-click the Vend_NAD group and the RemitTo_NAD group to
open them.

Click the DEACT IVATE button on the Main Toolbar. Click the original
0200_NAD group, which now repeats 17 times.

In the Vend_NAD group, click the LOC:10 segment and the
0500_CTA:2 group.
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Promoting the
LOC:11 segment

Promoting the
CTA:3 group

Promoting the PIA
segment

16. In the RemitTo_NAD group, click the LOC:12 segment and the
0500_CTA:4 group.

17. Click the DEACTIVATE button on the Main Toolbar again to turn
Deactivation mode off.

The LOC:11 segment (in the ShipTo_NAD group) contains the shipping
location information and repeats up to 25 times. You must extract one
iteration of the LOC:11 segment so you can map the SHIPTOLOC field
(which is in the INVBEGIN record that repeats once) to the LOC:11
segment.

Complete the following steps to promote one iteration of the LOC:11
segment:

1. Click the LOC:11 segment (in the ShipTo_NAD group) and select
Promote from the shortcut menu to extract one iteration of the LOC:11
segment. The new iteration is named LOC:13 and is located directly
above the LOC:11 segment.

2. Click the original LOC:11 segment with the right mouse button and
select Deactivate from the shortcut menu to deactivate the LOC:11
segment, which now repeats 24 times.

The CTA:3 group (in the ShipTo_NAD group) contains the contact
information and repeats up to five times. You must extract one iteration of
the CTA:3 group so you can map the SHIPTODEPTNUM field (which is in
the INVBEGIN record that repeats once) to the CTA:3 group.

Complete the following steps to promote one iteration of the CTA:3 group:

1. Click the CTA:3 group (in the ShipTo_NAD group) and select Promote
from the shortcut menu to extract one iteration of the CTA:3 group. The
new iteration is named CTA:5 and is located directly above the CTA:3
group.

2. Click the original CTA:3 group with the right mouse button and select
Deactivate from the shortcut menu to deactivate the CTA:3 group,
which now repeats four times.

The P1A segment (in the LIN group) contains additional product information
and repeats up to 25 times. You must extract one iteration of the PIA
segment so you can map your UPC code for the line item.

Complete the following steps to promote one iterations of the PIA segment:

1. Click the PIA segment with the right mouse button and select Promote
from the shortcut menu to extract one iteration of the PIA segment. The
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Promoting the
IMD:2 segment

Promoting the
QTY:2 segment

Promoting the
MOA group

new iteration is named PIA:2 and is located directly above the PIA
segment.

2. Click the original PIA segment (that now repeats 24 times) with the
right mouse button and select Deactivate from the shortcut menu to
deactivate the PIA segment.

The IMD:2 segment (in the LIN group) contains the Item description
information and repeats up to ten times. You must extract one iteration of the
IMD:2 segment so you can map the item description for the line item.

Complete the following steps to promote one iterations of the IMD:2
segment:

1. Click the IMD:2 segment with the right mouse button and select
Promote from the shortcut menu to extract one iteration of the IMD:2
segment. The new iteration is named IMD:3 and is located directly
above the IMD:2 segment.

2. Click the original IMD:2 segment (which now repeats nine times) with
the right mouse button and select Deactivate from the shortcut menu to
deactivate the IMD:2 segment.

The QTY segment contains the quantity information and repeats up to five
times. You must extract two iterations of the QTY:2 segment so you can
store the quantity shipped and the quantity ordered.

Complete the following steps to promote two iterations of the QTY:2
segment:

1. Click the QTY:2 segment with the right mouse button and select
Promote from the shortcut menu to extract one iteration of the QTY:2
segment. The new iteration is named QTY:5 and is located directly
above the QTY:2 segment.

2. Click the original QTY:2 segment, which now repeats four times, with
the right mouse button and select Promote from the shortcut menu to
extract one iteration of the QTY:2 segment. The new iteration is named
QTY:6 and is located directly above the QTY:2 segment.

3. Click the original QTY:2 segment with the right mouse button and
select Deactivate from the shortcut menu to deactivate the QTY:2
segment, which now repeats three times.

The MOA group in the detail section of the map (LIN group) contains the
line item unit price information and repeats up to five times. You must
extract one iteration of the MOA group so you can map the unit price to the
MOA group. Since you are only extracting one instance of the MOA group
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and then deactivating the original group, you do not need to add a
specialized definition to the new iteration of the group.

Complete the following steps to promote one iteration of the MOA group:

1. Click the 2300_MOA group (in the LIN group) with the right mouse
button and select Promote from the shortcut menu to extract one
iteration of the MOA group. The new iteration is named 2300_MOA:2
and is located directly above the 2300_MOA group.

2. Click the original 2300_MOA group with the right mouse button and
select Deactivate from the shortcut menu to deactivate the 2300_MOA
group, which now repeats four times.

Promoting the The CNT segment contains the control total information and repeats up to 10
CNT segment times. You must extract two iterations of the CNT segment so you can store
the total number of line items and the total quantity invoiced.

Complete the following steps to promote two iterations of the CNT segment:

1. Click the CNT segment with the right mouse button and select Promote
from the shortcut menu to extract one iteration of the CNT segment. The
new iteration is named CNT:2 and is located directly above the CNT
segment.

2. Click the original CNT segment (that now repeats nine times) with the
right mouse button and select Promote from the shortcut menu to extract
one iteration of the CNT segment. The new iteration is named CNT:3
and is located directly above the CNT segment.

3. Click the original CNT segment with the right mouse button and select
Deactivate from the shortcut menu to deactivate the CNT segment,
which now repeats eight times.

Promoting the The MOA group in the summary section of the map contains the total
MOA group monetary amount information for the and repeats up to 100 times. You must
extract one iteration of the MOA group so you will be able to map the
TOTALAMOUNT field (which is in the INVSUMMARY record that
repeats once), to the MOA group. Since you are only extracting one instance
of the MOA group (and will then deactivate the original group), you do not
need to add a specialized definition to the new iteration of the group.

Complete the following steps to promote one iteration of the MOA group:

1. Click the 4500_MOA group with the right mouse button and select
Promote from the shortcut menu to extract one iteration of the MOA
group. The new iteration is named 4500_MOA:2 and is located directly
above the 4500 _MOA group.
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Verifying EDI
Delimiters

2. Click the original 4500_MOA group with the right mouse button and
select Deactivate from the shortcut menu to deactivate the 4500_MOA
group, which now repeats 99 times.

If you are using an EDI standard that contains composite elements or sub-
elements, you must verify that Gentran:Director is specifying the correct
delimiters. Delimiters are flags that you define to the system as separating
specific EDI components. Delimiters are necessary for all variable field-
length standards, because the data is compressed and the leading zeroes and
trailing blanks are removed. Since the fields vary in length, the system needs
a flag to determine where one element ends and another begins. For
example, an element delimiter marks the beginning of a new element.

Although verifying EDI delimiters in Gentran:Director
is mandatory only if you are using a standard with
composite elements or sub-elements, we recommend
that perform this task regardless of which standard
you use.

Complete the following steps to verify EDI delimiters:

1. Click the INVOIC INVOICE MESSAGE file icon with the right mouse
button to access the shortcut menu. Select Properties... from the shortcut
menu to display the EDI File Format Properties dialog.

ELI Hic: Format Hroportics

Heme |IH¥OIC Dsec INVOICE MESSAGE
[T Sticam z=gments
EDI Synlan
Rules .. I
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T Oehrikar | Bl Tes Tag Dedrke Pos

Element Delmitsr I + I Elemert D eimiler Foz
Tag Poetian

Segment Delmier | ! I— Segmenl O elmiter Poz

Sub Element O elimiler | : Flecord Length Subelemant Defmiber Pos

Rales=a Chalaclar I ? I Ralaaze Character Poe

[ecimal Sepaiator | Oeoma Sepaxotm Pox

iR
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2. Inthe EDI Syntax section, verify that the Specify defaults check box is
selected.

3. Verify the required delimiters for the EDIFACT standard. If the
delimiters differ from the defaults in the table below, type either the
character or the hexadecimal value in the correct box.The default
delimiters for EDIFACT are the following:

EDIFACT Default EDIFACT
Default Hex
Character
Value

Tag Delimiter

Element Delimiter + (plus) 0x2B
Segment Delimiter ' (single quote) 0x27
Sub Element Delimiter : (colon) 0x3A
Release Character ? (question mark) Ox3F
Decimal Separator . (period) Ox2E

The tag delimiter is not used for EDIFACT.
4. Click OK to exit the EDI File Format Properties dialog.
Now define your application file layout.
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Defining the Rest of Your Application File Format

Copying the
HEADER
Record

Removing the
HEADER Standard
Rules

You have already defined the system import map that you will copy and use
in your import map. Now you must define the rest of your application file to
Gentran:Director. In the import map, the input side of the map is positional.
Your application file must contain all the information that you need to
generate the EDI message that you will send to your partner.

Before you define your application file format, obtain a layout of the
necessary records, fields, and groups. Each level of your application file
format must be created sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. This means that you
must create records and the group before you create the subordinate fields
and records.

You can copy the system import map header record to the import map. The
copied record contains subordinate fields, which will also be copied. Copied
map components retain all the information of the original map component,
S0 you must remove the standard rules you created for the fields in the
header record for the system import map.

Complete the following steps to copy the HEADER record from the system
import map to the import map:

1. Open the HEADER.MAP system import map if it is not already open.
2. Highlight the HEADER record.

3. Click Copy on the Main Toolbar.

4. Openthe PET_EINV.MAP import map.

5. Highlight the INPUT positional file icon.

6. Click Paste on the Main Toolbar to paste the contents of the Clipboard.

The HEADER record is pasted as a subordinate map component to the
INPUT positional file icon.

The HEADER record that you just copied from the system import map
contains five fields. The first field (PARTNER_ID) had a Select standard
rule applied to it in the system import map. The remaining four fields in the
copied HEADER record in the import map (STANDARD, VERSION,
TRANSACTION_SET, and TEST_PROD) had Update standard rules
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applied to them in the system import map. These standard rules are not
applicable to the import map so you must remove them.

Complete the following steps to remove the standard rules from the
HEADER record in the import map:

1. Double-click the PARTNER_ID field in the HEADER record to display
the Field Properties dialog.

| izl 'opoitizs

M Mandalon |1 |a ExIES
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Mn  Maz  Tpps Fremat

Creating the
INVBEGIN
Record

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Click the Use Standard Rule check box to remove the standard rule. The
system asks you confirm the removal of the standard rule from the field.

4. Click YES to remove the standard rule.
5. Click OK to save the change to the field.

6. Repeat steps 1 -6 for the STANDARD, VERSION,
TRANSACTION_SET, and TEST_PROD fields.

The second record in your application file format you must create
(INVBEGIN) is at the same level as the HEADER record.

The INVBEGIN (beginning) record contains the purchase order number and
date; the vendor, ship to, and remit to address information; and the bill of
lading number, and ship date. The beginning record is mandatory and occurs
once for each invoice.

Complete the following steps to create the INVBEGIN record:

1. Highlight the HEADER record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.
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2.

create equal records/groups and “Create Sub” to
create subordinate groups/records/fields.

Q Use “Insert” from the Edit menu when you want to

In the Name box, type “INVBEGIN” as the record identification code.

Do not use spaces or dashes (-) in the Name box. Use
the underscore () to separate words.

April 2005

In the Desc box, type “Beginning Record”. This description provides a
brief explanation of the record that allows you to differentiate it from
similar records.

In the Tag box, type “BEG” as the record identification code <TAG>. A
record is recognized by the following syntax:

<TAG>[Field_1][Field 2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

Q You must define the record tag on the Positional

Record Properties dialog for outbound maps instead of
defining fields with the purpose of explicitly containing
the record tag.

In the Position box, accept the default of “1” for the starting column
position of the tag in the data record.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

If the Min Usage box contains a “0” (zero), the record
is “conditional.” If the Min Usage box contains a “1” or
greater, the record is “mandatory.”

Accept the default of “1” in the Max Usage box so the beginning record
only occurs once (not a looping structure).
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The Positional Record Properties dialog should now look like this:
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7. Click OK to create the INVBEGIN record.

Creating the
INVCOMMENT The INVCommentGroup (comment information) groups all invoice
G comment information, including the reference number and the message text.
roup The INVCommentGroup occurs up to 10 times per invoice translated. The
information within the INVCommentGroup is further segregated by related
records.

Complete the following steps to create the INVCommentGroup:

1. To create a group that is at the same level as the INVBEGIN record,
highlight the INVBEGIN record and select Insert from the Edit menu.
Select Group from the submenu.
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2.

The Group Properties dialog is displayed.
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In the Name box, type “INVCommentGroup” to indicate that this group
will contain all of the comment records. This is the segment loop
identification code.

In the Description box, type “Comment Group” as the loop description.
This description provides a brief explanation of the loop.

In the Minimum Usage box, type “1” to make the loop mandatory. This
is the minimum number of times the loop must be repeated. For a
conditional loop, the minimum usage should always be “0” (zero). For a
mandatory loop, the minimum usage should be “1” or greater.

In the Maximum Usage box, type “10” to indicate that this group of
records will occur up to 10 times.

The Group Properties dialog should now look like this:
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5.
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Click OK to create the INVCommentGroup.
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Creating the

INVCOMMENT In this tutorial, the INVCommentGroup contains two subordinate records:
1 and INVCOMMENT1 and INVCOMMENT?2. After you create the first
subordinate record (INVCOMMENTL1), define the subsequent record at the
INVCOMMENT ' same level (INVCOMMENT?).

2 Records The INVCOMMENT1 (first comment) record contains the reference
number. The first comment record is mandatory and occurs once per invoice
translated (once for each comment line).

Complete the following steps to create the INVCOMMENT1 record:

1. Highlight the INVCommentGroup and select Create Sub from the Edit
menu. Select Record from the submenu.

The Positional Record Properties dialog is displayed.
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2. Inthe Name box, type “INVCOMMENT1” as the record identification
code.

In the Desc box, type “Invoice Comment Record 1”.
4. In the Tag box, type “CM1” as the record identification code <TAG>.

In the Position box, accept the default of “1” for the starting column
position of the tag in the data record.
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7.

In the Min Usage box, type “1” to make the record mandatory.

Accept the default of “1” in the Max Usage box so this record only
occurs once (not a looping structure).

The Positional Record Properties dialog should now look like this:
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Click OK to create the INVCOMMENT?1 record.

The INVCOMMENT?2 (second comment) record contains message text. The
second comment record is mandatory and occurs once per invoice translated
(once for each comment line).

Complete the following steps to create the INVCOMMENT?2 record:

1.
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Highlight the INVCOMMENT1 record and select Insert from the Edit
menu. Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “INVCOMMENT?2” the record identification
code.

In the Desc box, type “Invoice Comment Record 2”.
In the Tag box, type “CM2” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

In the Min Usage box, type “1” to make the record mandatory.
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Accept the default of “1” in the Max Usage box so this record only
occurs once (not a looping structure).

The Positional Record Properties dialog should now look like this:
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7. Click OK to create the INVCOMMENT?2 record.

Creating the

INVDETAIL The INVDETAIL (detail) record is at the same level as the HEADER and
Record INVBEGIN records and the INVCommentGroup.

The INVDETAIL record contains line item number and description, quantity
shipped, quantity ordered, unit of measure, price, and product code. The
detail record is mandatory and occurs up to 200,000 times per invoice
translated (once for each line item invoiced).

Complete the following steps to create the INVDETAIL record:

1. Highlight the INVCommentGroup and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

2. Inthe Name box, type “INVDETAIL” as the record identification code.
In the Desc box, type “Detail Record” as a record description.
4. Inthe Tag box, type “DET” as the record identification code <TAG>.
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5. Inthe Position box, accept the default of “1” as the starting column
position of the tag in the data record.

6. Inthe Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

7. Inthe Max Usage box, type “200000” as the maximum amount of times
the record can repeat.

The Positional Record Properties dialog should now look like this:
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8. Click OK to create the INVDETAIL record.

Creating the

INVSUMMARY  The final record that you must create is the INVSUMMARY (summary)
Record record, which is at the same level as the INVDETAIL record.

The INVSUMMARY (summary) record contains the total invoice amount
and the total transaction amount. The summary record is mandatory and
occurs once per invoice translated.

Complete the following steps to create the INVSUMMARY record:

1. Highlight the INVDETAIL record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.
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2. Inthe Name box, type “INVSUMMARY” as the record identification
code.

In the Desc box, type “Summary Record” as a record description.
4. Inthe Tag box, type “SUM” as the record identification code <TAG>.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

6. Inthe Min Usage box, type “1” to make the record mandatory.
7. Accept the default of “1” in the Max Usage box.
The Positional Record Properties dialog should now look like this:
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8. Click OK to create the INVSUMMARY record.

Now that you have created the record structure of the application file, you
can define the application fields.
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Creating the
Application
Fields

Field Name

The application side of the map (input) should now look like this:

EFINPUT M-
:zHEﬁDEH M- 1 Header Recard
INYBEGIM -#- 1 Beginning Record
—ﬁlN\-"EDmmentGmup -t- 10 Comment Group
tgmucnmmmﬂ M- 1 Inwoice Comment Record 1
[MVCOMMEMNTZ - 1 Invoice Comment Fecord 2
:zINVDET.-’-'-.IL -bd- 200000 Detail Record
INWSUMMARY -b4- 1 Summary Record

Each record you create will contain a group of logically related application
fields. These fields define the data structure and content that your system
uses to process the invoice.

The easiest way to add application fields to a record is to use the Positional
Field Editor. You generally create the fields for each sequential record
starting with the INVBEGIN record.

The application fields that you must create are listed under their respective
records in the following table. The name, mandatory status, description, data
type, and field length for each field are given in the table.

Min Max
Length  Length

Description

Header Record (HEADER) 1 per message

PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1

Beginning Record (INVBEGIN) 1 per message

BILLTOACCTBEG X Bill to Acct Number String 1 9

DOCTYPBEG X Document Type String 1 6

INVNUMBEG X Invoice Number String 1 10

INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)

182 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC)

Defining the Rest of Your Application File Format

Field Name

Description

Min
Length

Max
Length

PONUM Purchase Order Number String 0 20
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)
VENDNAME Vendor Name String 0 35
VENDADD1 Vendor Address Line 1 String 0 35
VENDADD2 Vendor Address Line2 String 0 35
VENDCITY Vendor City String 0 35
VENDSTATE Vendor State String 0 2
VENDPOSTALCODE Vendor Postal Code String 0 9
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD?2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
SHIPTOLOC Ship To Store Location String 0 9
SHIPTODEPTNUM Ship To Dept Number String 0 4
REMITTONAME Remit To Name String 0 35
REMITTOADD1 Remit To Address Line 1 String 0 35
REMITTOADD2 Remit To Address Line 2 String 0 35
REMITTOCITY Remit To City String 0 35
REMITTOSTATE Remit To State String 0 2
REMITTOPOSTALCODE Remit To Postal Code String 0 9
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
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Field Name

Comment Group (INVCommentGroup) 10 per message

Description

Min Max
Length  Length

Comment Record 1 (INVCOMMENT1) 1 per message

BILLTOACCTCM1 X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
REFNUM X Reference Number String 1 30
Comment Record 2 (INVCOMMENT2) 1 per message
BILLTOACCTCM2 X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232
Detail Record (INVDETAIL) up to 200,000 per message
BILLTOACCTDET X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) String 1 6
QTYSHIP X Quantity Shipped Number (NO) | 1 5
QTYORD X Quantity Ordered Number (NO) | 1 5
UNITPRICE X Unit Price Number (N2) | 1 7
UoM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
Summary Record (INVSUMMARY) 1 per message
BILLTOACCTSUM X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
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Field Name Description 'II?;;Z L;\ﬁignth Lg/lnzxth
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT X Total Monetary Value Number (N2) | 1 10

Summary
TRANSTOTAL X Transaction Totals Number (NO) | 1 6

You created the fields for the system import map HEADER record, copied
the fields to the import map, and removed the standard rules. The
INVBEGIN record is the first record for which you must define fields.
Complete the following steps to create the application fields for the
INVBEGIN record:

1. Click the INVBEGIN application record with the right mouse button
and select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

2. If the field you are creating is the first field in the record, click NEW. A
highlight bar is displayed in the Fields section where the new field is
positioned. You must fill in the field values in the Field Details section.

3. Inthe Name box, type “BILLTOACCTBEG”, which is the name of the
first field in the INVBEGIN record. Each application field must have a
unique name. It is useful to tag the end of fields that occur in multiple
records with a suffix that identifies the record that contains it. For
example, “BEG” for the Beginning record.

4. Click the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number”. This
description provides a brief explanation of the field that allows you to
differentiate it from similar fields.

6. From the Data Type list, select the “String” as the field type to specify
that this field must contain alphanumeric data.

To indicate the exact position of the field in the record,
type the starting field position in the Start Pos box.
Specify field start positions if, for example, you will
only be using a few fields and you want them
positioned exactly in the record.

In this tutorial, you will use the alternative to

specifying the start position of each field, which is to
add the fields sequentially in the record and then use
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10.

11.

12.
13.

the Auto Position function. Please see step 13 below for
more information on the Auto Position function.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

If, according to the table starting on page 182, the field’s minimum
length is “0”, then accept that default in the Min Length box. Otherwise
type “111.

In the Max Length box, type “9” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 182.

Click DELETE to stop adding fields.

Click AUTO POSITION to automatically position the fields in the
record. This calculates the start position in the record of each field based
on the criteria that each field is positioned directly after the previous
field and is of the length specified in the Max Length field. Click YES
to acknowledge the warning message that fields will be sequenced in
order.

It is only valid to use the Auto Position function if you
define a record tag on the Positional Record Properties

April 2005

dialog, and if you define every field in the record in the
sequence that each field occurs, as you are doing in this
tutorial.
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The Positional Field Editor dialog should now look like the following
(only the last 11 fields in the record are currently visible in the Fields
list):
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14. After you are completely finished adding fields to the INVBEGIN

record, click CLOSE.

Complete the following steps to create the application fields for the
INVCOMMENT1 record:

1.

Click the INVCOMMENT?1 application record with the right mouse
button and select Edit Fields... from the shortcut menu to access the
Positional Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “BILLTOACCTCML1”, which is the name of the
first field in the INVCOMMENT1 record.

Click the Mandatory check box to identify it as a required field.
In the Description box, type “Bill To Account Number”.
From the Data Type list, select the “String” as the field type.

Gentran:Director Application Integration EDIFACT Tutorial Guide April 2005 187



Defining the Rest of Your Application File Format Outbound Invoice (INVOIC)

188

10.

11.

12.
13.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

If, according to the table starting on page 182, the field’s minimum
length is “0”, then accept that default in the Min Length box. Otherwise
type “111.

In the Max Length box, type “9” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 182.

Click DELETE to stop adding fields.

Click AUTO POSITION. Click YES to acknowledge the warning
message that fields will be sequenced in order.

The Positional Field Editor dialog should now look like the following:
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14. After you are completely finished adding fields to the
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INVCOMMENT1 record, click CLOSE.
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Complete the following steps to create the application fields for the
INVCOMMENT?2 record:

1.

10.

11.

12.
13.

Click the INVCOMMENT?2 application record with the right mouse
button and select Edit Fields... from the shortcut menu to access the
Positional Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “BILLTOACCTCM2”, which is the name of the
first field in the INVCOMMENT?2 record.

Click the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the field
description.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

If, according to the table starting on page 182, the field’s minimum
length is “0”, then accept that default in the Min Length box. Otherwise
type “111.

In the Max Length box, type “9” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER.

Create the rest of the fields according to the record layout table starting
on page 182.

Click DELETE to stop adding fields.

Click AUTO POSITION. Click YES to acknowledge the warning
message that fields will be sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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14. When you are completely finished adding fields to the

INVCOMMENT?2 record, click CLOSE.

Complete the following steps to create the application fields for the
INVDETAIL record:

1.

190 April 2005

Click the INVDETAIL application record with the right mouse button
and select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “BILLTOACCTDET”, which is the name of the
first field in the INVDETALIL record.

Click the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the field
description.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC)

Defining the Rest of Your Application File Format

8.

10.

11.

12.
13.

14.

If, according to the table starting on page 182, the field’s minimum
length is “0”, then accept that default in the Min Length box. Otherwise
type “1”.

In the Max Length box, type “9” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER.

Create the rest of the fields according to the record layout table starting
on page 182.

Click DELETE to stop adding fields.

Click AUTO POSITION. Click YES to acknowledge the warning
message that fields will be sequenced in order.

The Positional Field Editor dialog should now look like the following:
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After you are completely finished adding fields to the INVDETAIL
record, click CLOSE.
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Complete the following steps to create the application fields for the
INVSUMMARY record:

1.

10.

11.

12.
13.

April 2005

Click the INVSUMMARY application record with the right mouse
button and select Edit Fields... from the shortcut menu to access the
Positional Field Editor dialog.

If the field you are creating is the first field in the record, click NEW.

In the Name box, type “BILLTOACCTSUM?”, which is the name of the
first field in the INVSUMMARY record.

Click the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the field
description.

From the Data Type list, select the “String” as the field type.

If the Data Type is “Number” or “Dt/Tm”, select the appropriate format
from the Format list.

If, according to the table starting on page 182, the field’s minimum
length is “0”, then accept that default in the Min Length box. Otherwise
type “111.

In the Max Length box, type “9” as the maximum field length.

To add the field and to create the next field positioned after it, press
ENTER.

Create the rest of the fields according to the record layout table starting
on page 182.

Click DELETE to stop adding fields.

Click AUTO POSITION. Click YES to acknowledge the warning
message that fields will be sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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14. After you are completely finished adding fields to the INVSUMMARY
record, click CLOSE.

After defining your application file, you must map the necessary data from
the EDI file to your application fields.
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Mapping Your Data

HEADER Record

INVBEGIN
Record

BILLTOACCTBEG

194

DOCTYPBEG

INVNUMBEG

This section examines each application field sequentially and describes the
mapping operations that you must perform to map the appropriate data from
each field.

For the import map, you will not map from any of the fields in the HEADER
(header) record. This record contains the five fields that comprise the key in
the system import map. However, since this header record is part of your
application file, it must be defined in the import map. You did this when you
copied the HEADER record from the system import map to this import map.
This header record is mandatory and occurs only once.

This section describes how to map from each field in the INVBEGIN
(beginning) record. The INVBEGIN (beginning) record contains the
purchase order number and date; the vendor, ship to, and remit to address
information; and the bill of lading number and ship date. The beginning
record is mandatory and occurs once for each invoice.

The BILLTOACCTBEG field is part of the application file format key, but
does not contain data that the system uses to generate the invoice. You will
not perform any mapping operations on this field.

The DOCTYPBEG field is part of the application file format key, but does
not contain data that the system uses to generate the invoice.You will not
perform any mapping operations on this field.

Use the Link function to map the INVNUMBEG field directly to the
BGMO05 (document/Message Number) element. The Link function allows
you to map a field or element from the Input side of the map to a field or
element on the Output side of the map. The link between the two fields is
visually represented with a line connecting the two fields.

You can also link the INVNUMBEG field directly to the UNS01 element
(Section Identification). This is a mandatory element in the mandatory UNS
segment (Section Control). For Gentran:Director to create a mandatory
segment in an outbound map, that segment must have at least one field
mapped to it. This direct link is overwritten by mapping the constant value
(“S”) that you have already mapped to the UNSO1 element.

April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC) Mapping Your Data

Mapping the invoice
number

Setting up the document
name

We recommend that you set up a Document Name for each map to make the
message identification easier when you use the document browsers.

To set up a Document Name, you must select an element or field in the map
that contains data to distinguish the messages translated by this map.

We strongly recommend that you select an element or
field that occurs only once in the message and has a
data type of “String.” For an Invoice, the document
name is typically the Document/Message Number.

To map the invoice number, link the application field INVNUMBEG in the
INVBEGIN record to the BGMO5 element in the BGM record.

Complete the following steps to set up the Document Name for this Purchase
Order:

1. Double-click the BGMO05 element to display the Field Properties dialog.
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2. Click the Use Standard Rule check box in the Advanced section to
display the rule options.

Click the Update option.
From the Table/Key list, select “Document record.”

From the Field list, select “Document Name.” This indicates that you
are updating the Name box in the document browsers with the contents
of this element.
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INVDATE

Changing the properties
of the DTM:2202
element

The Advanced section of the dialog should now look like this:
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6. Click OK to set up the document name.

On the EDI side of the map, the date information is contained in the DTM:22
segment. You must change the properties of the DTM:2202 element (Date/
Time/Period) to reflect the minimum and maximum length, the type, and the
format that your partner will send you.

Use the Link function to map the INVDATE field directly to the DTM:2202
(Date/Time/Period) element. If the DTM:2201 (Date/Time/Period Qualifier)
is “3”, the DTM:22 segment contains the invoice date/time. You must map a
constant to the Date/Time/Period Qualifier and establish a qualifying
relationship with the Date/Time/Period. This enables you to specify that the
Date/Time/Period element contains the invoice date/time.

You informed your partner that you will send six digits for the DTM:2202
element (Date/Time/Period) and these six digits will be a Dt/Tm data type in
the YYMMDD format (two-digit year, two-digit month, and two-digit day).
You must change the minimum and maximum length, the type, and the
format of the DTM:2202 element.

196 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC) Mapping Your Data

Complete the following steps to change the length of the DTM:2202

element:
1. Double-click the DTM:2202 element to display the Field Properties
dialog.
v [702
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2. Inthe Min box, type “6” as the minimum length.
In the Max box, type “6” as the maximum length.

4. From the Type list, select “Dt/Tm” to indicate that this is a date/time
element. The system prompts you with a message that changing the
field’s data type will invalidate its format. Click YES to acknowledge
this message and proceed.

5. From the Format list, select “YYMMDD,” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits contain the day.

The Field Properties dialog should now look like this:
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6. Click OK to exit the Field Properties dialog.

Setting the date/time/ You must map a constant to the Date/Time/Period Qualifier (DTM:2201
period qualifier element) and define a qualifying relationship with the Date/Time/Period
(DTM:2202 element).
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You have already defined all the constants that you will use for this map.
Now map the appropriate constant to the Date/Time/Period Qualifier
element.

Complete the following steps to set the Date/Time/Period Qualifier for the
DTM:22 segment:

1. Double-click the DTM:2201 element (Date/Time/Period Qualifier) in
the DTM:22 segment to access the Field Properties dialog.
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Click the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

a &~ D

From the Constants list, select the “3” constant (invoice date/time) to
identify the DTM:2202 element as containing the invoice date and time.

6. From the Qualifies list, select the “2380:2DATE/TIME/PERIOD,” to
set up a qualifying relationship with the DTM:2202 element.

The Qualifies list contains only active elements in the
same segment as the qualifying element.

7. Click OK. The “3” code is loaded in the Date/Time/Period Qualifier
element. The qualifying relationship between the DTM:2201 and
DTM:2202 elements is established.

Mapping the invoice To map the invoice date, link the application field INVDATE in the
date INVBEGIN record to the DTM:2202 element in the DTM:22 segment.
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PONUM

Setting the reference
qualifier

Use the Link function to map the PONUM field directly to the RFF:1102
(Reference Number) field. If the RFF:1101 (Reference Qualifier) is “ON,”
the RFF:11 segment contains the order number (purchase). You must map a
constant to the Reference Qualifier and establish a qualifying relationship
with the Reference Number. This enables you to specify that the Reference
Number element contains the order number (purchase).

We recommend that you set up a Document Reference for each map to make
message identification easier.

To set up a Document Reference, you must select an element or field in the
map that contains data to distinguish messages translated by this map. If you
set up the Reference in the Application Integration subsystem, the RefData
field of the document browsers that contain this message will contain the
data from that mapped field.

You must map a constant to the Reference Qualifier (RFF:1101 element)
and define a qualifying relationship with the Reference Number (RFF:1102
element).

You have already defined all the constants that you will use for this map.
Now map the appropriate constant to the Reference Qualifier element.

Complete the following steps to set the Reference Qualifier for the RFF:11
segment:

1. Double-click the RFF:1101 element (Reference Qualifier) in the
RFF:11 segment (PONUM_RFF group) to access the Field Properties
dialog.
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2. Click the Use Standard Rule check box.
3. Click the Constant option.
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4. Click the second Constant option.
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5. From the Constants list, select the “ON” constant to identify the
RFF:1102 element as containing the order number (purchase).

6. From the Qualifies list, select the “1154 REFERENCE NUMBER” to
set up a qualifying relationship with the RFF:1102 element.

7. Click OK and the “ON” code is loaded in the Reference Qualifier
element. The qualifying relationship between the RFF:1101 and
RFF:1102 elements is also established.

Mapping the purchase To map the purchase order number, link the application field PONUM in the
order number |NVBEGIN record to the RFF:1102 element in the RFF:11 segment

(PONUM_RFF group).
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Setting up the document  Complete the following steps to set up the Document Reference for this
reference |nvoice:

1.

Double-click the RFF:1102 element to display the Field Properties

dialog.
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6.

Click the Use Standard Rule check box in the Advanced section, to
display the rule options.

Click the Update option.
From the Table/Key list, select “Document record.”

From the Field list, select “Reference Data.” This indicates that you are
updating the RefData field in the document browsers with the contents

of thise

lement.

The Advanced section of the Field Properties dialog should now look

like this
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Click OK to set up the document reference.
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PODATE

Changing the properties

202

of the DTM:2502
element

On the EDI side of the map, the purchase order date information is contained
in the DTM:25 segment (in the PONUM_RFF group). You must change the
properties of the DTM:2502 element (Date/Time/Period) to reflect the
minimum and maximum length, type, and format that your partner will send
you.

Use the Link function you to map the PODATE field directly to the
DTM:2502 (Date/Time/Period) element. If the DTM:2501 (Date/Time/
Period Qualifier) is “4”, the DTM:25 segment contains the order date/time.
You must map a constant to the Date/Time/Period Qualifier and establish a
qualifying relationship with the Date/Time/Period. This enables you to
specify that the Date/Time/Period element contains the order date/time.

You have informed your partner that you will send six digits for the
DTM:2502 element (Date/Time/Period) and that these six digits will be a Dt/
Tm data type in the YYMMDD format (two-digit year, two-digit month, and
two-digit day). You must change the minimum and maximum length, type,
and format of the DTM:2502 element.

Complete the following steps to change the length of the DTM:2502
element:

1. Double-click the DTM:2502 element to display the Field Properties
dialog.
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2. Inthe Min box, type “6” as the minimum length.
In the Max box, type “6” as the maximum length.

4. From the Type list, select “Dt/Tm.” Click YES to acknowledge this
message and proceed.

5. From the Format list, select “YYMMDD.”
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The Field Properties dialog should now look like this:
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6. Click OK to exit the Field Properties dialog.

Setting the date/time/ You must map a constant to the Date/Time/Period Qualifier (DTM:2501
period qualifier element) and define a qualifying relationship with the Date/Time/Period
(DTM:2502 element).

You have already defined all the constants that you will use for this map.
Now you can map the appropriate constant to the Date/Time/Period
Qualifier element.

Complete the following steps to set the Date/Time/Period Qualifier for the
DTM:25 segment:

1. Double-click the DTM:2501 element (Date/Time/Period Qualifier) in
the DTM:25 segment to access the Field Properties dialog.
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2. Click the Use Standard Rule check box.
3. Click the Constant option.

4. Click the second Constant option.
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The Advanced section of the Field Properties dialog should now look

like this.
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5. From the Constants list, select the “4” constant (order date/time), to
identify the DTM:2502 element as containing the order date and time.

6. From the Qualifies list, select “2380:2 DATE/TIME/PERIOD” to set up
a qualifying relationship with the DTM:2502 element.

7. Click OK. The “4” code is loaded in the Date/Time/Period Qualifier
element and the qualifying relationship between the DTM:2501 and
DTM:2502 elements is established.

Mapping the purchase Use the Link function to map the PODATE field directly to the DTM:2502

order date (Date/Time/Period) element.

= To map the purchase order date, link the application field PODATE in
the INVBEGIN record to the DTM:2502 element in the DTM:25
segment (in the PONUM_RFF group).

VENDNAME The NAD group contains vendor, shipping, and billing name and address
information. It repeats multiple times. Your application file contains Vendor,
Ship To, and Remit To information that you must map to the NAD group.
However, you can only map fields and elements that are at the same level.
This means that you cannot map from a non-repeating record to a group.
Specifically, you cannot map the vendor, shipping, and remittance
information in the INVBEGIN record directly to the NAD group, because
the INVBEGIN record does not repeat.

204 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC) Mapping Your Data

Setting the party qualifier

To map vendor, shipping, and remittance information from your application
file format, you created three single iterations of the NAD group using the
promote function, so that the links between the application fields in the
INVBEGIN record and the NAD groups are valid. The Promote function
extracts the one iteration (instance) of a group (or repeating segment). This
enables you to map unique data from your application file to each NAD
group (Vend_NAD, ShipTo_NAD, and RemitTo_NAD).

You can map a constant to the NAD segment Party Qualifier for each
iteration of the NAD group. If the Party Qualifier is “VN,” that iteration of
the NAD group contains shipping information. You must map the Vendor
name and address fields in your application file format to the Vend_NAD
group. If the Party Qualifier is “ST,” that iteration of the NAD group
contains shipping information. You must map the Ship To name and address
fields in your application file format to the ShipTo_NAD group. If the Party
Qualifier is “RE”, that iteration of the NAD group contains remittance
information. You must map the remittance name and address fields in your
application file format to the RemitTo_NAD group.

You must set the Party Qualifier for the Vend_NAD, ShipTo_NAD, and

RemitTo_NAD groups, so the system can distinguish the type of name and

address information each NAD group should contain.

You have already defined all the constants that you will use for this map.

Now you can map the appropriate constant to each Party Qualifier element.

Complete the following steps to set the Party Qualifier for the Vend_NAD

group:

1. Double-click the NAD:301 element (Party Qualifier) in the NAD:3
segment to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
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4. Click the second Constant option.
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5. From the Constants list, select the “VVN” constant to identify this
iteration of the NAD group as containing vendor name and address

information.

6. Click OK. The “VN” code is loaded in the Party Qualifier element.
Complete the following steps to set the Party Qualifier for the ShipTo_NAD

group:

1. Double-click the NAD:401 element (Party Qualifier) in the NAD:4
segment to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.

3. Click the Constant option.
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6.

Click the second Constant option.
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From the Constants list, select the “ST” constant to identify this
iteration of the NAD group as containing shipping name and address
information.

Click OK. The “ST” code is loaded in the Party Qualifier element.

Complete the following steps to set the Party Qualifier for the
RemitTo_NAD group:

1.

a &~

Double-click the NAD:501 element (Party Qualifier) in the NAD:5
segment to access the Field Properties dialog.

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

From the Constants list, select the “RE” constant to identify this
iteration of the NAD group as containing vendor name and address
information.

Click OK. The “RE” code is loaded in the Party Qualifier element.

Linking the NAD group  Link the elements in your application fields to the appropriate elements in
the NAD group.

Mapping the vendor To map the vendor name, link the application field VENDNAME in the
name |INVBEGIN record to the NAD:310 element in the NAD:3 segment

(Vend_NAD group).
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VENDADD1 To map the VENDADD]I, link the application field VENDADDL1 in the
INVBEGIN record to the NAD:316 element in the NAD:3 segment
I (Vend_NAD group).

VENDADDZ To map the VENDADD?2, Link the application field VENDADD?2 in the
~ INVBEGIN record to the NAD:317 element in the NAD:3 segment
(Vend_NAD group).

VENDCITY To map the VENDCITY, link the application field VENDCITY in the
~ INVBEGIN record to the NAD:319 element in the NAD:3 segment
(Vend_NAD group).

VENDSTATE To map the VENDSTATE, link the application field VENDSTATE in the
INVBEGIN record to the NAD:320 element in the NAD:3 segment
-1 (Vend_NAD group).

VENDPOSTALCODE To map the VENDPOSTALCODE, link the application field
VENDPOSTALCODE in the INVBEGIN record to the NAD:321 element in
the NAD:3 segment (Vend_NAD group).

SHIPTONAME To map the SHIPTONAME, link the application field SHIPTONAME in the
INVBEGIN record to the NAD:410 element in the NAD:4 segment
(ShipTo_NAD group).

<]

SHIPTOADD1 To map the SHIPTOADDZ, link the application field SHIPTOADDL in the
INVBEGIN record to the NAD:416 element in the NAD:4 segment
a (ShipTo_NAD group).

SHIPTOADDZ To map the SHIPTOADD?2, link the application field SHIPTOADD?2 in the
INVBEGIN record to the NAD:417 element in the NAD:4 segment
> (ShipTo_NAD group).

-

SHIPTOCITY To map the SHIPTOCITY, link the application field SHIPTOCITY in the
INVBEGIN record to the NAD:419 element in the NAD:4 segment
e (ShipTo_NAD group).

SHIPTOSTATE  To map the SHIPTOSTATE, link the application field SHIPTOSTATE in
the INVBEGIN record to the NAD:420 element in the NAD:4 segment
> (ShipTo_NAD group).

-
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SHIPTOPOSTALCODE  To map the SHIPTOPOSTALCODE, link the application field
- SHIPTOPOSTALCODE in the INVBEGIN record to the NAD:421 element
in the NAD:4 segment (ShipTo_NAD group).

SHIPTOLOC The SHIPTOLOC (ship to location) contains additional reference
information about the Ship To address. This field is in the INVBEGIN
record that occurs once. Map this field to the LOC:1305 element (place/
location) in the LOC:13 segment in the ShipTo_NAD group.

You must also map a constant to the Place Location Qualifier (LOC:1301
element) and define a qualifying relationship with the Place/Location

(LOC:1305 element). If the Place/Location Qualifier is “4” (goods receipt
place), that iteration of the LOC:13 segment contains the ship to location.

Setting the place/ You have already defined all constants that you will use for this map. Now
location qualifier map the appropriate constant to each Place/Location Qualifier element.

Complete the following steps to set the Place/Location Qualifier for the
LOC:13 segment:

1. Double-click the LOC:1301 element (Place/Location Qualifier) in the
LOC:13 segment in the ShipTo_NAD group to access the Field
Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
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Mapping the ship to
location

SHIPTODEPTNUM

210

4. Click the second Constant option.
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5. From the Constants list, select the second “4” constant in the list to
identify this iteration of the LOC:13 segment as containing the ship to
department number.

6. From the Qualifies list, select the “3224:2 PLACE/LOCATION” to set
up a qualifying relationship with the Place/Location element.

7. Click OK. The “4” code is loaded in the Place/Location Qualifier
element and the qualifying relationship between the LOC:1301 and
LOC:1305 elements is established.

After mapping the constant to the Place/Location Qualifier element and
establishing the appropriate qualifying relationship, map the SHIPTOLOC
field.

To map the SHIPTOLOC, link the application field SHIPTOLOC in the
INVBEGIN record to the LOC:1305 element in the LOC:13 segment
(ShipTo_NAD group)

The SHIPTODEPTNUM (ship to department number) contains additional
reference information about the Ship To address. This field is in the
INVBEGIN record that occurs once. Map this field to the CTA:603 element
(department or employee) in the CTA:6 segment in the CTA:5 group in the
ShipTo_NAD group.

To map the SHIPTODEPTNUM, link the application field
SHIPTODEPTNUM in the INVBEGIN record to the CTA:603 element in
the CTA:6 segment in the CTA:5 group (ShipTo_NAD group)
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REMITTONAME

REMITTOADD1

REMITTOADD2
REMITTOCITY
REMITTOSTATE

REMITTOPOSTAL
CODE

BOLNUM

Setting the reference
qualifier
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To map the REMITTONAME, link the application field REMITTONAME
in the INVBEGIN record to the NAD:510 element in the NAD:5 segment
(RemitTo_NAD group).

To map the REMITTOADDLU, link the application field REMITTOADD1 in
the INVBEGIN record to the NAD:516 element in the NAD:5 segment
(RemitTo_NAD group).

To map the REMITTOADD?2, link the application field
selectREMITTOADD? in the INVBEGIN record to the NAD:517 element
in the NAD:5 segment (RemitTo_NAD group).

To map the REMITTOCITY, link the application field REMITTOCITY in
the INVBEGIN record to the NAD:519 element in the NAD:5 segment
(RemitTo_NAD group).

To map the REMITTOSTATE, link the application field REMITTOSTATE
in the INVBEGIN record to the NAD:520 element in the NAD:5 segment
(RemitTo_NAD group).

To map the REMITTOPOSTALCODE, link the application field
REMITTOPOSTALCODE in the INVBEGIN record to the NAD:521
element in the NAD:5 segment (RemitTo_NAD group).

Use the Link function to map the BOLNUM field directly to the RFF:1202
(Reference Number) field. If the RFF:1201 (Reference Qualifier) is “BM,”
the RFF:12 segment contains the bill of lading number. You must map a
constant to the Reference Qualifier and establish a qualifying relationship
with the Reference Number. This enables you to specify that the Reference
Number element contains the bill of lading number.

You must map a constant to the Reference Qualifier (RFF:1201 element)
and define a qualifying relationship with the Reference Number (RFF:1202
element).

You have already defined all the constants that you will use for this map.
Now map the appropriate constant to the Reference Qualifier element.
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Complete the following steps to set the Reference Qualifier for the RFF:12
segment:

1. Double-click the RFF:1201 element (Reference Qualifier) in the
RFF:12 segment (BOL_RFF group) to access the Field Properties
dialog.
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Mapping the bill of lading
number

SHIPDATE

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.

Click the second Constant option.

o > 0N

From the Constants list, select the “BM” constant (bill of lading
number), to identify the RFF:1202 element as containing the bill of
lading number.

6. From the Qualifies list, select the “1154 REFERENCE NUMBER” to
set up a qualifying relationship with the RFF:1202 element.

7. Click OK. The “BM” code is loaded in the Reference Qualifier element
and the qualifying relationship between the RFF:1201 and RFF:1202
elements is established.

To map the BOLNUM (bill of lading number), link the application field
BOLNUM in the INVBEGIN record to the RFF:1202 element in the RFF:12
segment (BOL_RFF group).

On the EDI side of the map, the purchase order date information is contained
in the DTM:26 segment (in the BOL_RFF group). You must change the
properties of the DTM:2602 element (Date/Time/Period) to reflect the
minimum and maximum length, type, and format that your partner will send
you.

Use the Link function to map the SHIPDATE field directly to the
DTM:2602 (Date/Time/Period) element. If the DTM:2601 (Date/Time/
Period Qualifier) is “11”, the DTM:26 segment contains the despatch date/
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Changing the properties
of the DTM:2602
element

time. You must map a constant to the Date/Time/Period Qualifier and
establish a qualifying relationship with the Date/Time/Period. This enables
you to specify that the Date/Time/Period element contains the despatch date/
time.

You have informed your partner that you will send six digits for the
DTM:2602 element (Date/Time/Period), and these six digits will be a Dt/Tm
data type in the YYMMDD format (two-digit year, two-digit month, and
two-digit day). You must change the minimum and maximum length, type,
and format of the DTM:2602 element.

Complete the following steps to change the length of the DTM:2602
element:

1. Double-click the DTM:2602 element to display the Field Properties
dialog.

2. Inthe Min box, type “6” as the minimum length.
3. Inthe Max box, type “6” as the maximum length.

4. From the Type list, select “Dt/Tm.” Click YES to acknowledge this
message and proceed.

5. From the Format list, select “YYMMDD.”
The Field Properties dialog should now look like this:
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Setting the date/time/
period qualifier

6. Click OK to exit the Field Properties dialog.

You must map a constant to the Date/Time/Period Qualifier (DTM:2601
element) and define a qualifying relationship with the Date/Time/Period
(DTM:2602 element).

You have already defined all the constants that you will use for this map.
Now you map the appropriate constant to the Date/Time/Period Qualifier
element.
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Complete the following steps to set the Date/Time/Period Qualifier for the
DTM:26 segment:

1. Double-click the DTM:2601 element (Date/Time/Period Qualifier) in
the DTM:26 segment to access the Field Properties dialog.
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In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

a &~

From the Constants list, select the “11” constant (despatch date/time) to
identify the DTM:2602 element as containing the ship date and time.

6. From the Qualifies list, select the “2380:2 DATE/TIME/PERIOD” to
set up a qualifying relationship with the DTM:2602 element.

7. Click OK. The “11” code is loaded in the Date/Time/Period Qualifier
element and the qualifying relationship between the DTM:2601 and
DTM:2602 elements is established.

Mapping the purchase Use the Link function to map the SHIPDATE field directly to the
order date  DTM:2602 (Date/Time/Period) element.

To map the purchase order date, link the application field SHIPDATE in the
INVBEGIN record to the DTM:2602 element in the DTM:26 segment (in
the BOL_RFF group)

INVComment
Group The INVCommentGroup (comment information) groups all the invoice
comment information, including the reference number and the message text.
The INVCommentGroup occurs up to 10 times per invoice translated. The
information within the INVCommentGroup is further segregated by record.
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INVCOMMENT1
Record

BILLTOACCTCM1

DOCTYPCM1

INVNUMCM1

REFNUM

Setting the text subject
qualifier

This section describes how to map from each field in the INVCOMMENT1
(first comment) record. The INVCOMMENT1 record contains the reference
number. The first comment record is mandatory and occurs once per invoice
translated (once for each comment line).

The BILLTOACCTCML field is part of the application file format key but
does not contain data that the system uses to generate the invoice. You will
not perform any mapping operations on this field.

The DOCTYPCML1 field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

The INVNUMCML1 field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

The FTX segment contains free form or coded text information. It repeats up
to 10 times. The REFNUM field can be directly mapped to the FTX06
element in the FTX segment, but you must map a constant to the Text
Subject Qualifier (FTXO01 element) and define a qualifying relationship with
the Free Text (FTX06) element to indicate that the FTX06 contains the
reference number.

You have already defined all the constants that you will use for this map.
Now map the appropriate constant to the Text Subject Qualifier element.

Complete the following steps to set the Text Subject Qualifier for the FTX
segment:

1. Double-click the FTX01 element (Text Subject Qualifier) in the FTX
segment to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
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number

INVCOMMENT?2
Record

BILLTOACCTCMZ2

DOCTYPCM2

INVNUMCM2

MESSAGETEXT

Click the Constant option.
Click the second Constant option.

From the Constants list, select the “INV” constant to identify this
iteration of the FTX segment as containing the reference number
(invoice instruction). This number is in addition to the primary order
number.

6. From the Qualifies list, select “4440 FREE TEXT” to set up a
qualifying relationship with the Free Text element.

7. Click OK. The “INV” code is loaded in the Reference Number Qualifier
element and the qualifying relationship between the FTX01 and FTX06
elements is established.

After mapping the constant to the Reference Number Qualifier element and
establishing the appropriate qualifying relationship, map the REFNUM
field.

To map the shipping reference information, link the application field
REFNUM in the INVCOMMENT1 record to the FTX06 element in the REF
segment.

This section describes how to map from each field in the INVCOMMENT?2
(first comment) record. The INVCOMMENT2 record contains message text.
The second comment record is mandatory and occurs once per invoice
translated (once for each comment line).

The BILLTOACCTCM2 field is part of the application file format key but
does not contain data that the system uses to generate the invoice. You will
not perform any mapping operations on this field.

The DOCTYPCM2 field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

The INVNUMCM2 field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

To map the message text, link the application field MESSAGETEXT in the
INVCOMMENT?2 record to the FTXO07 element in the FTX segment.
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INVDETAIL

Record This section describes how to map from each field in the INVDETAIL
(detail) record. The INVCOMMENT?2 record contains line item number and
description, quantity shipped, quantity ordered, unit of measure, price, and
product code. The detail record is mandatory and occurs up to 200,000 times
per invoice translated (once for each line item invoiced).

BILLTOACCTDET The BILLTOACCTDET field is part of the application file format key but
does not contain data that the system needs to use to generate the invoice.
You will not perform any mapping operations on this field.

DOCTYPDET The DOCTYPDET field is part of the application file format key but does
not contain data that the system needs to use to generate the invoice. You
will not perform any mapping operations on this field.

INVNUMDET The INVNUMDET field is part of the application file format key but does
not contain data that the system needs to use to generate the invoice. You
will not perform any mapping operations on this field.

ITEMNUM The ITEMNUM field can be directly mapped to the LINO1 Line Item
Number element in the LIN segment (LIN group). However, you must
calculate an incremental count of the number of line items. Use that total
value in the Transaction Totals element (CNT:202).

Calculating the number Complete the following steps to count line items and generate a control total:

f line it . . .
otline rems 1. Double-click the LINO1 element (in the LIN segment in the LIN group).

This field is typically used to count line items.
The Field Properties dialog is displayed.

| 1zl "'epoibics
Neeme [1002
Descriion | |HE ITEM MUMBER
ala W aidakion Bdvancad »a
M Max  Tpp= Format p—
| .
[T Wandalop |1 IE IHumI:u:l |;I IN[I |ﬂ e

2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.
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3. Click the Use Accum option.
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4. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. From the Primary Accumulator list, select “0.” Before any calculations
are performed on an accumulator, its content is “0” (zero). When you
use an accumulator, the system adds a new accumulator to the bottom of
this list.

April 2005

There is only one set of accumulators for each map.
This means that accumulator “0,” whether it is used in
the Primary Accumulator or Alternate Accum box, is
the same accumulator with the same contents. If you
assign calculations to accumulator “0” at the beginning
of the map and then use accumulator “0” again later in
the map, the content of that accumulator will be the
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result of the earlier calculation. Any additional
calculations you assign to that accumulator will be
performed on the contents resulting from an earlier
calculation.

6. Inthe Name box, type “Line Item Number”. This descriptive alias
enables you to differentiate how the accumulators you create are used.

7. From the First list, select “Increment primary.” This is the first
operation that the system performs. This specifies that the system
increases the value in this accumulator by one for each LIN group.

The First box is active only after you select a Primary
Accumulator.
8. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK on the Field Properties dialog to add the standard rule to the
LINO1 element.

10. Double-click the CNT:202 element (in the CNT:2 segment). This field
typically contains the total number of line items.
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The Field Properties dialog is displayed.
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11. In the Advanced section, click the Use Standard Rule check box to
display the rule options.

12. Click the Use Accum option.

13. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

14. From the Primary Accumulator list, select primary accumulator “0.”
This accumulator currently contains the total number of line items.

15. From the First list, select “Use primary.” This specifies that the system
will load the current value of the accumulator into the CNT:202
(Control Value) element.

The Edit Accumulator Entry dialog should now look like this:
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16. Click OK to add the accumulator.
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Mapping the item
number

QTYSHIP

The Advanced section of the Field Properties dialog should now look
like this.
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17. Click OK on the Field Properties dialog to add the standard rule to the
CNT:202 element.

The CNT:202 element now contains the total number of line items in the
invoice.

After using an accumulator to calculate the incremental count of the number
of line items, map the ITEMNUM field directly to the LINO1 element.

To map the item number, link the application field ITEMNUM in the
INVDETAIL record to the LINO1 element in the LIN segment (LIN group).

You have already promoted two iterations of the QTY segment in the LIN
group. You can map the QTYSHIP field directly to the QTY:502 Quantity
element in the QTY:5 segment in LIN group. However, you must map a
constant to the Quantity Qualifier (QTY:501 element) and define a
qualifying relationship with the Quantity (QTY:502 element). If the
Quantity Qualifier is “12” (despatch quantity), that iteration of the QTY:5
segment contains the quantity shipped.

You must also count the quantity shipped for each line item and load the
total quantity in the CNT:302 (Hash Total) field. Additionally, you must
map a constant to the Control Qualifier (CNT:301 element) and define a
qualifying relationship with the Monetary Amount (CNT:302) element. If
the Control Qualifier is “1” (total quantity), that iteration of the CNT:3
segment contains the total quantity.
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Setting the quantity Map a constant to the Quantity Qualifier (QTY:501 element) and define a
qualifier qualifying relationship with the Quantity (QTY:502) element.

You have already defined the constants that you will use for this map. Now
map the appropriate constant to each Quantity Qualifier element.

Complete the following steps to set the Quantity Qualifier for the QTY:5
segment:

1. Double-click the QTY:501 element (Quantity Qualifier) in the QTY:5
segment in the LIN group to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
4. Click the second Constant option.
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5. From the Constants list, select the “12” constant to identify this iteration
of the QTY:5 segment as containing the quantity shipped.
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From the Qualifies list, select the “6060:2 QUANTITY” to set up a
qualifying relationship with the Quantity element.

Click OK. The “12” code is loaded in the Quantity Qualifier element
and the qualifying relationship between the QTY:501 and QTY:502
elements is established.

Calculating the number Complete the following steps to count the quantity invoiced and generate a
of line items  hash total:

1.

Double-click the QTY:502 element in the QTY:5 segment in the LIN
group. This field is typically used to count the line items.

The Field Properties dialog is displayed.
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In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

From the Primary Accumulator list, select “1.”

In the Name box, type “Total Quantity”. This descriptive alias that will
enables you to differentiate how the accumulators you create are used.

From the First list, select “Sum in primary.” This is the first operation
that the system performs and specifies that the system adds the numeric
value (takes the positive or negative sign of the numbers into account)
of the field to the contents of the Primary Accumulator for each iteration
of the PO1 group.
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The Edit Accumulator Entry dialog should now look like this:

Edit Aecumulatar Entry Ed
Prirnany Accurulshor |1 |:I Harra IT-:-IaI Quanlily I i I
O per alioes Cancd I

Firel IEum in primany |ﬂ illemata ﬁccu‘nl [ﬂ
Secand | 2]
Thid | 2]
Foulh | 1]

8. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK on the Field Properties dialog to add the standard rule to the
QTY:502 element.

10. Double-click the CNT:302 element (in the CNT:3 segment). This field
typically contains the total quantity of the purchase order.
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The Field Properties dialog is displayed.

| 1zl "'epoibics

Name | uee:2
De=cription IEEINTHIIIL'L-'ALIJE
ala*iaidation
Win Max  Tppe Format —
I+ Wandalon: |1 I‘IE Mumbe |£I IHEI H Ll

11. In the Advanced section, click the Use Standard Rule check box to
display the rule options.

12. Click the Use Accum option.

13. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

14. From the Primary Accumulator list, select primary accumulator “1.”
This accumulator currently contains the total quantity.

15. From the First list, select “Use primary” to load the current value of the
accumulator into the CNT:302 (Control Value) element.

The Edit Accumulator Entry dialog should now look like this:
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16. Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:
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17. Click OK on the Field Properties dialog to add the standard rule to the
CNT:302 element.

The CNT:302 element now contains the total quantity of the purchase
order.

Setting the control You must map a constant to the Control Qualifier (CNT:301 element) and
qualifier - define a qualifying relationship with the Control Value (CNT:302) element.

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Control Qualifier element.

Complete the following steps to set the Control Qualifier for the CNT:3
segment:

1. Double-click the CNT:301 element (Control Qualifier) in the CNT:3
segment to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
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Mapping the quantity
shipped

QTYORD

3. Click the Constant option.

4. Click the second Constant option.
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5. From the Constants list, select the “1” constant to identify this iteration
of the CNT:3 segment as containing the total quantity.

6. From the Qualifies list, select the “6066:3 CONTROL VALUE”, to set
up a qualifying relationship with the Control VValue element.

7. Click OK. The “1” code is loaded in the Control Qualifier element and
the qualifying relationship between the CNT:301 and CNT:302
elements is established.

After mapping the using an accumulator to calculate the quantity invoiced
for each line item and generate a hash total, you can map the QTYSHIP field
directly to the QTY:502 element.

To map the QTYSHIP, link the application field QTYSHIP in the
INVDETAIL record to the QTY:502 element in the QTY:5 segment (LIN

group).

You have already promoted two iterations of the QTY segment (in the LIN
group). The QTYORD field can be directly mapped to the QTY:602
Quantity element in the QTY:6 segment (LIN group). However, you must
map a constant to the Quantity Qualifier (QTY:601 element) and define a
qualifying relationship with the Quantity (QTY:602 element). If the
Quantity Qualifier is “21” (ordered quantity), that iteration of the QTY:6
segment contains the quantity ordered.
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Setting the quantity
qualifier

You must map a constant to the Quantity Qualifier (QTY:601 element) and
define a qualifying relationship with the Quantity (QTY:602) element.

You have already defined all the constants that you will use for this map.
Now map the appropriate constant to each Quantity Qualifier element.

Complete the following steps to set the Quantity Qualifier for the QTY:6
segment:

1. Double-click the QTY:601 element (Quantity Qualifier) in the QTY:6
segment in the LIN group, to access the Field Properties dialog.
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Mapping the quantity
ordered

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.

Click the second Constant option.

o > N

From the Constants list, select the “21” constant to identify this iteration
of the QTY:6 segment as containing the quantity ordered.

6. From the Qualifies list, select the “6060:3 QUANTITY” to set up a
qualifying relationship with the Quantity element.

7. Click OK. The “21” code is loaded in the Quantity Qualifier element
and the qualifying relationship between the QTY:601 and QTY:602
elements is established.

After mapping the using an accumulator to calculate each line item’s
quantity invoiced and to generate a hash total, map the QTYORD field
directly to the QTY:602 element.

To map the QTYORD, link the application field QTYORD in the
INVDETAIL record to the QTY:602 element in the QTY:6 segment (LIN

group).
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UNITPRICE

Setting the monetary
amount type qualifier

You can map the UNITPRICE field directly to the MOA:1302 Monetary
Amount element in the MOA:13 segment (MOA:2 group, LIN group).
However, you must map a constant to the Monetary Amount Type Qualifier
(MOA:1301 element) and define a qualifying relationship with the Monetary
Amount (MOA:1302) element. If the Monetary Amount Type Qualifier is
“146” (unit price), that iteration of the MOA:13 segment contains the unit
price.

You must multiply the quantity invoiced for each line item by the unit price
to obtain the extended price. You must also generate a running total of the
extended price and load the final total in the MOA:1402 (Total Invoice
Amount) element.

You must map a constant to the Monetary Amount Type Qualifier
(MOA:1301 element) and define a qualifying relationship with the Monetary
Amount (MOA:1302) element.

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Monetary Amount Type Qualifier
element.

Complete the following steps to set the Monetary Amount Type Qualifier for
the MOA:13 segment:

1. Double-click the MOA:1301 element (Monetary Amount Type
Qualifier) in the MOA:13 segment in the MOA:2 group to access the
Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.

3. Click the Constant option.
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4. Click the second Constant option.
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5. From the Constants drop-down list, select the “146” constant to identify
this iteration of the MOA:13 segment as containing the unit price.

6. From the Qualifies drop-down list, select the “5004 MONETARY
AMOUNT?” to set up a qualifying relationship with the Quantity
element.

7. Click OK. The “146” code is loaded in the Monetary Amount Type
Qualifier element and the qualifying relationship between the
MOA:1301 and MOA:1302 elements is established.

Calculating the value Complete the following steps to multiply the quantity invoiced for each line
total jtem by the unit price to obtain the extended price:

1. Double-click the QTY:502 element (in the QTY:5 segment in the LIN
group). This field is typically used to count the quantity invoiced.

The Field Properties dialog is displayed.
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In the Advanced section, click NEW... to access the Edit Accumulator

Entry dialog to create a new calculation for this element.
From the Primary Accumulator drop-down list, select “2.”

In the Name box, type “Extended Price”.

From the First drop-down list, select “Load primary.” This is the first
operation that the system performs and specifies that the system loads

the contents of the element into the Primary Accumulator for each

iteration of the QTY:5 group.
The Edit Accumulator Entry dialog should now look like this:
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6. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look

like this:
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7.

Click OK on the Field Properties dialog to add the standard rule to the
QTY:502 element.

Double-click the MOA:1302 element (in the MOA:13 segment in the
MOA:2 group in the LIN group). This is the field that contains the unit
price for each line item.

The Field Properties dialog is displayed.
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9. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

10. Click the Use Accum option.

11. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

12. From the drop-down list, select primary accumulator “2.”

13. From the First drop-down list, select “Multiply with primary.” This is

the first operation that the system performs. This specifies that the
system multiplies the value of the MOA:1302 (Unit Price) element with
the contents of the primary accumulator and stores the result in the
primary accumulator for each iteration of the MOA:2 group.

The Edit Accumulator Entry dialog should now look like this:
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14. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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15. Click OK on the Field Properties dialog to add the standard rule to the
MOA:1302 element.

If you have an extended price element in your EDI file,
load the total from the extended price calculation into
that element. To do this, use an accumulator on that
extended price element that specifies “Use primary”
for accumulator 2.

Generating a running  Complete the following steps to generate a running total of the extended
total price:

1. Double-click the MOA:1302 element (in the MOA:13 segment in the
MOA:2 group in the LIN group). This is the field that contains the unit
price for each line item.
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The Field Properties dialog is displayed.
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In the Advanced section, click NEW... to access the Edit Accumulator
Entry dialog to create another calculation for this element.

From the Primary Accumulator drop-down list, select primary
accumulator “3.”

In the Name box, type “Running Total”.

From the First drop-down list, select “Add primary to alternate.” This
specifies that the system adds the contents of the primary accumulator to
the contents of the alternate accumulator and stores the result in the
primary accumulator for each iteration of the MOA:2 group.

From the Alternate Accum drop-down list, select “2.” This specifies that
the system adds the value of accumulator “2,” which contains the
extended price for a line item, to the value of accumulator “3.” The
system stores the sum in accumulator “3”, which contains a running
total of the extended price with each iteration of the MOA:2 group.

The Edit Accumulator Entry dialog should now look like this:
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Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK on the Field Properties dialog to add the standard rule to the
MOA:1302 element.

Loading the running total Complete the following steps to load the running total of the extended price
into the MOA:1402 (Monetary Amount) element:

1. Double-click the MOA:1402 element (in the MOA:14 segment in the
MOA:2 group in the summary section of the map). This is the field that
contains the total amount.

The Field Properties dialog is displayed.
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2. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

3. Click the Use Accum option.

4, Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. From the drop-down list, select primary accumulator “3.”

6. From the First drop-down list, select “Use primary.” This specifies that
the system will load the contents of the primary accumulator into the
MOA:1402 element.

The Edit Accumulator Entry dialog should now look like this:
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7. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK on the Field Properties dialog to add the standard rule to the
MOA:1402 element.

Mapping the unit price  After using accumulators to multiply the quantity invoiced for each line item
by the unit price to obtain the extended price and generate a running total of
the extended price, map the UNITPRICE field to the MOA:1302 element.
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UOM

CUSTPROCODE

Setting the line item
type, coded

To map the UNITPRICE, link the application field UNITPRICE in the
INVDETAIL record to the MOA:1302 element in the MOA:13 segment (in
the MOA:2 group in the LIN group)

You have already mapped the quantity shipped to the QTY:5 segment and
the quantity ordered to the QTY:6 segment. Map the unit of measure to both
segments.

To map the UOM to both segments, Link the application field UOM in the
INVDETAIL record to the QTY:503 element in the QTY:5 segment (LIN
group). Then link the application field UOM in the INVDETAIL record to
the QTY:603 element in the QTY:6 segment (LIN group).

You can map the CUSTPROCODE (customer product code) field directly to
the LINO3 element in the LIN segment in the LIN group. However, you must
map a constant to the LINO4 element (Item Number Type, Coded) and
establish a qualifying relationship with the Item Number (LINO3). This
enables you to specify that the LINO3 element contains your partner’s
product code.

You must map a constant to the LINO4 element (Item Number Type, Coded)
and establish a qualifying relationship with the Iltem Number (LINO3).

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Iltem Number Type, Coded element.

Complete the following steps to set a constant for the Iltem Number Type,
Coded element:

1. Double-click the LINO4 element (Item Number Type, Coded) in the
LIN segment in the LIN group to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.

3. Click the Constant option.
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4. Click the second Constant option.
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5. From the Constants drop-down list, select the “BP” constant (buyer’s
part number) to identify the LINO4 element as containing the customer
product code.

6. From the Qualifies drop-down list, select the “7140 ITEM NUMBER”
to set up a qualifying relationship with the Item Number element.

7. Click OK. The “BP” code is loaded in the Item Number Type, Coded
element and the qualifying relationship between the LINO3 and LINO4
elements is established.

Mapping the customer After establishing the appropriate qualifying relationship, map the
product code CUSTPROCODE field.

To map the product code information, link the application field
CUSTPROCODE in the INVDETAIL record to the LINO3 element in the
LIN segment (LIN group).

UPCCODE You can map the UPCCODE (your UPC code) field directly to the PIA:202
element in the P1A:2 segment (in the LIN group). However, you must map a
constant to the P1A:203 element (Item Number Type, Coded) and establish a
qualifying relationship with the Item Number (PIA:202). This enables you to
specify that the PIA:202 element contains your UPC code.

Additionally, you must set the Product ID Function Qualifier for the P1A:2
segment (P1A:201 element).

Setting the line item You must map a constant to the PIA:203 element (Item Number Type,
type, coded Coded) and establish a qualifying relationship with the Item Number
(P1A:202).

238 April 2005 Gentran:Director Application Integration EDIFACT Tutorial Guide



Outbound Invoice (INVOIC) Mapping Your Data

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Iltem Number Type, Coded element.

Complete the following steps to set a constant for the Iltem Number Type,
Coded element:

1. Double-click the P1A:203 element (Item Number Type, Coded) in the
P1A:2 segment in the LIN group to access the Field Properties dialog.
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2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
4. Click the second Constant option.
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5. From the Constants list, select the “UP” constant (UPC code), to
identify the PIA:202 element as containing your UPC code.

6. From the Qualifies list, select the “7140:7 ITEM NUMBER” to set up a
qualifying relationship with the Item Number element.

7. Click OK. The “UP” code is loaded in the Item Number Type, Coded
element and the qualifying relationship between the PIA:202 and
P1A:203 elements is established.
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Setting the product ID  You must also map a constant to the PIA:201 element (Product ID Function
function qualifier ~Qualifier) and establish a qualifying relationship with the Item Number
(PIA:202).

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Product ID Function Qualifier element.

Complete the following steps to set a constant for the Product ID Function
Qualifier element:

1. Double-click the P1A:201 element (Product ID Function Qualifier) in
the PIA:2 segment in the LIN group to access the Field Properties

dialog.
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In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.

Click the second Constant option.

o~ N

From the Constants list, select the second “1” constant (additional
information) to identify the PIA:202 element as containing additional
product information.

6. From the Qualifies list, select the “7140:7 ITEM NUMBER” to set up a
qualifying relationship with the Item Number element.

7. Click OK. The “1” code is loaded in the Product ID Function Qualifier
element and the qualifying relationship between the PIA:201 and
P1A:202 elements is established.

Mapping your UPC code After establishing the appropriate qualifying relationship, map the
UPCCODE field.

To map the product code information, link the application field UPCCODE
in the INVDETAIL record to the PIA:202 element in the PI1A:2 segment
(LIN group).
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ITEMDESC  Since you have already promoted one instance of the IMD segment in the
LIN group, you can map the ITEMDESC (item description) field directly to
the IMD:306 element.

Mapping the item To map the item description, link the application field ITEMDESC in the
description  INVDETAIL record to the IMD:306 element in the IMD:3 segment (LIN

group).

INVSUMMARY
Record This section describes how to map from each field in the INVSUMMARY
(summary) record. The INVSUMMARY record contains the total invoice
amount and the total transaction amount. The summary record is mandatory
and occurs once per invoice translated.

BILLTOACCTSUM The BILLTOACCTSUM field is part of the application file format key but
does not contain data that the system uses to generate the invoice. You will
not perform any mapping operations on this field.

DOCTYPSUM The DOCTYPSUM field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

INVNUMSUM  The INVNUMSUM field is part of the application file format key but does
not contain data that the system uses to generate the invoice. You will not
perform any mapping operations on this field.

TOTALAMOUNT  For the system to create output segments, there must be at least one explicit
link to an element in that segment and data to support that link. Though you
are mapping the total amount with accumulators, you must add an explicit
link with an application field that contains data.

You must also map a constant to the Monetary Amount Type Qualifier
(MOA:1401 element) and define a qualifying relationship with the Monetary
Amount (MOA:1402) element. If the Monetary Amount Type Qualifier is
“128” (total amount), that iteration of the MOA:14 segment contains the
total invoice amount.

Setting the monetary You must map a constant to the Monetary Amount Type Qualifier
amount type qualifier (MOA:1401 element) and define a qualifying relationship with the Monetary
Amount (MOA:1402) element.

You have already defined the constants that you will use for this map. Now
map the appropriate constant to the Monetary Amount Type Qualifier
element.
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Complete the following steps to set the Monetary Amount Type Qualifier for
the MOA:14 segment:

1. Double-click the MOA:1401 element (Monetary Amount Type
Qualifier) in the MOA:14 segment in the MOA:2 group to access the
Field Properties dialog.

Fizld Fropocitice
. [5
Descrtion  [MONETARY AMOLINT TFE GUALIFIER
ala W aldation
Mir Ma  Type Famnzt —
W Mandalon |1_ |3_ ISIIing M Ix Cordiliors...

Mapping the total
monetary value
summary

TRANSTOTAL

In the Advanced section, click the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

a &~ D

From the Constants list, select the “128” constant to identify this
iteration of the MOA:14 segment as containing the total invoice
amount.

6. From the Qualifies list, select the “5004 MONETARY AMOUNT?”, to
set up a qualifying relationship with the Quantity element.

7. Click OK. The “128” code is loaded in the Monetary Amount Type
Qualifier element and the qualifying relationship between the
MOA:1401 and MOA:1402 elements is established.

To map the total monetary value summary, link the application field
TOTALAMOUNT in the INVSUMMARY record to the MOA:1402
element in the MOA:14 segment (in the MOA:2 group).

For the system to create output segments, there must be at least one explicit
link to an element in that segment, and data to support that link. Therefore,
even though you are mapping the transaction total with accumulators, you
must add an explicit link with an application field that contains data.

Additionally, you must map a constant to the Control Qualifier (CNT:201
element) and define a qualifying relationship with the Monetary Amount
(CNT:202) element. If the Control Qualifier is “2” (number of line items in
message), that iteration of the CNT:2 segment contains the total number of
line items.
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Setting the control You must map a constant to the Control Qualifier (CNT:201 element) and
qualifier  define a qualifying relationship with the Control Value (CNT:202) element.

You have already defined all the constants that you will use for this map.
Now map the appropriate constant to the Control Qualifier element.

Complete the following steps to set the Control Qualifier for the CNT:2

segment:

1. Double-click the CNT:201 element (Control Qualifier) in the CNT:2
segment, to access the Field Properties dialog.

I zid | 'opoibics
Nerie |cas8:2
Desition  {CONTAOL QUALIFIER
ala Waldation
M Max  Tppe Format
F Handalory |1 |3 IStri'u |;I IH Cormilices:
2. Inthe Advanced section, click the Use Standard Rule check box.
3. Click the Constant option.
4. Click the second Constant option.
5. From the Constants list, select the “2” constant to identify this iteration

of the CNT:2 segment as containing the total number of line items.

6. From the Qualifies list, select the “6066:2 CONTROL VALUE” to set
up a qualifying relationship with the Control VValue element.

7. Click OK. The “2” code is loaded in the Control Qualifier element and
the qualifying relationship between the CNT:201 and CNT:202
elements is established.

Mapping the total To map the transaction totals, link the application field TRANSTOTAL in
transaction amount  the INVSUMMARY record to the CNT:202 element in the CNT:2 segment.
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Finalizing the Map

To complete the mapping process, you must save the map, compile the
translation object, print and review the Gentran:Director report, and test the
map.

Compiling the
Map The Compile function generates a translation object. The map that you

created (PET_EINV.MAP) is a source map. When that source map is
compiled the result is a compiled translation object.

After you save the translation object, you must register it with
Gentran:Director before you can use it.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map.
2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Hame EHE

Save IaTransDbi j gl

File harme: |Pet_einv.TF‘L

Save as type: ITransIation Objects [~ TPL) j Cancel |

3. The “File name” box already contains “PET_EINV.TPL.” This is the
name of the translation object, using the default . TPL file extension and
our recommendation that you name the translation object (. TPL file) the
same file name as you named the map (.MAP file).

Do NOT overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.
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4. Change the Drive and Folder where the compiled translation object will
be stored, if necessary.

Do NOT store the compiled translation object in the
GENTRAN DirectorRegTransObj subfolder. This
subfolder is reserved for storing a copy of each
translation object you register with Gentran:Director.

5. Click SAVE. The system compiles the map and generates a translation
object. The Compile Errors dialog is displayed. Verify that no errors
occurred and click OK to exit the dialog.

6. Select Details from the Edit menu.

The Translation Object Details dialog is displayed.

Tranzlation Dbject Dretailz

rSummeny
A khor Diezclipion Traredation Object Functon Bpetem
Steri PETE 321 INWOIC Impott | | mpoit | C
rg I e I H |—I | Cancel I
“Merson Control

Major walgion I'I Minar version IEI Compiled o |12—53p-‘|555

EDI Associaliohs

Irput Output
Apency |_ | IE_ [Edtact
Yersian | | Joseam | [ECIFACT 1552 REL
Tramsaction | | [NeDIC | [INVOICE MESSAGE
Releas I_ II]_
F Groun | | ||Nv1:| Ic |

The date on which the translation object was compiled is automatically
loaded into the Compiled on box on the Translation Object Details
dialog. Click CANCEL to exit the dialog.

7. Select Save from the File menu to save the source map
You must register this translation object with the
Gentran:Director system before you can use it. See the

Gentran:Director User’s Guide for information on
registering a translation object.
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Printing the
Report

Testing the
Translation
Object

The Gentran:Director report enables you to validate and review the map, and
make modifications as needed. If you review the report and determine that
the map is incorrect, make the modifications, save the map, recompile the
translation object, and print the report again.

Complete the following steps to print the Gentran:Director report:

1.  Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.
Print Dptions |

— Report sections

¥ Frint branching diagram
¥ Print recard details ﬂl
¥ Frint mapping details
¥ Frint extended rulez
¥ Print code lizts

W Inchude only active ohiects

2. Accept the defaults on this dialog (all options checked), so the report
will include all sections and only the activated map components. Click
OK. The Print dialog is displayed.

3. Select the appropriate options. Click OK.

Click SETUP... to select a specific printer, paper orientation, or size and
source of paper. The Print Setup dialog is displayed.

After you compile the map, print and verify the report, and register the
translation object with Gentran:Director, you can test the translation object
to verify that the data is translated correctly.

Following is an overview of the steps required for testing the system import
(HEADER.TPL) and import (PET_EINV.TPL) translation objects that you
created:

1. Register the HEADER.TPL and PET_EINV.TPL translation object with
Gentran:Director. Please see the Gentran:Director User’s Guide for
more information on registering a translation object.
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If you have not already done so, import the PETZONEL1.PAR partner
relationship into Gentran:Director. Please see the Gentran:Director
User’s Guide for more information on importing a partner.

The default path for the partner file is: C:\Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PETZONE1.PAR

Verify (in Partner Editor) that the PET E 92.1 INVOIC Import
translation object is selected for the Outbound Relationship. Please see
the Gentran:Director User’s Guide for more information on selecting
outbound translation objects.

Ask your system administrator to add the system import translation
object (HEADER.TPL) to the System Configuration program. Please
see the Administration Guide for more information about how your
system administrator must modify the system configuration program.

Use the Import option in Gentran:Director to process the data file
(PET_EINV.TXT) through the translation object. The data file is
located in the TUTORIAL subfolder under the folder where

Gentran:Director is installed. The default path for the data file is:

C:\Program Files\Sterling Commerce\GENTRAN Director\
TUTORIAL\PET_EINV.TXT

Please see the Gentran:Director User’s Guide for more information on
importing files.

After the message is translated, it is located in the Workspace in
Gentran:Director. View the EDI data to ensure that the message was
translated correctly. Please see the Gentran:Director User’s Guide for
more information on viewing raw EDI data.
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?In Documents This Gentran:Director browser contains a list of documents that were
received by the system but failed compliance checking or that do not have an
identifiable partner or transaction set.

?0ut Documents This Gentran:Director browser contains a list of documents that were
imported into the system via unattended processing but are invalid.

acknowledgement This term is used to indicate the ANSI 997 functional acknowledgement, the
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL
document.

activation This function enables you to make map components available for use. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. When translating data, the system does not process groups,
segments, composites, and elements (or records and fields) that are not
activated. Therefore, you must activate the groups, segments, composites,
and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) is the standards-setting
group for the automotive industry. The standards form a subset of the ANSI
X12 standard.

ANA Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many
products and services, such as safety glasses and battery capacities. The
ANSI X12 committee is the chief EDI standards-setting organization for the
United States.

application file If you are creating an import or export map, you must define your
application to Gentran:Director. In Gentran:Director terminology, your
application file is also referred to as a fixed-format file or a positional file.
Your application file must contain all the information that you either need to
extract from your partner’s document (if the map is inbound) or need to send
to your partner (if the map is outbound), so that your system can accurately
process the data.
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application system
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browser

button

check box

click

code list tables

colours

communications
session

Communicator

compile

compliant

Computer systems, outside of EDI, designed to fulfill specific business
functions. These include accounting, purchasing, materials control, human
resources, shipping, and other systems.

A browser is a window that displays a list of items, such as documents
(transaction sets), interchanges, translation objects, etc. A document browser
displays only documents.

A button enables you to execute a command. You select a button either by
clicking it or by pressing TAB until the button you want is selected and then
pressing ENTER. Unavailable buttons are dimmed, and the currently
selected button has a darker border than the other buttons.

A check box enables you to select or clear options from a list. You can select
as many options from the list as you need. A selected check box contains a
checkmark. The labels of unavailable options are dimmed.

Click indicates that you should position your cursor on top of the designated
item and press and release your primary mouse button. The primary mouse
button is the button you access with your index finger, regardless of whether
you are utilizing right-handed or left-handed mouse operation.

These are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined
with a code.

This feature enables you to select foreground and background colours to
visually define the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one
continuous period of connection. This could include sending two or three
interchange envelopes to a network, each for a different trading partner.

This is the Gentran:Director communications software. The Communicator
enables you to send, receive, resend, establish communication port
definitions, establish communication profiles, establish communication
scripts, and view and delete communication sessions.

This function compiles the map and creates a translation object. The map
that you create using Gentran:Director is a source map. When that source
map is compiled, the result is a compiled translation object. This translation
object will need to be registered with the Gentran:Director system before
you can use it.

This means that the document conforms to the EDI standards as defined by
the translation object.
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component data
element

composite data
element

conditions

constant

cross-reference table

date/time

deactivation

default

dialog box

document

A simple data element that belongs to a composite data element. Component
data elements are also called sub-elements.

A contains two or more component data elements or sub-elements.
Composites are defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

See relational conditions.

This standard rule enables you to move a literal constant value to the
specified element or field, indicate a qualifying relationship with another
element or field, and map the current date or time to the specified element or
field.

This table is created in Partner Editor and is used to convert your values to
your trading partner's values during outbound processing, or your partner's
values to your values during inbound processing.

This type of field or element contains a date or time. If you specify that a
field or element will be a date/time type, you must specify exactly how the
date or time must be formatted.

This function enables you to make map components unavailable for use by
the system. The system does not enable you to deactivate the mandatory
groups, segments, composites, and elements.

A predefined value — programs use these built-in values unless you
specifically override them.

A dialog box (or dialog) contains additional information or options that you
need to act on. If you specify any options, you can select a button to execute
the command. Some dialog boxes display warnings or messages indicating
why a requested task cannot be accomplished. If the dialog box has a title
bar, you can move it to another location on your desktop.

One transaction set containing actual data and treated as a single entity. The
amount of data does not affect whether something is a document or not, only
the fact that it is treated as a single entity. For example, regardless of
whether a purchase order contains one item or ten thousand, if it is one
purchase order, it is one document.

If a trading partner sends you a communication containing 10 purchase
orders, you have received 10 documents. If the communication contained 15
invoices, you have received 15 documents.
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double-click

EANA

EDI

EDI standard

EDIA

EDIFACT

element

This indicates that you should position your cursor on top of the designated
item and quickly press and release your primary mouse button twice. The
primary mouse button is the button you access with your index finger,
regardless of whether you are utilizing right-handed or left-handed mouse
operation.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.

This is the rules for turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the
Transportation Data Coordinating Committee (TDCC).

This is the standards organization of the United Nations Economic and
Social Council. The acronym is short for the Electronic Data Interchange for
Administration, Commerce, and Transport.

The smallest piece of usable information defined by the standards. Examples
might include a quantity, unit price, or description. An individual element
can have somewhat different meanings depending on context. Therefore,
elements are normally not considered to have useful meaning until they are
combined into segments. An element is the EDI map component that is
mapped (linked) to a corresponding application field to move data to and
from the EDI file.

There are three types of data elements, as illustrated in the table below:

Data Element Definition

Simple data element A single piece of information defined by
the standards.

Composite data A data element that is made up of

element multiple component elements.

Component data A simple data element that belongs to a

element composite data element. Component
data elements are also called sub-
elements.
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envelope A way of separating information in transmissions for ease of processing.
Each envelope contains a header segment and a trailer segment, which
separate the envelope from other envelopes and provide information about
the contents of the envelope.

There are three levels of envelopes, as follows:

Transaction Set
Each transaction set (business document) is contained within a transaction
set envelope.

Functional Group

An envelope containing related business documents. The standards define
which transaction sets should be placed together into a functional group
envelope.

Interchange Envelope

All material being sent to one trading partner in one communication. The
term Interchange Envelope is the term used by ANSI. EDIA uses the term
Transmission Envelope to refer to this level of envelope. Since we use the
term transmission for other uses, we will refer to Interchange Envelope only.

A communications session could easily include a

number of interchange envelopes. For this reason, the
standards-setting bodies are considering a fourth level
of envelope to cover an entire communications session.

equalize This function enables you to reinstate the two sides of the map with focus in
equal dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted
documents that your partners send you to your application file (flat file
definition). An export map is necessary for inbound processing.

export translation See export map.
object
extended rules These rules enable you to use a Gentran:Director proprietary programming
language to perform virtually any mapping operation you require.

field The smallest piece of information defined in the application file. A field is
the application map component that is mapped (linked) to a corresponding
EDI element to move data to and from your application file.

fixed-format file See application file.
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font

functional group

group

import

import map

import translation

object
inbound mapping

In Drawer

In Documents

This feature enables you to globally change the font that is used in the
display of all maps. The default font that Gentran:Director uses is a Sans
Serif 9 point. The Font feature enables you to change the font type, style, and
point size. This gives you the flexibility to shrink the font if you need to
view more of the map on your monitor, enlarge the font, or change the type
and style to be more easily readable by you.

A group of transaction sets that the standards-setting body (such as ANSI)
has defined as fitting together with other related transaction sets. An
example might be a Functional Group defined as containing all purchasing
transaction sets.

A looping structure that contains related records/segments and/or groups that
repeat in sequence until either the group data ends or the maximum number
of times that the loop is allowed to repeat is exhausted. If you create a group
that is subordinate to another group (a sub-group), this corresponds to a
nested looping structure (a loop within a loop). The application (positional)
file and the EDI file are both groups and therefore, they is visually
represented the same way as other groups and sub-groups in
Gentran:Director.

This command enables you to import data from an external application file.
Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information.

This map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-
formatted documents that your partners expect to receive from you. An
import map is necessary for outbound processing.

See import map.

The system translates your trading partner’s EDI standard formatted
business document to your application file format, so you can receive
documents from you partners. To translate inbound data, you need to create
an export map.

This Gentran:Director browser contains a list of documents that were
received and processed.

This Gentran:Director browser contains a list of documents that the system
received but that have not yet been processed by the user. Once the
documents are processed (printed or exported) the documents will be
transferred to the In Drawer.
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integer

interchange

Interchanges
browser

link

list box

literal constant

location table

lookup table

loop count

loop start/loop end
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An integer is a number that has an implied decimal point (e.g., “2.01” is
formatted as “201").

The interchange contains all the functional groups of documents (transaction
sets) sent from one sender to one receiver in the same transmission.

This Gentran:Director browser enables you to view a hierarchical list of all
the interchanges that were sent or received. It contains status information
about the interchanges, (e.g., whether or not a functional acknowledgement
was received and the status of that acknowledgement). This browser also
enables you to access the documents within the interchanges. The
Interchanges browser can always be accessed.

This function enables you to map a field or element from the Input side of
the map to a field or element on the Output side of the map. The link
between two map components (hereafter referred to as fields) is visually
represented with a line connecting the two fields.

A list box displays a list of choices. Scroll bars are provided if there are more
choices than can fit in the box.

These are used by the system as a repository to store information that will be
used at a later point in the map. Typically, constants are used in an outbound
map to generate a qualifier.

This is a table created in Partner Editor that is used to contain address-related
information about the partner.

This is a table created in Partner Editor that is used to select information
related to a value in inbound or outbound data.

This standard rule enables you to count the number of times a loop is
repeated, if the element or field is part of a loop. If the loop is a nested loop,
you can track the current loop or the outer loop. For example, if the Y loop is
nested within the X loop, and the Y loop has cycled through 15 iterations
and the X loop has cycled through 3 iterations, you can choose to count
either the “15” (Y loop) or the “3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and LE segments differentiate between two or more loops of the same type.
If the transaction contains LS and LE segments and depending on whether
your map is inbound or outbound, you will need to define the LS and LE
segments for the loops you will be using in the map in one of two different
ways.
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map

menu

menu bar

network

number

ODETTE

Out Documents

outbound mapping

Out Drawer

partner

Partner Editor

positional file

post

predefined

April 2005

A set of instructions you define in the Gentran:Director Application
Integration subsystem that indicates the corresponding relationship between
your application file and the EDI standards, and defines how the system
should translate data.

A list of items from which you can choose. Each item represents a
command. Unavailable items on a menu are dimmed to inform you they are
disabled.

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN). A
service, such as Commerce:Network, that accepts and holds transmissions
from companies until it is convenient for a trading partner to accept them.

This type of field or element contains either an integer or real number. If you
specify that a field or element will be a number type, you must designate the
format by specifying a format of either “N” (integer) or “R” (real) and the
number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

This Gentran:Director browser contains a list of documents that are ready to
be sent. After the documents are successfully sent, they are automatically
transferred to the Out Drawer.

The system translates your application file format to EDI standard formats,
so you can send documents to your partners. To translate outbound data, you
need to create an import map and a system import map in Gentran:Director.

This Gentran:Director browser contains a list of documents that were
successfully sent out by the system.

Another firm with which your company trades documents. Also referred to
as a trading partner.

This Gentran:Director function enables you to define, edit, and delete all
partner information for your company and all of your trading partners.

See application file.

This Gentran:Director function enables you to move compliant documents
from the Workspace to the Out Documents.

On a data entry translation object, a default value for a particular element.
You can change the value as necessary.
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printout

promote

qualifier

radio buttons

real number

receive

record

relational condition

respond

responsible agency

This is produced when data received from a trading partner passes through a
print translation object. You do not have to actually print the data. The
printout could be to a file on your hard disk.

This function extracts one iteration (instance) of a group or repeating
segment. This enables you to map unique data from your application file,
and/or enter a specialized definition. Gentran:Director specifies that only
one-to-one (no loops) or many-to-many (loop) mapping relationships are
valid.

This is an element that has a value expressed as a code that gives a specific

meaning to the function of another element. A qualifying relationship is the
interaction between an element and its qualifier. The function of the element
changes depending on which code the qualifier contains.

Radio buttons indicate a group of mutually exclusive options. You can only
select one option at a time. Select an option by clicking the radio button or
pressing the SPACE BAR until the option you want is selected. The selected
option contains a black dot. The labels of unavailable choices are dimmed.

A real number has an explicit decimal point (e.g., “2.01” is formatted as
“2.01™), and truncates trailing zeroes.

This Gentran:Director function enables you to manually initiate a
communications session to receive data from your trading partner.

Contains a group of related fields. A record can occur once or can repeat
multiple times.

This function enables to connect fields together for syntax or compliance
reasons. For example, Field A is invalid unless Field B is present. Therefore,
if you set up a condition that pairs Fields A and B, the system will generate a
compliance error if one of those fields is not present.

This Gentran:Director function enables you to create a turnaround document
(using the Turn Around translation object in the partner relationship) in
response to one or more selected document(s) in the In Drawer.

An organization that develops and updates standards for EDI
communications. These organizations include ANSI, EDIA, AIAG, UCS,
EDIFACT, ODETTE, and VICS.
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segment A group of related elements or composite data elements that combine to
communicate useful data. Segments are defined by the EDI standards. A
segment can occur once or can repeat multiple times. For example, a catalog
price segment might consist of elements for item description, volume, price,
lead time, etc. By themselves, none of these elements would communicate
useful information. Together, they provide the information necessary for
someone to tell if the item is what is desired, whether the price is reasonable,
etc. A number of segments together form a transaction set.

select This standard rule enables you to select entries from a location table, cross-
reference table, partner table, or lookup table (all tables created in the
Gentran:Director Partner Editor). You can then map the fields in those tables
to one or more fields in the data. The Select function uses the value of the
current field to perform the selection.

send This Gentran:Director function enables you to manually start a
communications session to send data to your trading partner. Only selected
documents are enveloped and sent. If no documents are selected, ALL
documents will be sent. Successfully sent documents are moved to the Out
Drawer.

set See Transaction Set.
simple mapping See link.

split  This function enables you to split (break) a group or repeating segment into
two loops. You will typically use this function when you need more than one
instance of the same map component that still occurs multiple times.

standard rules These rules give you access to functions that are necessary for mapping
operations that are more complex than simple linking, but less involved than
extended rules. Each of the standard rules are mutually exclusive (you can
use only one on a particular field).

status bar The status bar of an application window defines information about a
selection, command, or process, defines Menu Bar items as the user
highlights each item, and indicates any current keyboard-initiated modes for
typing (e.g., CAP for the “Caps Lock” key or NUM for the “Num Lock”
key, etc.).

string This type of field or element contains one or more printable characters. If
you specify that a field or element will be a string type, you must designate
the format by specifying a syntax token.
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syntax token This function enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type
element or field. You can then use the syntax tokens in the Format field of
the Field Properties dialog. This enables you to define what type of
characters should be used while compliance checking each element/field
(i.e., alphanumeric within a certain range, numeric within a certain range,
etc.).

system import map The translator uses this map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the
application file, so the system will know which import map to use to process
the document. You need a system import map that is defined in
EDIMGR.INI to translate outbound data.

systemimport See system import map.
translation object

system translation These translation objects control the creation and separation of interchanges,
object functional groups, and transaction sets. They also used to generate and
reconcile functional acknowledgements. All the required system translation
objects are automatically installed with the Gentran:Director system.

TDCC See EDIA.

TDF TDF is the Transaction Data File. This file serves as a filter between your
document files and the Gentran:Director translator. For outbound
processing, data is imported from a TDF file and translated to EDI format
using a TDF Import translation object. The data is then ready to be posted
and sent to your trading partner. For inbound processing, EDI documents
that are received by Gentran:Director can be exported to a TDF-formatted
file using a TDF Export translation object. This data file is then ready to be
processed or converted to your internal application files.

third-party network See Network.

title bar The title bar of an application window contains the name of the application
and enables you to move the window to another position on your desktop.

toolbar This contains buttons that graphically represent commands available in the
Menu Bar.

TRADACOMS The U.K. standards for EDI that are published by the Article Numbering
Association (UK) LTD.
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trading partner

transaction set
(document)

translation object

translator

transmission

transmission chain

Another firm with which you company trades documents. Also referred to as
a partner.

A business form as defined by the standards. Examples include an ANSI 850
purchase order or an EDIFACT INVOIC (invoice). The standards define
each transaction set in terms of the segments and elements that make up the
form, the order in which they appear, and the relationships among them. This
is also known as “message” in Europe.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify
which translation object(s) will be used by each partner relationship.

Inbound Translation Objects:

Turn Around: This translation object is used when a document is received,
to create the natural response document that contains as many elements from
the received document as possible.

Export File: This translation object indicates that when a document is
received, it will be exported to a specified file format.

Print: This translation object is used to print documents.

Outbound Translation Objects:

Import: This translation object is used to import data from an application
file.

Print: This translation object is used to print documents.

Data Entry: This translation object is used to enter data into the Document
Editor facility.

This is the engine that processes data for Gentran:Director, the Application
Integration subsystem, and the Forms Integration subsystem.

See Communications Session.

A path an EDI communication could follow, including one company, one
trading partner, and one or more network services.

turnaround document A document into which data elements from the source document have been
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turnaround map

automatically transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document
(a logical response document to the source) from an inbound (source)
document, by transferring data from the source document to elements in the
target document (translation object).
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UCs

update

use accum

use code

user translation
object

version

VICS

Workspace

X12

The Uniform Communications Standard is the standard used by the grocery
industry.

This standard rule enables you to update a specific field in a document
record, envelope segment, interchange, group, current partner, or document
(if the map side format type is EDI), with the element or field contents.

This standard rule gives you access to a set of numeric variables that you can
manipulate via numeric operations, and then transfer to and from fields. This
function enables you to add, change, or delete calculations for the element/
field, including hash totals (used to accumulate numeric field values, i.e.,
quantity, price, etc.). This function also enables you to map the accumulated
total into a control total field, and use accumulators. Accumulators are used
generally for counting the occurrences of a specific element or generating
increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a
predefined code table, specify whether or not a compliance error will be
generated if the element or field does not contain one of the values in the
code table, and store a code’s description in another element or field.

These translation objects control data entry, importing, exporting, document
turnaround, and creating printed reports. These translation objects are
created using the Application Integration or Forms Integration subsystems.
The Application Integration subsystem enables you to generate import,
export, and document turnaround translation objects. The Forms Integration
subsystem enables you to generate data entry and print translation objects.

Each standards-setting body updates its standards on a regular basis. Each
formal update is referred to as a version.

The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

This Gentran:Director browser contains a list of outbound “Work in
Progress” documents. It also contains recently imported or data entry
documents.

The ANSI committee that sets and publishes standards for EDI.
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